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     [bookmark: pgfId-1260728]Preface 
      
      
 
     
 
 
    [bookmark: pgfId-1260729]This preface describes the audience, organization, and conventions of the Cisco DCNM Fundamentals Guide. It also provides information on how to obtain related documentation.
 
     
      [bookmark: pgfId-1247773]Audience
 
     [bookmark: pgfId-1208100]This guide is for experienced network administrators who are responsible for configuring and maintaining the Nexus family switch and Cisco MDS 9000 Family of multilayer directors and fabric switches.
 
    
 
     
      [bookmark: pgfId-1208101]Organization
 
     [bookmark: pgfId-1245982]This guide is organized as follows:
 
      
       
        
         
         	 
           
           [bookmark: pgfId-1250225]Chapter 
          
  
         	 
           
           [bookmark: pgfId-1250227]Title 
          
  
         	 
           
           [bookmark: pgfId-1250229]Description 
          
  
        
 
         
         	[bookmark: pgfId-1250234]Chapter 1
  
         	[bookmark: pgfId-1250241]Introduction to Cisco Data Center Network Manager
  
         	[bookmark: pgfId-1250244]Provides a brief overview of Cisco DCNM Fundamentals.
  
        
 
         
         	[bookmark: pgfId-1264664]Chapter 2
  
         	[bookmark: pgfId-1264666]Cisco DCNM User Roles
  
         	[bookmark: pgfId-1264668]Provides the information about the user roles of Cisco DCNM.
  
        
 
         
         	[bookmark: pgfId-1264722]Chapter 4
  
         	[bookmark: pgfId-1264724]Cisco DCNM Web Client
  
         	[bookmark: pgfId-1264726]Provides the features of Cisco DCNM Web Client and the major changes in the latest release.
  
        
 
         
         	[bookmark: pgfId-1253724]Chapter 7
  
         	[bookmark: pgfId-1253726]Cisco DCNM-SAN Overview
  
         	[bookmark: pgfId-1253816]Provides a brief overview of Cisco DCNM-SAN.
  
        
 
         
         	[bookmark: pgfId-1250267]Chapter 8
  
         	[bookmark: pgfId-1250272]Configuring Cisco DCNM-SAN Server
  
         	[bookmark: pgfId-1250274]Provides in-depth descriptions of GUI and capabilities of Cisco DCNM-SAN Server.
  
        
 
         
         	[bookmark: pgfId-1250279]Chapter 9
  
         	[bookmark: pgfId-1250283]Configuring Authentication in Cisco DCNM-SAN
  
         	[bookmark: pgfId-1250286]Describes the authentication schemes between Cisco DCNM-SAN components and fabric switches.
  
        
 
         
         	[bookmark: pgfId-1250291]Chapter 10
  
         	[bookmark: pgfId-1250296]Configuring Cisco DCNM-SAN Client
  
         	[bookmark: pgfId-1250298]Provides in-depth descriptions of GUI and capabilities of Cisco DCNM-SAN.
  
        
 
         
         	[bookmark: pgfId-1250303]Chapter 11
  
         	[bookmark: pgfId-1250308]Device Manager
  
         	[bookmark: pgfId-1250310]Provides in-depth descriptions of GUI and capabilities of Device Manager.
  
        
 
         
         	[bookmark: pgfId-1250315]Chapter 12
  
         	[bookmark: pgfId-1250320]Configuring Performance Manager
  
         	[bookmark: pgfId-1250322]Provides overview of the Performance Manager architecture.
  
        
 
         
         	[bookmark: pgfId-1250339]Chapter 13
  
         	[bookmark: pgfId-1250344]Monitoring the Network
  
         	[bookmark: pgfId-1250346]Provides details on monitoring the network.
  
        
 
         
         	[bookmark: pgfId-1250351]Chapter 14
  
         	[bookmark: pgfId-1250356]Monitoring Performance
  
         	[bookmark: pgfId-1250358]Provides details on using Performance Manager.
  
        
 
        
      
 
     
 
    
 
     
      [bookmark: pgfId-1208840]Document Conventions
 
     [bookmark: pgfId-1208858]Command descriptions use these conventions: 
 
      
       
        
         
         	[bookmark: pgfId-1208843]boldface font
  
         	[bookmark: pgfId-1208845]Commands and keywords are in boldface.
  
        
 
         
         	[bookmark: pgfId-1208847]italic font
  
         	[bookmark: pgfId-1208849]Arguments for which you supply values are in italics.
  
        
 
         
         	[bookmark: pgfId-1208851][ ]
  
         	[bookmark: pgfId-1208853]Elements in square brackets are optional.
  
        
 
         
         	[bookmark: pgfId-1208855][ x | y | z ]
  
         	[bookmark: pgfId-1208857]Optional alternative keywords are grouped in brackets and separated by vertical bars.
  
        
 
        
      
 
     
 
     [bookmark: pgfId-1208884]Screen examples use these conventions: 
 
      
       
        
         
         	[bookmark: pgfId-1208861]screen font
  
         	[bookmark: pgfId-1208863]Terminal sessions and information the switch displays are in screen font.
  
        
 
         
         	[bookmark: pgfId-1208865]boldface screen font
  
         	[bookmark: pgfId-1208867]Information you must enter is in boldface screen font.
  
        
 
         
         	[bookmark: pgfId-1208869]italic screen font
  
         	[bookmark: pgfId-1208871]Arguments for which you supply values are in italic screen font.
  
        
 
         
         	[bookmark: pgfId-1208873]< >
  
         	[bookmark: pgfId-1208875]Nonprinting characters, such as passwords, are in angle brackets.
  
        
 
         
         	[bookmark: pgfId-1208877][ ]
  
         	[bookmark: pgfId-1208879]Default responses to system prompts are in square brackets.
  
        
 
         
         	[bookmark: pgfId-1208881]!, #
  
         	[bookmark: pgfId-1208883]An exclamation point (!) or a pound sign (#) at the beginning of a line of code indicates a comment line.
  
        
 
        
      
 
     
 
     [bookmark: pgfId-1208885]This document uses the following conventions:
 
      
       
     
 
     
 
     [bookmark: pgfId-1208886]Note Means reader take note. Notes contain helpful suggestions or references to material not covered in the manual.
 
      
      
 
     
 
     
 
      
       
     
 
     
 
      
      [bookmark: pgfId-1208887] 
      Caution Means 
      reader be careful. In this situation, you might do something that could result in equipment damage or loss of data. 
       
       
 
      
 
     
 
     [bookmark: pgfId-1251319]In this document, the following shortened names are used:
 
      
      	 [bookmark: pgfId-1265956]Cisco Data Center Network Manager for SAN is also referred to as DCNM-SAN.
 
      	 [bookmark: pgfId-1265957]Cisco Data Center Network Manager for LAN is also referred to as DCNM-LAN.
 
     
 
    
 
     
      [bookmark: pgfId-1265960][bookmark: marker-1265958]Related Documentation[bookmark: marker-1265959]
 
     [bookmark: pgfId-1265964]This section contains information about the documentation available for Cisco DCNM and for the platforms that Cisco DCNM manages.
 
     [bookmark: pgfId-1252757]This section includes the following topics:
 
      
      	 [bookmark: pgfId-1252760]Cisco DCNM Documentation
 
      	 [bookmark: pgfId-1252764]Cisco Nexus 1000V Series Switch Documentation
 
      	 [bookmark: pgfId-1252768]Cisco Nexus 2000 Series Fabric Extender Documentation
 
      	 [bookmark: pgfId-1252772]Cisco Nexus 3000 Series Switch Documentation
 
      	 [bookmark: pgfId-1252776]Cisco Nexus 4000 Series Switch Documentation
 
      	 [bookmark: pgfId-1252780]Cisco Nexus 5000 Series Switch Documentation
 
      	 [bookmark: pgfId-1252784]Cisco Nexus 7000 Series Switch Documentation
 
     
 
      
       [bookmark: pgfId-1252789][bookmark: 70739]Cisco DCNM Documentation
 
      [bookmark: pgfId-1252793]The Cisco DCNM documentation is available at the following URL:
 
      [bookmark: pgfId-1252796]http://www.cisco.com/en/US/products/ps9369/tsd_products_support_series_home.html
 
      [bookmark: pgfId-1252799]The documentation set for Cisco DCNM includes the following documents:
 
     
 
      
       [bookmark: pgfId-1252801]Release Notes
 
      [bookmark: pgfId-1252804]Cisco DCNM Release Notes, Release 10.0.x
 
     
 
      
       [bookmark: pgfId-1254662]Cisco DCNM
 
      [bookmark: pgfId-1254663]The following publications support both Cisco DCNM for LAN and DCNM for SAN, and address the new licensing model, the new installation process, and the new features of Cisco DCNM:
 
       
       	 [bookmark: pgfId-1266123]Cisco DCNM Fundamentals Guide, Release 10.0.x
 
       	 [bookmark: pgfId-1266124]Cisco DCNM Installation Guide, Release 10.0.x
 
      
 
     
 
      
       [bookmark: pgfId-1252854][bookmark: 56774]Cisco DCNM for SAN Configuration Guides
 
      [bookmark: pgfId-1255811]System Management Configuration Guide, Cisco DCNM for SAN
 
      [bookmark: pgfId-1255812]Interfaces Configuration Guide, Cisco DCNM for SAN
 
      [bookmark: pgfId-1255813]Fabric Configuration Guide, Cisco DCNM for SAN 
 
      [bookmark: pgfId-1255814]Quality of Service Configuration Guide, Cisco DCNM for SAN
 
      [bookmark: pgfId-1255815]Security Configuration Guide, Cisco DCNM for SAN
 
      [bookmark: pgfId-1255816]IP Services Configuration Guide, Cisco DCNM for SAN
 
      [bookmark: pgfId-1255817]Intelligent Storage Services Configuration Guide, Cisco DCNM for SAN
 
      [bookmark: pgfId-1255818]High Availability and Redundancy Configuration Guide, Cisco DCNM for SAN
 
      [bookmark: pgfId-1255819]Inter-VSAN Routing Configuration Guide, Cisco DCNM for SAN
 
      [bookmark: pgfId-1252893]SMI-S and Web Services Programming Guide, Cisco DCNM for SAN
 
     
 
      
       [bookmark: pgfId-1252900][bookmark: 46564]Cisco Nexus 1000V Series Switch Documentation
 
      [bookmark: pgfId-1252903]The Cisco Nexus 1000V Series switch documentation is available at the following URL:
 
      [bookmark: pgfId-1252906]http://www.cisco.com/en/US/products/ps9902/tsd_products_support_series_home.html
 
     
 
      
       [bookmark: pgfId-1252910][bookmark: 42534]Cisco Nexus 2000 Series Fabric Extender Documentation
 
      [bookmark: pgfId-1252914]The Cisco Nexus 2000 Series Fabric Extender documentation is available at the following URL:
 
      [bookmark: pgfId-1252917]http://www.cisco.com/en/US/products/ps10110/tsd_products_support_series_home.html
 
     
 
      
       [bookmark: pgfId-1252919][bookmark: 92320]Cisco Nexus 3000 Series Switch Documentation
 
      [bookmark: pgfId-1252922]The Cisco Nexus 3000 Series switch documentation is available at the followingURL:
 
      [bookmark: pgfId-1252925]http://www.cisco.com/en/US/products/ps11541/tsd_products_support_series_home.html
 
     
 
      
       [bookmark: pgfId-1252927][bookmark: 55748]Cisco Nexus 4000 Series Switch Documentation
 
      [bookmark: pgfId-1252930]The Cisco Nexus 4000 Series switch documentation is available at the following URL:
 
      [bookmark: pgfId-1252933]http://www.cisco.com/en/US/products/ps10596/tsd_products_support_series_home.html
 
     
 
      
       [bookmark: pgfId-1252935][bookmark: 42671]Cisco Nexus 5000 Series Switch Documentation
 
      [bookmark: pgfId-1252938]The Cisco Nexus 5000 Series switch documentation is available at the following URL:
 
      [bookmark: pgfId-1252941]http://www.cisco.com/en/US/products/ps9670/tsd_products_support_series_home.html
 
     
 
      
       [bookmark: pgfId-1252943][bookmark: 97219]Cisco Nexus 7000 Series Switch Documentation
 
      [bookmark: pgfId-1252946]The Cisco Nexus 7000 Series switch documentation is available at the following URL:
 
      [bookmark: pgfId-1252949]http://www.cisco.com/en/US/products/ps9902/tsd_products_support_series_home.html
 
     
 
    
 
     
      [bookmark: pgfId-1251665]Additional Related Documentation for Cisco MDS 9000
 
     [bookmark: pgfId-1251650]The documentation set for the Cisco MDS 9000 Family includes the following documents. To find a document online, use the Cisco MDS NX-OS Documentation Locator at:
 
     [bookmark: pgfId-1249440]http://www.cisco.com/en/US/docs/storage/san_switches/mds9000/roadmaps/doclocater.htm
 
      
       [bookmark: pgfId-1249441]Release Notes 
 
       
       	 [bookmark: pgfId-1249442] Cisco MDS 9000 Family Release Notes for Cisco MDS NX-OS Releases  
 
       	 [bookmark: pgfId-1249443] Cisco MDS 9000 Family Release Notes for MDS SAN-OS Releases 
 
       	 [bookmark: pgfId-1249444] Cisco MDS 9000 Family Release Notes for Cisco MDS 9000 EPLD Images 
 
      
 
     
 
      
       [bookmark: pgfId-1249446]Regulatory Compliance and Safety Information 
 
       
       	 [bookmark: pgfId-1249447]Regulatory Compliance and Safety Information for the Cisco MDS 9000 Family 
 
      
 
     
 
      
       [bookmark: pgfId-1249448]Compatibility Information 
 
       
       	 [bookmark: pgfId-1249449]Cisco Data Center Interoperability Support Matrix
 
       	 [bookmark: pgfId-1249450]Cisco MDS 9000 NX-OS Hardware and Software Compatibility Information and Feature Lists
 
       	 [bookmark: pgfId-1249451] Cisco MDS 9000  Family Switch-to-Switch Interoperability Configuration Guide 
 
      
 
     
 
      
       [bookmark: pgfId-1249452]Hardware Installation 
 
       
       	 [bookmark: pgfId-1249453]Cisco MDS 9500 Series Hardware Installation Guide 
 
       	 [bookmark: pgfId-1249454]Cisco MDS 9200 Series Hardware Installation Guide 
 
       	 [bookmark: pgfId-1249455] Cisco MDS 9100 Series Hardware Installation Guide 
 
       	 [bookmark: pgfId-1249456]Cisco MDS 9124 and Cisco MDS 9134 Multilayer Fabric Switch Quick Start Guide
 
      
 
     
 
      
       [bookmark: pgfId-1249457]Software Installation and Upgrade 
 
       
       	 [bookmark: pgfId-1249458]Cisco MDS 9000 NX-OS Software Upgrade and Downgrade Guide
 
      
 
     
 
      
       [bookmark: pgfId-1249459]Cisco NX-OS 
 
       
       	 [bookmark: pgfId-1249460]Cisco MDS 9000 Family NX-OS Licensing Guide
 
       	 [bookmark: pgfId-1249461]Cisco MDS 9000 Family NX-OS Fundamentals Configuration Guide
 
       	 [bookmark: pgfId-1249462]Cisco MDS 9000 Family NX-OS System Management Configuration Guide
 
       	 [bookmark: pgfId-1249463]Cisco MDS 9000 Family NX-OS Interfaces Configuration Guide
 
       	 [bookmark: pgfId-1249464]Cisco MDS 9000 Family NX-OS Fabric Configuration Guide
 
       	 [bookmark: pgfId-1249465]Cisco MDS 9000 Family NX-OS Quality of Service Configuration Guide
 
       	 [bookmark: pgfId-1249466]Cisco MDS 9000 Family NX-OS Security Configuration Guide
 
       	 [bookmark: pgfId-1249467]Cisco MDS 9000 Family NX-OS IP Services Configuration Guide
 
       	 [bookmark: pgfId-1249468] Cisco MDS 9000 Family NX-OS Intelligent Storage Services Configuration Guide 
 
       	 [bookmark: pgfId-1249469]Cisco MDS 9000 Family NX-OS High Availability and Redundancy Configuration Guide 
 
       	 [bookmark: pgfId-1249470] Cisco MDS 9000 Family NX-OS Inter-VSAN Routing Configuration Guide 
 
       	 [bookmark: pgfId-1249471]Cisco MDS 9000 Family Cookbook for Cisco MDS SAN-OS
 
      
 
     
 
      
       [bookmark: pgfId-1249484]Command-Line Interface 
 
       
       	 [bookmark: pgfId-1249485]Cisco MDS 9000 Family Command Reference 
 
      
 
     
 
      
       [bookmark: pgfId-1249486]Intelligent Storage Networking Services Configuration Guides 
 
       
       	 [bookmark: pgfId-1249487]Cisco MDS 9000 Family I/O Acceleration Configuration Guide
 
       	 [bookmark: pgfId-1249488]Cisco MDS 9000 Family SANTap Deployment Guide 
 
       	 [bookmark: pgfId-1249489]Cisco MDS 9000 Family Data Mobility Manager Configuration Guide 
 
       	 [bookmark: pgfId-1249490]Cisco MDS 9000 Family Storage Media Encryption Configuration Guide 
 
      
 
     
 
      
       [bookmark: pgfId-1249491]Troubleshooting and Reference 
 
       
       	 [bookmark: pgfId-1249492]Cisco MDS 9000 Family and Nexus 7000 Series System Messages Reference
 
       	 [bookmark: pgfId-1249493]Cisco MDS 9000 Family SAN-OS Troubleshooting Guide 
 
       	 [bookmark: pgfId-1249494]Cisco MDS 9000 Family NX-OS MIB Quick Reference 
 
       	 [bookmark: pgfId-1249495]Cisco DCNM for SAN Database Schema Reference
 
      
 
     
 
    
 
     
      [bookmark: pgfId-1249496][bookmark: 55984]Obtaining Documentation and Submitting a Service Request
 
     [bookmark: pgfId-1249497]For information on obtaining documentation, submitting a service request, and gathering additional information, see the monthly What’s New in Cisco Product Documentation, which also lists all new and revised Cisco technical documentation, at:
 
     [bookmark: pgfId-1249499]http://www.cisco.com/en/US/docs/general/whatsnew/whatsnew.html
 
    
 
   
 
  
 
  
  
   
   
    
     [bookmark: pgfId-120306]New and Changed Information 
      
      
 
     
 
 
    [bookmark: pgfId-120307]This chapter introduces new and changed information for Cisco Data Center Network Manager, Release 10.1.x. For more information about the operation on the Cisco DCNM Web Client and SAN Client, please refer to Web Client Online Help.
 
    [bookmark: pgfId-117334]The following table lists the New and Changed topics for this guide. 
 
    [bookmark: pgfId-102221]
 
     
      
       
       [bookmark: pgfId-120783]Table ii-1 [bookmark: 22488]New and Changed Topics for Cisco DCNM Release 10.2.x 
 
       
       
        
        	 
          
          [bookmark: pgfId-120791]Feature 
         
  
        	 
          
          [bookmark: pgfId-120793]New or Changed Topics 
         
  
        	 
          
          [bookmark: pgfId-120795]Changed in Release 
         
  
        	 
          
          [bookmark: pgfId-120797]Where Documented 
         
  
       
 
        
        	[bookmark: pgfId-122375]Enhancements to Media Controller
  
        	[bookmark: pgfId-122751]Enhancements to Media Controller
 [bookmark: pgfId-122377]
  
        	[bookmark: pgfId-122379]10.2(1)
  
        	[bookmark: pgfId-122381]Enhancements to Media Controller
  
       
 
        
        	[bookmark: pgfId-120799]LAN Fabric Provisioning
  
        	[bookmark: pgfId-120801]LAN Fabric Provisioning
  
        	[bookmark: pgfId-122480]10.2(1)
  
        	[bookmark: pgfId-120805]LAN Fabric Provisioning
  
       
 
        
        	[bookmark: pgfId-120807]IPv6 Support
  
        	[bookmark: pgfId-122849]IPv6 Support
  
        	[bookmark: pgfId-122489]10.2(1)
  
        	[bookmark: pgfId-120813]IPv6 Support
  
       
 
        
        	[bookmark: pgfId-120823]FEX Configuration
  
        	[bookmark: pgfId-122949]FEX Configuration
 [bookmark: pgfId-120825]
  
        	[bookmark: pgfId-122513]10.2(1)
  
        	[bookmark: pgfId-120829]FEX Configuration
  
       
 
        
        	[bookmark: pgfId-123610]VDC Enhancements
  
        	[bookmark: pgfId-123612]VDC Enhancements
  
        	[bookmark: pgfId-123857]10.2(1)
  
        	[bookmark: pgfId-123619]VDC Enhancements
  
       
 
        
        	[bookmark: pgfId-123786]Network Audit Reporting
  
        	[bookmark: pgfId-123845]Network Audit Reporting
  
        	[bookmark: pgfId-123790]10.2(1)
  
        	[bookmark: pgfId-123792]Network Audit Reporting
  
       
 
        
        	[bookmark: pgfId-120831]Support for Additional Storage Devices in DCNM Connect
  
        	[bookmark: pgfId-122988]Support for Additional Storage Devices in DCNM Connect
 [bookmark: pgfId-120833]
  
        	[bookmark: pgfId-122525]10.2(1)
  
        	[bookmark: pgfId-120837]Support for Additional Storage Devices in DCNM Connect
  
       
 
        
        	[bookmark: pgfId-120855]SNMP Poller Adjustment
  
        	[bookmark: pgfId-123066]SNMP Poller Adjustment
  
        	[bookmark: pgfId-122549]10.2(1)
  
        	[bookmark: pgfId-120861]SNMP Poller Adjustment
  
       
 
        
        	[bookmark: pgfId-120863]Enhancement to Multi Site Manager
  
        	[bookmark: pgfId-123105]Enhancement to Multi Site Manager
  
        	[bookmark: pgfId-122561]10.2(1)
 [bookmark: pgfId-120867]
  
        	[bookmark: pgfId-120869]Enhancement to Multi Site Manager
  
       
 
        
        	[bookmark: pgfId-120871]Monitoring Custom Port Groups
  
        	[bookmark: pgfId-123146]Monitoring Custom Port Groups
  
        	[bookmark: pgfId-122573]10.2(1)
 [bookmark: pgfId-120875]
  
        	[bookmark: pgfId-120877]Monitoring Custom Port Groups
  
       
 
        
        	[bookmark: pgfId-120879]Slow Drain Enhancement
  
        	[bookmark: pgfId-123187]Slow Drain Enhancement
  
        	[bookmark: pgfId-122585]10.2(1)
  
        	[bookmark: pgfId-120885]Slow Drain Enhancement
  
       
 
        
        	[bookmark: pgfId-120895]Template Enhancement
  
        	[bookmark: pgfId-123265]Template Enhancement
  
        	[bookmark: pgfId-122609]10.2(1)
  
        	[bookmark: pgfId-120901]Template Enhancement
  
       
 
        
        	[bookmark: pgfId-120903]Endpoint Locator (EPL)
  
        	[bookmark: pgfId-123306]Endpoint Locator (EPL)
  
        	[bookmark: pgfId-122621]10.2(1)
  
        	[bookmark: pgfId-120909]Endpoint Locator (EPL)
  
       
 
        
        	[bookmark: pgfId-120911]VxLAN EVPN IR
  
        	[bookmark: pgfId-123349]VxLAN EVPN IR
  
        	[bookmark: pgfId-122633]10.2(1
  
        	[bookmark: pgfId-120917]VxLAN EVPN IR
  
       
 
        
        	[bookmark: pgfId-123432]Support for New Hardware
  
        	[bookmark: pgfId-123434]Support for New Hardware
  
        	[bookmark: pgfId-123436]10.2(1)
  
        	[bookmark: pgfId-123441]Support for New Hardware
  
       
 
       
     
 
    
 
   
 
  
 
  
  
   
   
    
     [bookmark: pgfId-109148][bookmark: 56803]Introduction to Cisco Data Center Network Manager 
      
      
 
     
 
 
    [bookmark: pgfId-109103]Cisco Data Center Network Manager (DCNM) is a management system for the Cisco Unified Fabric. It enables you to provision, monitor, and troubleshoot the data center network infrastructure. It provides visibility and control of the unified data center. Cisco DCNM provides a comprehensive feature set that meets the routing, switching, and storage administration needs of data centers. Cisco DCNM streamlines the provisioning for the unified fabric and monitors the SAN and LAN components. Cisco DCNM provides a high level of visibility and control through a single web based management console for Cisco Nexus, Cisco MDS, and Cisco Unified Computing System (UCS) products. During the DCNM installation, you can choose install applications related to Unified Fabric only for Unified Fabric-mode installations.
 
    [bookmark: pgfId-103677]Cisco DCNM LAN Thick Client has been omitted from release 10.0.x. Now you can perform the functionalities on the unified Cisco DCNM Web Client instead of another LAN thick client. DCNM SAN and DCNM DM Clients are an installation option. All Cisco DCNM Web Client and Cisco DCNM for SAN product documentation is now published to the Data Center Network Manager listing page on Cisco.com: 
 
    [bookmark: pgfId-103024]http://www.cisco.com/en/US/products/ps9369/tsd_products_support_configure.html.
 
   
 
  
 
  
  
   
   
    
     [bookmark: pgfId-1519285][bookmark: 92652]Cisco DCNM User Roles 
      
      
 
     
 
 
    [bookmark: pgfId-1550393]Cisco DCNM defines what operations a user can perform in Cisco DCNM Web Client by controlling what features are available in the menu and tool bar items. Cisco DCNM role-based authorization limits access to the server operations depending on the user roles. 
 
    [bookmark: pgfId-1550394]This chapter contains following sections:
 
     
     	 [bookmark: pgfId-1550398]Cisco DCNM Credentials
 
     	 [bookmark: pgfId-1550399]Cisco DCNM Users
 
     	 [bookmark: pgfId-1550606]DCNM Roles
 
     	 [bookmark: pgfId-1550891]Roles from Cisco DCNM Perspective
 
    
 
   
 
    
     [bookmark: pgfId-1519342][bookmark: 40876]Cisco DCNM Credentials
 
    [bookmark: pgfId-1543292]Cisco DCNM has two sets of credentials, namely:
 
     
     	 [bookmark: pgfId-1561944]Device credentials—used to discover and manage devices
 
     	 [bookmark: pgfId-1561960]Cisco DCNM credentials—used to access the Cisco DCNM server.
 
    
 
    [bookmark: pgfId-1549812]This document describes about DCNM credentials and how user roles are mapped to specific set of DCNM server operations.
 
   
 
    
     [bookmark: pgfId-1519468][bookmark: 52660]Cisco DCNM Users
 
    [bookmark: pgfId-1550814]Cisco DCNM user-based access allows the administrator to control the access to the Cisco DCNM server by using the DCNM client (Web Client or LAN client). The user access is secured by a password.
 
     
      
    
 
    
 
    [bookmark: pgfId-1570015]Note Beginning from Release 10.0(x), DCNM does not allow you to reset the password using adduser script. You must logon to Cisco DCNM Web UI to reset the password. The adduser script is used only to add a new DCNM user on the existing DCNM setup.
 
     
     
 
    
 
    
 
   
 
    
     [bookmark: pgfId-1550836][bookmark: 13802]DCNM Roles
 
    [bookmark: pgfId-1562396]Cisco DCNM performs authorization of access to the users based on roles. The role-based authorization limits access to the Cisco DCNM server operations based on the roles to which the users are assigned. Cisco DCNM does not define new roles to access the DCNM server; however, the Cisco DCNM leverages the existing roles that are supported on the devices monitored, such as Cisco MDS 9000 Series Switches, and Cisco Nexus Switches. 
 
    [bookmark: pgfId-1562464]Cisco DCNM supports following roles:
 
     
     	 [bookmark: pgfId-1551353]global-admin
 
     	 [bookmark: pgfId-1551381]network-admin
 
     	 [bookmark: pgfId-1551400]lan-network-admin
 
     	 [bookmark: pgfId-1551424]san-network-admin
 
     	 [bookmark: pgfId-1551454]san-admin
 
     	 [bookmark: pgfId-1551476]server-admin
 
     	 [bookmark: pgfId-1551490]sme-admin
 
     	 [bookmark: pgfId-1551714]sme-stg-admin
 
     	 [bookmark: pgfId-1551754]sme-kmc-admin
 
     	 [bookmark: pgfId-1551789]sme-recovery
 
     	 [bookmark: pgfId-1551823]network-operator
 
    
 
    [bookmark: pgfId-1551861]In a typical enterprise environment, users and their roles are defined in a centralized place such as, TACACS+, RADIUS or LDAP. As Cisco DCNM supports the existing device roles, the administrator need not define new roles specifically.
 
   
 
    
     [bookmark: pgfId-1557030][bookmark: 37948]Roles from Cisco DCNM Perspective
 
    [bookmark: pgfId-1557040]Cisco DCNM perspective defines the operations a user can perform on the Cisco DCNM client by controlling the menu and tool bar items. Different perspectives define different set of operations.
 
    [bookmark: pgfId-1562596]For example, the Admin perspective allows all the operations by showing all the menu and tool bar items where as Operator perspective allows limited set of operation by hiding Admin and Config Menu items. 
 
    [bookmark: pgfId-1557041]Each DCNM user role is mapped to a particular DCNM perspective, which allows limited access to server features. DCNM clients support following four perspectives:
 
     
     	 [bookmark: pgfId-1557031]Admin Perspective
 
     	 [bookmark: pgfId-1557106]Server Admin Perspective
 
     	 [bookmark: pgfId-1557120]SME Perspective
 
     	 [bookmark: pgfId-1557125]Operator Perspective
 
    
 
     
      
       
       [bookmark: pgfId-1557410]Table 2-1 [bookmark: DCNM_Roles_and_Perspectives_Mapping_Table]DCNM Roles and Perspectives Mapping Table
 
       
       
        
        	 
          
          [bookmark: pgfId-1557414]Role 
         
  
        	 
          
          [bookmark: pgfId-1557416]Perspective 
         
  
       
 
        
        	[bookmark: pgfId-1557418]global-admin
  
        	 [bookmark: pgfId-1557420]Admin Perspective
  
       
 
        
        	[bookmark: pgfId-1557422]network-admin
  
       
 
        
        	[bookmark: pgfId-1557426]san-admin
  
       
 
        
        	[bookmark: pgfId-1557430]san-network-admin
  
       
 
        
        	[bookmark: pgfId-1557434]lan-network-admin (Web Client)
  
       
 
        
        	[bookmark: pgfId-1557438]server-admin
  
        	[bookmark: pgfId-1557440]Server Admin Perspective
  
       
 
        
        	[bookmark: pgfId-1557442]sme-admin
  
        	 [bookmark: pgfId-1557444]SME Perspective
  
       
 
        
        	[bookmark: pgfId-1557446]sme-sgt-admin
  
       
 
        
        	[bookmark: pgfId-1557450]sme-kmc-admin
  
       
 
        
        	[bookmark: pgfId-1557454]sme-recovery
  
       
 
        
        	[bookmark: pgfId-1557458]network-operator
  
        	 [bookmark: pgfId-1557460]Operator Perspective
  
       
 
        
        	[bookmark: pgfId-1557462]lan-network-admin (SAN Thick Client)
  
       
 
       
     
 
    
 
     
      [bookmark: pgfId-1557786][bookmark: 34586]Admin Perspective
 
     [bookmark: pgfId-1558530]Admin Perspective can be accessed through the Cisco DCNM Web Client and SAN Client only, by the users who are assigned the role of global-admin, network-admin, san-admin, san-network-admin and lan-network-admin.
 
    
 
     
      [bookmark: pgfId-1557814]Web Client Admin Perspective
 
     [bookmark: pgfId-1557857]Web client admin perspective has full control of the DCNM server and can access all the features. Via the access to the Admin menu items, the users also has full control of Cisco DCNM authentication settings.
 
    
 
     
      [bookmark: pgfId-1557863]SAN Thick Client Admin Perspective
 
     [bookmark: pgfId-1557904]SAN thick client admin perspective has full control of the DCNM server and can access all the features. All the top-level menu items are accessible.
 
    
 
     
      [bookmark: pgfId-1557910][bookmark: 30647]Server Admin Perspective
 
     [bookmark: pgfId-1559307]Server admin perspective can be accessed via web client and SAN thick client only by the users who are assigned the role of server-admin.
 
    
 
     
      [bookmark: pgfId-1557940]Web Client Server Admin Perspective
 
     [bookmark: pgfId-1559395]Web client server admin perspective has access to all the web client features. Via the access to the Admin menu items, the users also has full control of Cisco DCNM authentication settings.
 
    
 
     
      [bookmark: pgfId-1557986]SAN Thick Client Server Admin Perspective
 
     [bookmark: pgfId-1559534]The configuration capabilities of a server admin role are limited to FlexAttach and relevant data. The server admin can pre-configure SAN for new servers, move a server to another port on the same NPV device or another NPV device and replace a failed server onto the same port without involving the SAN administrator. The server admin will not be able to manage Fabric Manager users or connected clients. The menu items that are not related to server management are not accessible, e.g. Zone, Performance, etc. SAN thick client server admin perspective has no access to Discover button, Fabrics and License Files tabs. The server admin is not able to manage Fabric Manager users or connected clients in SAN thick client.
 
    
 
     
      [bookmark: pgfId-1558035][bookmark: 60444]SME Perspective
 
     [bookmark: pgfId-1559921]Storage Media Encryption (SME) perspective is designed for sme-admin, sme-sgt-admin, sme-kmc-admin and sme-recovery role-based users. It can be categorized to five different sme admin perspective according to the roles:
 
      
      	 [bookmark: pgfId-1560114]Web Client SME Admin Perspective
 
      	 [bookmark: pgfId-1560148]SME Storage Perspective
 
      	 [bookmark: pgfId-1560162]SME Key Management Perspective
 
      	 [bookmark: pgfId-1560176]SME Recovery Perspective
 
      	 [bookmark: pgfId-1560190]SAN Thick Client SME Perspective
 
     
 
    
 
     
      [bookmark: pgfId-1558063][bookmark: 88955]Web Client SME Admin Perspective 
 
     [bookmark: pgfId-1559888]Web client sme admin perspective is designed to sme-admin role users who have no access to Admin and Config menu items in the Web client and cannot use features under those menu items. On the other hand, the SME provision features are accessible.
 
    
 
     
      [bookmark: pgfId-1560642][bookmark: 94629]SME Storage Perspective 
 
     [bookmark: pgfId-1560643]SME storage perspective is designed to the sme-stg-admin role users. sme-stg-admin role users have same perspective as sme-admin role except you cannot manage the key management features.
 
    
 
     
      [bookmark: pgfId-1560802][bookmark: 78223]SME Key Management Perspective
 
     [bookmark: pgfId-1560858]SME key management perspective is designed to the sme-kmc-admin role users. sme-kmc-admin role users have same perspective as sme-admin role except that you cannot perform SME configurations.
 
    
 
     
      [bookmark: pgfId-1565394][bookmark: 25961]SME Recovery Perspective
 
     [bookmark: pgfId-1565395]SME recovery perspective is designed to the sme-recovery role users for master key recovery. sme-recovery role users have same perspective as sme-admin role except that you cannot perform the storage and key management features.
 
    
 
     
      [bookmark: pgfId-1565397][bookmark: 17986]SAN Thick Client SME Perspective
 
     [bookmark: pgfId-1565398]SAN thick client SME perspective has no access to Discover button, Fabrics and License Files tabs.All the SME related perspective would not be able to manage Fabric Manager users or connected clients, as well as operator perspective.
 
    
 
     
      [bookmark: pgfId-1558374][bookmark: 21904]Operator Perspective
 
     [bookmark: pgfId-1561257]Operator perspective is designed for network-operator and lan-network-admin role users, and lan-network-admin role only has SAN thick client operator perspective. 
 
    
 
     
      [bookmark: pgfId-1558248]Web Client Operator Perspective
 
     [bookmark: pgfId-1561315]Web client operator perspective has no access to Admin and Config menu items and the features under those menu items cannot be used. All the other features can be used.
 
    
 
     
      [bookmark: pgfId-1558458]SAN Thick Client Operator Perspective
 
     [bookmark: pgfId-1561267]SAN thick client operator perspective has no access to Discover button, Fabrics and License Files tabs, and would not be able to manage Fabric Manager users or connected clients.
 
    
 
   
 
  
 
  
  
   
   
    
     [bookmark: pgfId-1519285][bookmark: 92652]Device Pack for Cisco DCNM 
      
      
 
     
 
 
    [bookmark: pgfId-1569151]The device pack is a modular installation that can be applied on Cisco DCNM. The device pack adds support for the Cisco Nexus Switches to Cisco DCNM versions.
 
   
 
    
     [bookmark: pgfId-1569705][bookmark: 52871]Installing the Device Pack
 
    [bookmark: pgfId-1569861]Perform the following steps to install the device pack with DCNM.
 
    
 
    [bookmark: pgfId-1569862]Step 1 Navigate to www.cisco.com/go/dcnm, and download the latest device pack.
 
     
     [bookmark: pgfId-1570471]Example: 
    
 
    [bookmark: pgfId-1572446]dcnm-device-pack.10.0.1.DP.1.zip
 
    [bookmark: pgfId-1570427]Step 2 Copy the zip file to the DCNM machine.
 
    [bookmark: pgfId-1569935]Step 3 Stop the DCNM applications by using the appropriate command.
 
     
     	 [bookmark: pgfId-1572953]For Cisco DCNM in Standalone and Federation modes, use  appmgr stop dcnm command.
 
     	 [bookmark: pgfId-1572954]For Cisco DCNM in Native HA mode, use the Stop_DCNM_Servers script under the /root folder.
 
     	 [bookmark: pgfId-1572955]For Cisco DCNM in Linux Standalone and Federation modes, use stopSANServer.sh command.
 
     	 [bookmark: pgfId-1569959]For Cisco DCNM in Windows Standalone and Federation modes, use stopSanService.bat command.
 
    
 
    [bookmark: pgfId-1570022]Step 4 Navigate to the location where you have saved the device pack and extract the files
 
    [bookmark: pgfId-1571589]Step 5 Execute the patch file by using the following command:
 
     
      
    
 
    
 
    [bookmark: pgfId-1571721]Note For Federation and Native-HA setup with Cisco DCNM, ensure that the device pack is installed on both primary and secondary devices.
 
     
     
 
    
 
    
 
    [bookmark: pgfId-1570073]Step 6 After the patch installation is complete, restart DCNM applications using the appropriate command.
 
     
     	 [bookmark: pgfId-1571185]For Cisco DCNM in Standalone and Federation modes, use  appmgr start dcnm command.
 
     	 [bookmark: pgfId-1571186]For Cisco DCNM in Native HA mode, use the Start_DCNM_Servers script under the /root folder.
 
     	 [bookmark: pgfId-1571187]For Cisco DCNM in Linux Standalone and Federation modes, use startSANServer.sh command.
 
     	 [bookmark: pgfId-1571188]For Cisco DCNM in Windows Standalone and Federation modes, use startSanService.bat command.
 
    
 
    [bookmark: pgfId-1570172]Step 7 Navigate to Cisco DCNM Web Client > Administration> DCNM Server > Modular Device Support for view the list of patches applied to the Cisco DCNM. You can verify the patch installation on the Cisco DCNM Web Client. 
 
    [bookmark: pgfId-1570305]
 
     
     
 
    
 
    
 
   
 
  
 
  
  
   
   
    
     [bookmark: pgfId-1587797][bookmark: 19264]Cisco DCNM Web Client 
      
      
 
     
 
 
    [bookmark: pgfId-1569037]Using Cisco DCNM Web Client, you can monitor Cisco MDS and Nexus family switch events, performance and inventory, and perform minor administrative tasks.
 
    [bookmark: pgfId-1569041]The default user credentials to access Cisco DCNM, Release 10.0.x are as configured during the deployment of the installers.
 
    [bookmark: pgfId-1569042]Cisco DCNM Web Client provides the following features: 
 
     
     	 [bookmark: pgfId-1569046]Navigating DCNM Web Client
 
     	 [bookmark: pgfId-1569050]Downloading Cisco DCNM-SAN Client
 
     	 [bookmark: pgfId-1569054]Downloading Cisco Device Manager Client
 
     	 [bookmark: pgfId-1569058]Viewing Dashboard Information
 
     	 [bookmark: pgfId-1569062]Viewing Topology Information
 
     	 [bookmark: pgfId-1569066]Viewing Inventory Information
 
     	 [bookmark: pgfId-1569070]Viewing Monitor Information
 
     	 [bookmark: pgfId-1569074]Viewing Administration Information
 
     	 [bookmark: pgfId-1569078]Using Cisco DCNM Web Client with SSL
 
     	 [bookmark: pgfId-1587660]Enhancements in Cisco DCNM Release 10.2(1)
 
    
 
   
 
    
     [bookmark: pgfId-1587662][bookmark: 91275]Navigating DCNM Web Client
 
    [bookmark: pgfId-1587663]Cisco Data Center Network Manager (DCNM) is a management system for the Cisco Unified Fabric. It enables you to provision, monitor, and troubleshoot the data center network infrastructure. It provides visibility and control of the unified data center. Cisco DCNM provides a comprehensive feature set that meets the routing, switching, and storage administration needs of data centers. Cisco DCNM streamlines the provisioning for the unified fabric and monitors the SAN and LAN components. Cisco DCNM provides a high level of visibility and control through a single web based management console for Cisco Nexus, Cisco MDS, and Cisco Unified Computing System (UCS) products. During the DCNM installation, you can choose to install applications related to Unified Fabric only for Unified Fabric-mode installations.
 
    [bookmark: pgfId-1569086]The DCNM Web Client has standardized certain navigation conventions.
 
     
     	 [bookmark: pgfId-1569090]Scope Menu
 
     	 [bookmark: pgfId-1569094]Admin Menu
 
     	 [bookmark: pgfId-1569098]Table and Filtering Navigation
 
     	 [bookmark: pgfId-1569102]Printing
 
     	 [bookmark: pgfId-1569106]Exporting to a File
 
     	 [bookmark: pgfId-1569110]Sorting Columns
 
     	 [bookmark: pgfId-1569114]Cisco DCNM Web Search Engine
 
    
 
     
      [bookmark: pgfId-1569116][bookmark: 81853]Scope Menu 
 
     [bookmark: pgfId-1569117]Beginning with Cisco NX-OS Release 6.x, a new drop-down list called Scope is added to Cisco DCNM Web Client that applies to all pages except the Administration and Configure pages.
 
     [bookmark: pgfId-1569118]You can use the scope menu to filter network information by:
 
      
      	 [bookmark: pgfId-1569119]Data Center
 
      	 [bookmark: pgfId-1569120]Default_LAN 
 
      	 [bookmark: pgfId-1569121]Default_SAN 
 
      	 [bookmark: pgfId-1569122]Individual Fabric Various other custom scopes created by the users.
 
     
 
     [bookmark: pgfId-1569123]The features accessible from the tabs are limited to the areas that you choose in the filter tree.
 
    
 
     
      [bookmark: pgfId-1569125][bookmark: 53807]Admin Menu
 
     [bookmark: pgfId-1569126]You can use the admin menu to:
 
      
      	 [bookmark: pgfId-1569127]DCNM SAN: Launch the SAN Client.
 
      	 [bookmark: pgfId-1569128]DCNM DM: Launch the Device Manager Client which is part of the SAN option.
 
      	 [bookmark: pgfId-1569129]Change Password: Changes the password for the current logged in user. 
 
      	 [bookmark: pgfId-1569130]Help Content: Pops out the online help of the current page.
 
      	 [bookmark: pgfId-1569131]About: Display the information about Cisco Data Center Network Manager.
 
      	 [bookmark: pgfId-1569132]Logout: Logout from the DCNM Web Client. 
 
     
 
    
 
     
      [bookmark: pgfId-1569134][bookmark: 85497]Table and Filtering Navigation
 
     [bookmark: pgfId-1569135]Some tables that can be filtered will have a filter option to view subsets of the information. Either choose the filter menu or click Filter. An editable row at the top of the table appears. Enter values into the table cells and click Return to display matching rows.
 
    
 
     
      [bookmark: pgfId-1569137][bookmark: 57161]Printing
 
     [bookmark: pgfId-1569138]Click Print to view the table in a printer-friendly format. You can then print the page from the browser. 
 
    
 
     
      [bookmark: pgfId-1569140][bookmark: 73189]Exporting to a File
 
     [bookmark: pgfId-1569141]An Export icon is in the upper right corner of some tables or top right corner of the window. Click this icon to export the data to Microsoft Excel. 
 
    
 
     
      [bookmark: pgfId-1569143][bookmark: 76328]Sorting Columns
 
     [bookmark: pgfId-1569144]Not all columns are sortable but you can click a sortable column head to sort the information for that column. 
 
    
 
     
      [bookmark: pgfId-1569146][bookmark: 16856]Cisco DCNM Web Search Engine 
 
     [bookmark: pgfId-1569147]The search engine helps you to locate records according to the following search criteria: 
 
      
      	 [bookmark: pgfId-1569148]Search by Name. 
 
      	 [bookmark: pgfId-1569149]Search by IP Address. 
 
      	 [bookmark: pgfId-1569150]Search by WWN. 
 
      	 [bookmark: pgfId-1569151]Search by Alias. 
 
      	 [bookmark: pgfId-1569152]Search by MAC Address. 
 
      	 [bookmark: pgfId-1569153]Search by Serial Number. 
 
     
 
    
 
     
      [bookmark: pgfId-1569155][bookmark: 49266]Using the Cisco DCNM Search Engine 
 
     
 
     [bookmark: pgfId-1569156]Step 1 Click Search box on the top right corner of the main window. 
 
     [bookmark: pgfId-1569157]You see the search text box. 
 
     [bookmark: pgfId-1569158]Step 2 Use the drop-down to search by: 
 
      
      	 [bookmark: pgfId-1569159]Name 
 
      	 [bookmark: pgfId-1569160]IP Address 
 
      	 [bookmark: pgfId-1569161]WWN 
 
      	 [bookmark: pgfId-1569162]Alias 
 
      	 [bookmark: pgfId-1569163]MAC Address
 
      	 [bookmark: pgfId-1569164]Serial Number
 
     
 
     [bookmark: pgfId-1569165]Step 3 Enter the value based on the search option and click the arrow to begin the search. 
 
     [bookmark: pgfId-1569166]The search results are displayed in a new window. 
 
    
 
   
 
    
     [bookmark: pgfId-1569168][bookmark: 50667]Downloading Cisco DCNM-SAN Client
 
    [bookmark: pgfId-1569169]You must use Cisco DCNM Web Client to launch Cisco DCNM-SAN Client.
 
    
 
    [bookmark: pgfId-1569170]Step 1 On the top right of the DCNM Web Client home screen, click the settings icon next to the login user. Select DCNM-SAN option. 
 
    [bookmark: pgfId-1569171]Step 2 If you have the latest Java version installed, a Warning message is displayed.
 
    [bookmark: pgfId-1569172]Step 3 Click Run with the latest version button.
 
    [bookmark: pgfId-1569173]Step 4 Enter the user credentials to log on to Cisco DCNM-SAN client. This message appears only the first time you launch Cisco DCNM-SAN Client.
 
   
 
    
     [bookmark: pgfId-1569176][bookmark: 10682][bookmark: 46606]Downloading Cisco Device Manager Client 
 
    [bookmark: pgfId-1569177]You must use Cisco DCNM Web Client to Install Cisco Device Manager client.
 
     
      
    
 
    
 
    [bookmark: pgfId-1569178]Note Device Manager Client is part of the SAN option.
 
     
     
 
    
 
    
 
    
 
    [bookmark: pgfId-1569179]Step 1 On the top right of the DCNM Web Client home screen, click the settings icon next to the login user. Select DCNM DM option. 
 
    [bookmark: pgfId-1569180]Step 2 If you have the latest Java version installed, a Warning message is displayed.
 
     
      
    
 
    
 
    [bookmark: pgfId-1569181]Note Cisco DCNM Device Manager supports JRE versions 1.6 and 1.7. Follow the instructions in the Cisco Device Manager installer wizard to proceed with the installation. 
 
     
     
 
    
 
    
 
    [bookmark: pgfId-1569182]Step 3 Once the installation is complete, enter the user credentials to log on to the Cisco Device Manager client.
 
   
 
    
     [bookmark: pgfId-1569185][bookmark: 28868][bookmark: 28343]Viewing Dashboard Information 
 
    [bookmark: pgfId-1569186]The Cisco DCNM Web Client dashboard gives you comprehensive information of the following: 
 
     
     	 [bookmark: pgfId-1569187] Summary - You can view the summary dashboard which displays the overall functioning of all the devices connected. It gives you daily statistics of the connected devices. New panels has been introduced in release 10.0.x to simplify the management of LAN and SAN clients.
 
     	 [bookmark: pgfId-1569191] Network - You can view the information of switches including status and license, as well as detailed switch dashboard information for a specific switch. 
 
     	 [bookmark: pgfId-1569192] Storage - You can view details about the storage device along with its events and topology.
 
     	 [bookmark: pgfId-1569193] Compute - You can view the details and events for a particular Host along with its events and topology. 
 
    
 
     
      
    
 
    
 
    [bookmark: pgfId-1569194]Note Compute is available only with SAN installation
 
     
     
 
    
 
    
 
    [bookmark: pgfId-1569197]For more information about the Dashboard tab, refer to the Web Client Online Help.
 
   
 
    
     [bookmark: pgfId-1569200][bookmark: 10948][bookmark: 78800]Viewing Topology Information 
 
    [bookmark: pgfId-1569201]Topology is a first class menu item in this release with the intention that it is fully functional for providing detailed access to configuration as well as monitoring functionality. The Cisco DCNM topology consolidates functionality in the existing Fabric topology as well as the current Dashboard topology into a new fully featured topology which includes the following features in a single view:
 
     
     	 [bookmark: pgfId-1569202]Optional display of Vinci Balls or device icons.
 
     	 [bookmark: pgfId-1569203]Display of Multi-link, Port-channels, VPCs.
 
     	 [bookmark: pgfId-1569204]Display of Inter-fabric links.
 
     	 [bookmark: pgfId-1569205]VDC and Pod Groupings.
 
     	 [bookmark: pgfId-1569206]Device-Scope, Fabric and Datacenter drill-down.
 
     	 [bookmark: pgfId-1569207]Automatic VPC Peer and FEX Groupings.
 
     	 [bookmark: pgfId-1569208]Ability to select devices and take action consistent with other areas of the product.
 
    
 
    [bookmark: pgfId-1570219]For more information about Topology, refer to the Web Client Online Help.
 
   
 
    
     [bookmark: pgfId-1569213][bookmark: 46753]Viewing Inventory Information
 
    [bookmark: pgfId-1576142]Beginning with Cisco DCNM release 6.x, you can view the inventory and the performance for both SAN and LAN switches by using the global Scope pane. You can select LAN, SAN, or both to view the inventory information. You can also export and print the inventory information. In this tab, you can find the discovered LAN switches, SAN switches, Storage devices and Virtual Machine Manager. You can also add a new discovery LAN or SAN switch as well.
 
    [bookmark: pgfId-1576143]For more information about Inventory tab, refer to the Web Client Online Help.
 
   
 
    
     [bookmark: pgfId-1576145][bookmark: 11764]Viewing Monitor Information
 
    [bookmark: pgfId-1597338]You can get the performance statistics of CPU, Memory, Traffic, others, accounting and events information. You can also view performance information about SAN and LAN. You can also create customized reports based on historical performance, events, and inventory information gathered in this tab. You can create aggregate reports with summary and detailed views. You can also view previously saved reports. 
 
    [bookmark: pgfId-1597414]For more information about Monitor tab, refer to the Web Client Online Help.
 
   
 
    
     [bookmark: pgfId-1570384]Viewing Configure Information
 
    [bookmark: pgfId-1570515]Allow user to view and configure Zoning, Device Alias, Port Monitoring and Device Credentials.
 
    [bookmark: pgfId-1570540]For more information about Configure tab, refer to the Web Client Online Help.
 
   
 
    
     [bookmark: pgfId-1570518][bookmark: 69682]Viewing Administration Information
 
    [bookmark: pgfId-1569231]You can view and configure DCNM servers, DCNM users, performance setup and event setup.
 
    [bookmark: pgfId-1569234]For more information about Administration tab, refer to the Web Client Online Help.
 
   
 
    
     [bookmark: pgfId-1569240][bookmark: 43180][bookmark: 64552][bookmark: 55199][bookmark: 14163]Using Cisco DCNM Web Client with SSL[bookmark: marker-1569239]
 
    [bookmark: pgfId-1569245]From release 10.0.x, Cisco DCNM Web Client uses HTTPs. If you want to install [bookmark: marker-1569244]SSL certificates and use Cisco DCNM Web Client over HTTPs (using [bookmark: marker-1569246]TCP port 443 or another custom port), you need a certificate for each external IP address that accepts secure connections. You can purchase these certificates from a well-known Certificate Authority ([bookmark: marker-1569247]CA).
 
    [bookmark: pgfId-1569248]To enable SSL, you must set up the keystore to use either a self-signed certificate or a certificate from a trusted third-party company such as VeriSign.
 
    [bookmark: pgfId-1569249]This section includes the following topics:
 
     
     	 [bookmark: pgfId-1569253]Creating a Local Certificate
 
     	 [bookmark: pgfId-1569257]Creating a Certificate Request
 
    
 
     
      [bookmark: pgfId-1569263][bookmark: 10272]Creating a Local Certificate
 
     
 
     [bookmark: pgfId-1569264]Step 1 Set up a keystore to use a self-signed certificate (local certificate). From the command line, enter the following command on windows:
 
      
      [bookmark: pgfId-1569265]%JAVA_HOME%/bin/keytool -genkey -alias tomcat -keyalg RSA -keystore "C:\Program Files\Cisco Systems\dcm\jboss-as-7.2.0.Final\standalone\configuration\fmserver.jks" 
     
 
      
      [bookmark: pgfId-1569266] 
     
 
     [bookmark: pgfId-1569267]Step 2 Enter your name, organization, state, and country. Enter change it when prompted for a keystore password. If you prefer to use your own password, do not forget to change the keystorepass attribute in the server.xml file. When prompted for a key password, press Enter or use the same password as the keystore password. 
 
      
       
     
 
     
 
     [bookmark: pgfId-1569268]Note You can now follow the steps in the next section for modifying DCNM Web Client to use SSL.
 
      
      
 
     
 
     
 
     [bookmark: pgfId-1569269]To obtain a certificate from the Certificate Authority of your choice, you must create a Certificate Signing Request (CSR). The CSR is used by the certificate authority to create a certificate that identifies your website as secure. 
 
    
 
     
      [bookmark: pgfId-1569271][bookmark: 94493]Creating a Certificate Request
 
     
 
     [bookmark: pgfId-1569272]Step 1 Create a local certificate (as described in the previous section).
 
      
       
     
 
     
 
     [bookmark: pgfId-1569273]Note You must enter the domain of your website in the fields First and Last name in order to create a working certificate.
 
      
      
 
     
 
     
 
     [bookmark: pgfId-1569274]Step 2 Create the CSR with this commandon windows: 
 
      
      [bookmark: pgfId-1569275]keytool -certreq -keyalg RSA -alias tomcat -file certreq.csr -keystore "C:\Program Files\Cisco Systems\dcm\jboss-as-7.2.0.Final\standalone\configuration\fmserver.jks" 
     
 
      
      [bookmark: pgfId-1569276] 
     
 
     [bookmark: pgfId-1569277]Now you have a file called certreq.csr. The file is encoded in PEM format. You can submit it to the certificate authority. You can find instructions for submitting the file on the Certificate Authority website.
 
     [bookmark: pgfId-1569278]Step 3 After you have your certificate, you can import it into your local keystore. You must first import a Chain Certificate or Root Certificate into your keystore. You can then import your certificate.
 
     [bookmark: pgfId-1569279]Step 4 Download a Chain Certificate from the Certificate Authority where you obtained the certificate:
 
      
       
       	 [bookmark: pgfId-1569280]For Verisign.com commercial certificates, go to this URL:
 
      
 
     
 
     [bookmark: pgfId-1569281]http://www.verisign.com/support/install/intermediate.html
 
      
      [bookmark: pgfId-1569282] 
     
 
      
      	 [bookmark: pgfId-1569283]For Verisign.com trial certificates, go to this URL:
 
     
 
     [bookmark: pgfId-1569284]http://www.verisign.com/support/verisign-intermediate-ca/Trial_Secure_Server_Root/index.html
 
      
      [bookmark: pgfId-1569285] 
     
 
      
       
       	 [bookmark: pgfId-1569286]For Trustcenter.de, go to this URL: 
 
      
 
     
 
     [bookmark: pgfId-1569287]http://www.trustcenter.de/certservices/cacerts/en/en.htm#server
 
      
      [bookmark: pgfId-1569288] 
     
 
      
       
       	 [bookmark: pgfId-1569289]For Thawte.com, go to this URL: 
 
      
 
     
 
     [bookmark: pgfId-1569290]http://www.thawte.com/certs/trustmap.html
 
      
      [bookmark: pgfId-1569291] 
     
 
      
       
       	 [bookmark: pgfId-1569292]Import the Chain Certificate into your keystore by entering the  keytool -import -alias root -keystore " C:\Program Files\Cisco Systems\dcm\jboss-as-7.2.0.Final\standalone\configuration\fmserver.jks" -trustcacerts -file filename_of_the_chain_certificate command. 
 
       	 [bookmark: pgfId-1569293]Import the new certificate in X509 format by entering the  keytool -import -alias tomcat -keystore " C:\Program Files\Cisco Systems\dcm\jboss-as-7.2.0.Final\standalone\configuration\fmserver.jks" -trustcacerts -file your_certificate_filename command. 
 
      
 
     
 
    
 
   
 
    
     [bookmark: pgfId-1594300][bookmark: 60018]Enhancements in Cisco DCNM Release 10.2(1)
 
    [bookmark: pgfId-1596605]The following features and enhancements are available with Cisco DCNM Release 10.2(1). 
 
    [bookmark: pgfId-1596787]For details about configuring the feature using DCNM Web Client, see the Cisco DCNM Web Client Online Help.
 
     
      [bookmark: pgfId-1596608][bookmark: 82344]Enhancements to Media Controller 
 
     [bookmark: pgfId-1594631]The following are the enhancements made to Media Controller in this release:
 
      
      	 [bookmark: pgfId-1594632]Bandwidth Tracking on Host Facing Link—The senders and receivers can connect to Leaf switches of the PMN Fabric. The sender initiates a multicast flow and the receiver subscribes to a multicast flow. Since multicast is used, there can bemultiple receivers subscribing to a flow. The senders are devices such as cameras, microphones, playback devices etc. The receivers are devices such as video monitors, speakers, multi-viewers etc. You can track the bandwidth on the host facing link. Using this functionality, DCNM do not allows the receiver to request for more flows or sender to send more flows than the available bandwidth on the host facing link.
 
      	 [bookmark: pgfId-1594633]Topology Visualization—Cisco DCNM 10.2(1) consists of a new scalable Topology visualization UI, which shows the PMN Fabric, endpoints attached to the fabric along with the ability to perform searches.
 
      	 [bookmark: pgfId-1588686]Endpoint (Sender and Receiver management)—Senders and receivers can connect to the Leaf switches of the PMN Fabric. The Sender initiates a multicast flow and the Receiver subscribes to a multicast flow. Cisco DCNM exposes the API for registration of the Sender and Receiver. DCNM also allows the Sender/Receiver to be validated/authenticated by the API user. A table lists all the current registered senders and receivers with information about the flow instances. DCNM UI and REST APIs allow users to add additional metadata to the receiver/sender information, such as Camera-BXB or Camera-SJ, to aid in easy mapping.
 
      	 [bookmark: pgfId-1594785]Flow Alias—Using the Flow Alias feature, you can specify names for multicast groups and flows. The multicast IP addresses are difficult to remember, thus by assigning a name to the multicast IP address, you can search and add policies based on the name. You can configure flow alias on Cisco Web Client > Media Controller > Flow Alias.
 
     
 
     [bookmark: pgfId-1593778]To enable Media Controller on the Cisco DCNM Web Client, you must install the DCNM in media-controller mode. See Cisco DCNM Installation Guide, Release 10.2(x) for more information. 
 
     [bookmark: pgfId-1593779]You can monitor the devices from the Cisco DCNM Web Client > Media Controller.
 
     [bookmark: pgfId-1596697]For more information, see the Cisco DCNM Web Client Online Help.
 
     [bookmark: pgfId-1596684]
 
    
 
     
      [bookmark: pgfId-1593780][bookmark: 31351]LAN Fabric Provisioning
 
     [bookmark: pgfId-1594968]In this release, DCNM provides a new wizard that enables you to deploy a network with ease. This feature provides simple network overlay provisioning for Cisco Nexus 9000 VXLAN EVPN LAN Fabrics. This deploys networks populated by DCNM profile templates. To start, you need to select an existing fabric or add a new fabric and then define Fabric Settings. 
 
     [bookmark: pgfId-1595056]After you select or create a fabric, you can continue to the next step to select a network. You can add a new or edit/delete/select an existing network. To access this feature, choose Configure > LAN Fabric Provisioning > Network Deployment.
 
     [bookmark: pgfId-1595057]For more information, see the Cisco DCNM Web Client Online Help.
 
    
 
     
      [bookmark: pgfId-1595058][bookmark: 85849]IPv6 Support
 
     [bookmark: pgfId-1589154]In this release, DCNM enables you to manage switches with either IPv4 or IPv6 management interfaces. DCNM Web access (DCNM management interface) still supports IPv4 only. The extended fabric interface (eth1) supports both IPv4 and IPv6. DCNM supports LAN switches with IPv6 management interface, not for SAN switches. Also, DCNM OVA/ISO installation supports the LAN switches with IPv6 management interface. The Windows/Linux installation will not support IPv6 management interface.
 
     [bookmark: pgfId-1589155]DCNM allows POAP to LAN switches with IPv4 only, but the switch definition allows management interface to be configured with IPv6 address. Once POAP is complete, if switch management interface is configured with IPv6, then DCNM communicates with the switch via SNMP/SSH/NxAPI/Syslog with IPv6. For Programmable Fabric, switch can also communicate to the LDAP on DCNM server with IPv6.
 
    
 
     
      [bookmark: pgfId-1589670][bookmark: 99400]FEX Configuration
 
     [bookmark: pgfId-1590769]The Fabric Extender feature allows you to manage a Cisco Nexus 2000 Series Fabric Extender and its association with the Cisco NX-OS switch that it is attached to. From Release 10.2(1), you can create and modify FEX for the LAN devices from Cisco DCNM Web Client > Inventory > Switches. FEX feature is available on LAN devices only. 
 
      
       
     
 
     
 
     [bookmark: pgfId-1597600]Note If a Cisco Nexus Switch is discovered as part of SAN fabric, FEX feature is not available.
FEX is also not supported on Cisco Nexus 1000V devices.
For Cisco Nexus 9500 switches, 4x10G breakout for FEX connectivity is not supported. 
 
     [bookmark: pgfId-1597872]
 
      
      
 
     
 
     
 
    
 
     
      [bookmark: pgfId-1595199][bookmark: 53573]VDC Enhancements
 
     [bookmark: pgfId-1595200]Beginning with Cisco DCNM Release 10.2(1), you can create and manage VDCs from Cisco DCNM Web Client > Inventory > Switches > VDCs. As Cisco DCNM supports DCNM on Cisco Nexus 7000 Series only, click an active Cisco Nexus 7000 Switch. After you create a VDC, you can change the interface allocation, VDC resource limits, and the high availability (HA) policies.
 
    
 
     
      [bookmark: pgfId-1595183][bookmark: 79355]Network Audit Reporting
 
     [bookmark: pgfId-1590888]DCNM 10.2(1) provides auditing for the configuration change across the network switches. You can get report for all the configuration changes, which happen on the devices in a data center. You can generate an audit report for devices for a given period. To generate reports using the Network Audit config feature, the backup job should be scheduled for that device. The reports can also be exported to an HTML document. If real time job is scheduled for the device, audit will also show the mode through which config changes were made. The audit report uses color codes; green—new config, red—deleted config, and blue—changed config.
 
    
 
     
      [bookmark: pgfId-1589664]VLAN Edit Support
 
     [bookmark: pgfId-1591035]DCNM 10.2(1) allows you to edit a VLAN.
 
    
 
     
      [bookmark: pgfId-1591125][bookmark: 61742]Support for Additional Storage Devices in DCNM Connect 
 
     [bookmark: pgfId-1591379]To expand additional storage coverage, DCNM includes Pure Storage, HDS storage in DCNM connect. For storage array discovery, DCNM will support storage virtualization profile to cover IBM SAN Volume Controller (SVC).
 
    
 
     
      [bookmark: pgfId-1591541][bookmark: 85565]SNMP Poller Adjustment
 
     [bookmark: pgfId-1591530]Currently performance polling interval is a five minutes fixed interval for all the entities except ISL. DCNM 10.2(1) provides the ability to adjust interval to 10 minutes or 15 minutes. To configure the interval, choose Administration > Performance Setup > Database in the DCNM Web UI.
 
    
 
     
      [bookmark: pgfId-1591947][bookmark: 42720]Enhancement to Multi Site Manager
 
     [bookmark: pgfId-1591948]In this release, DCNM provides top level switch information per fabric instead of top level (“Default San”). To access this feature, choose Administration > DCNM Server > Multi Site Manager.
 
    
 
     
      [bookmark: pgfId-1592143][bookmark: 37004]Monitoring Custom Port Groups
 
     [bookmark: pgfId-1592171]Custom port group is used in DCNM report and event forwarding. DCNM enables you to view custom port group and performance statistics. To access this feature, choose Monitor > Custom Port Groups.
 
    
 
     
      [bookmark: pgfId-1592527][bookmark: 45191]Slow Drain Enhancement
 
     [bookmark: pgfId-1592763]In DCNM 10.2(1), you can export slow drain analysis data to a CSV or an Excel file. The default file format for export is CSV. To export this data, choose Monitor > SAN > Slow Drain Analysis.
 
     [bookmark: pgfId-1592876]In addition, DCNM enables you to schedule a slow drain analysis job and send the result via email. 
 
     [bookmark: pgfId-1592877]In the slow drain daily scheduled job page, an ‘Email To’ (optional) field is available, which allows you to enter an email address. The report will be emailed to this configured email address after each job is complete. 
 
     [bookmark: pgfId-1593174]For more information about this new feature, please refer to Web Client Online Help.
 
    
 
     
      [bookmark: pgfId-1593456][bookmark: 64925]Template Enhancement 
 
     [bookmark: pgfId-1593457]In this release, templates will support IPv6.
 
    
 
     
      [bookmark: pgfId-1593452][bookmark: 71458]Endpoint Locator (EPL)
 
     [bookmark: pgfId-1593506]The Endpoint Locator (EPL) feature allows real-time tracking of endpoints within a data center. This includes tracing the life history of an endpoint as well as provides insights into the trends associated with endpoint additions/removals/moves etc. 
 
     [bookmark: pgfId-1593569]With the DCNM OVA or ISO installation, the DCNM VM is deployed with 2 interfaces—eth0 for general access to the DCNM and eth1 interface that is used primarily for fabric management. In most deployments, the eth1 interface is part of the same network on which the mgmt0 interfaces of the Nexus switches reside. This allows DCNM to perform out-of-band management of these devices including out-of-band POAP. Since the BGP process on the Nexus devices only runs on the non-management VRF (specifically default VRF), there is a requirement to have IP connectivity from the DCNM to the fabric through any of the devices using one of the front-panel interfaces. For this purpose, a third interface ethx, is required on the DCNM VM that can provide inband connectivity to the network fabric. This is a pre-requisite for enabling the EPL feature. Addition of a new interface does not require a restart of DCNM VM. Once the vnic is added to the DCNM VM, the corresponding veth interface gets created and shows up in the CentOS VM on which DCNM runs as an ethx interface.
 
     [bookmark: pgfId-1595388]High Availability with Endpoint Locator—The Endpoint Locator feature along with its key components only runs on the active DCNM. However, the search process also runs on the standby DCNM so that all endpoint data and associated events are always synced between the active and standby DCNMs. In this way, during a switchover, the data is already available on the new active DCNM (old standby). In addition, Endpoint locator (EPL) also allows a DCNM standby to be added where there is a only a single DCNM instance running with EPL enabled and subsequently a standby is added at a later stage.
 
     [bookmark: pgfId-1595404]The third interface is required when inband management is used for a fabric via the eth1 interface. This ensures that the management interface used by DCNM for managing the devices and potentially even for POAP should not have any dependency on the interface through which EPL BGP peering occurs.
 
     [bookmark: pgfId-1595419]Once physical connectivity is established between DCNM and the fabric through a switch’s front-panel interface, the following steps explain the appropriate configurations that are performed on the respective switches and DCNM.
 
     [bookmark: pgfId-1595438]Endpoint Locator supports the following features:
 
      
      	 [bookmark: pgfId-1595439]Support for a BGP EVPN Fabric (N9k, N56xx as leafs)
 
      	 [bookmark: pgfId-1595502]Support for a L3VPN or DFA Fabric (N56xx, N6k as leafs)
 
      	 [bookmark: pgfId-1595518]Support for dual-homed endpoints 
 
      	 [bookmark: pgfId-1595535]Support for dual-stack endpoints
 
      	 [bookmark: pgfId-1595551]Supports up to 2 BGP Route-Reflectors (Nexus 9000, Nexus 7999, Nexus 5600, Nexus 6000)
 
      	 [bookmark: pgfId-1595567]Support with and without NX-API (to gather additional information such as port, vlan etc.) 
 
      	 [bookmark: pgfId-1595584]Auto-configuration of the Fabric to enable the Endpoint Locator feature when DCNM is directly attached to a leaf/ToR in a fabric
 
      	 [bookmark: pgfId-1595607]Support of Endpoint Locator feature when DCNM is not directly attached to a ToR/leaf in a fabric
 
      	 [bookmark: pgfId-1595623]Support for optional flush of the Endpoint data to start afresh
 
      	 [bookmark: pgfId-1595639]Support for real-time and historical dashboards
 
      	 [bookmark: pgfId-1595655]Support for views with operational and exploratory insights such as endpoint life-time, network/endpoint/vrf daily views and operational heat map
 
      	 [bookmark: pgfId-1595682]Full High availability support
 
      	 [bookmark: pgfId-1595692]Endpoint data stored for up to 180 days amounting to a maximum of 5G storage space
 
      	 [bookmark: pgfId-1595762]Supported scale: 10000 endpoints
 
     
 
     [bookmark: pgfId-1595763]For more information, see the Cisco DCNM Web Client Online Help.
 
    
 
     
      [bookmark: pgfId-1595764][bookmark: 81734]VxLAN EVPN IR 
 
     [bookmark: pgfId-1593593]From the DCNM General and LAN fabric settings, the IR (Ingress Replication) option is added for handling BUM traffic for VxLAN EVPN fabric. IR and Multicast Routing are mutually exclusive. If IR is selected, DCNM allows IR-based profiles only. DCNM will also add appropriate IR configuration in the leaf templates and do not show Multicast configuration.
 
    
 
     
      [bookmark: pgfId-1595343][bookmark: 19859]Support for New Hardware
 
     [bookmark: pgfId-1595344]The following hardware are supported in Cisco DCNM Release 10.2(1):
 
     [bookmark: pgfId-1595339]
 
      
       
        
        [bookmark: pgfId-1595813]Table 4-1 Support for New Hardware
 
        
        
         
         	 
           
           [bookmark: pgfId-1595817]Hardware Description 
          
  
         	 
           
           [bookmark: pgfId-1595819]Part Number 
          
  
        
 
         
         	[bookmark: pgfId-1595821]Cisco MDS 9700 48-Port 32-Gbps Fibre Channel Switching Module
  
         	[bookmark: pgfId-1595823]DS-X9648-1536K9
  
        
 
         
         	[bookmark: pgfId-1595825]Nexus 9300 with 24p 40/50G QSFP+ and 6p 40G/100G QSFP28
  
         	[bookmark: pgfId-1595827]N9K-C93180LC-EX
  
        
 
         
         	[bookmark: pgfId-1595829]New fabric module for the Cisco Nexus 9516 Switch chassis
  
         	[bookmark: pgfId-1595831]N9K-C9516-FM-E
  
        
 
         
         	[bookmark: pgfId-1595833]40/100G Ethernet Module for Nexus 9500 series chassis
  
         	[bookmark: pgfId-1595835]N9K-X9736C-EX
  
        
 
         
         	[bookmark: pgfId-1595837]N9K-C92300YC-FixedModule
  
         	[bookmark: pgfId-1595839]N9K-C92300YC
  
        
 
         
         	[bookmark: pgfId-1596034]48-port 1/10/25 Gigabit Ethernet SFP+ and 4-port 40/100 Gigabit Ethernet QSFP line card
  
         	[bookmark: pgfId-1595843]N9K-X97160YC-EX
  
        
 
         
         	[bookmark: pgfId-1595845]Nexus N9K-C9232C Series fixed module with 32x40G/100G 
  
         	[bookmark: pgfId-1595847]N9K-C9232C
  
        
 
         
         	[bookmark: pgfId-1595849]Cisco Nexus 2348TQ-E 10GE Fabric Extender
  
         	[bookmark: pgfId-1595851]
  
        
 
        
      
 
     
 
    
 
   
 
  
 
  
  
   
   
    
     [bookmark: pgfId-280582]Media Controller 
      
      
 
     
 
 
    [bookmark: pgfId-308614]This chapter describes the Media Controller and Programmable Media Network (PMN) AMQP notification in Cisco DCNM. This chapter contains the following sections:
 
     
     	 [bookmark: pgfId-270238]Overview
 
     	 [bookmark: pgfId-270281]PMN AMQP Notification in Cisco DCNM
 
     	 [bookmark: pgfId-310338]Notification Body
 
     	 [bookmark: pgfId-310347]Sample Notification
 
    
 
   
 
    
     [bookmark: pgfId-310378][bookmark: 29833]Overview
 
    [bookmark: pgfId-311698]Cisco’s IP fabric for media solution helps transition from an SDI router to an IP-based infrastructure. In an IP-based infrastructure, a single cable has the capacity to carry multiple bidirectional traffic flows and can support different flow sizes without requiring changes to the physical infrastructure.
 
    [bookmark: pgfId-257638]The IP fabric for media solution consists of a flexible spine and leaf architecture or a single modular switch topology. The solution uses Cisco Nexus 9000 Series switches in conjunction with the Cisco non-blocking multicast (NBM) algorithm (an intelligent traffic management algorithm) and with or without the Cisco Data Center Network Manager (DCNM) Media Controller. Using open APIs, the Cisco DCNM Media Controller can integrate with various broadcast controllers. The solution provides a highly reliable (zero drop multicast), highly visible, highly secure, and highly available network. 
 
    [bookmark: pgfId-313582]For information about Cisco's IP fabric for media solution, see the Cisco Nexus 9000 Series NX-OS IP Fabric for Media Solution Guide, Releases 7.0(3)I4(5), 7.0(3)I6(1), and 7.0(3)F2(1) at the following URL:
 
    [bookmark: pgfId-313819]http://www.cisco.com/c/en/us/td/docs/switches/datacenter/nexus9000/sw/7-x/ip_fabric_for_media/solution/guide_703i45/b_Cisco_Nexus_9000_Series_IP_Fabric_for_Media_Solution_Guide_703I45.html
 
    [bookmark: pgfId-313798]For information about the media controller functionality in the Cisco DCNM Web Client, see the Cisco DCNM Web Client Online Help at the following URL:
 
    [bookmark: pgfId-314082]http://www.cisco.com/c/en/us/td/docs/switches/datacenter/sw/DCNM_OLH/Web_Client/b_DCNM_web_client_olh/Media_Controller.html
 
    [bookmark: pgfId-317054]For information about the PMN APIs, see the Cisco DCNM API reference guide at the following URL:
 
    [bookmark: pgfId-317188]https://developer.cisco.com/site/data-center-network-manager/
 
   
 
    
     [bookmark: pgfId-314112][bookmark: 95983]PMN AMQP Notification in Cisco DCNM
 
    [bookmark: pgfId-314321]Cisco DCNM uses the Advanced Message Queuing Protocol (AMQP), which is an open standard protocol to exchange messages with other entities. It generates real-time AMQP notification for various operations. The message contains routing key, properties, and payload sections. The consumer of the message can use the routing key to quickly filter the required messages. The properties section provides additional information about the message such as message priority, delivery mode, content type, content encoding, and header. The payload is the actual notification content.
 
   
 
    
     [bookmark: pgfId-314365][bookmark: 95317]Notification Body
 
    [bookmark: pgfId-315509]The Cisco DCNM notification payload contains necessary information about the event. The table below shows the event categories that Cisco DCNM generates.
 
    [bookmark: pgfId-315544]
 
     
      
       
       [bookmark: pgfId-315512]Table 5-1 Event Categories
 
       
       
        
        	 
          
          [bookmark: pgfId-315516]Category 
         
  
        	 
          
          [bookmark: pgfId-315518]Operation 
         
  
       
 
        
        	[bookmark: pgfId-315520]Host
  
        	[bookmark: pgfId-315522]Create/update/delete/import
  
       
 
        
        	[bookmark: pgfId-315524]Host Policy
  
        	[bookmark: pgfId-315526]Create/update/delete/import, association with Host, dissociation from the Host, host policy (ACL) deployment status
  
       
 
        
        	[bookmark: pgfId-315528]Flow
  
        	[bookmark: pgfId-315530]Create/delete/migration
 [bookmark: pgfId-315531]Insufficient bandwidth of interface, HTTP error during config deployment to the switch, flow stitch status
  
       
 
        
        	[bookmark: pgfId-315533]Flow Policy
  
        	[bookmark: pgfId-315535]Create/delete/update/import
  
       
 
        
        	[bookmark: pgfId-315537]Flow Alias
  
        	[bookmark: pgfId-315539]Create/delete/update/import
  
       
 
        
        	[bookmark: pgfId-315541]Switch
  
        	[bookmark: pgfId-315543]Switch reload, switch interface status update, line card status update, failed flow update, 
  
       
 
       
     
 
    
 
    [bookmark: pgfId-315559]
 
   
 
    
     [bookmark: pgfId-315545][bookmark: 84056]Sample Notification
 
     
      [bookmark: pgfId-316017]Host Creation
 
      
      [bookmark: pgfId-316018]Host created with name: Host-2.1.1.3 by admin 
     
 
      
      [bookmark: pgfId-316019] 
     
 
    
 
     
      [bookmark: pgfId-316077]Host Policy Creation
 
      
      [bookmark: pgfId-316059]Host Policy with policy name LabVideoPolicy successfully created by admin 
     
 
      
      [bookmark: pgfId-316992] 
     
 
    
 
     
      [bookmark: pgfId-316150]Flow Migration
 
      
      [bookmark: pgfId-316176]Successful Migration:NodeDown: 4130(93180YC-68) is down [broken node 4130(93180YC-68) triggers flow 225.3.2.1 with sender:13080/6580 removal] 
     
 
      
      [bookmark: pgfId-316138] 
     
 
    
 
     
      [bookmark: pgfId-316212]Switch Reload
 
      
      [bookmark: pgfId-316192]Switch with IP:192.0.2.1 has recovered from a reload and is up now 
     
 
      
      [bookmark: pgfId-316369] 
     
 
      
       
     
 
     
 
     [bookmark: pgfId-316379]Note In the upcoming Cisco DCNM release, the PMN notification body will be changed to JSON format and the routing key will consist of event type, operation status and so on for notification filtering. Some information. The keys used in REST APIs will be added to notification body to simplify the integration of external application.
 
      
      
 
     
 
     
 
     [bookmark: pgfId-316375]
 
    
 
   
 
  
 
  
  
   
   
    
     [bookmark: pgfId-280582][bookmark: 1072]Configuring DCNM Native High Availability 
      
      
 
     
 
 
    [bookmark: pgfId-308614]This chapter describes the DCNM Native High Availability (HA) configuration and troubleshooting. This chapter contains the following sections:
 
     
     	 [bookmark: pgfId-270238]DCNM HA Overview
 
     	 [bookmark: pgfId-270281]DCNM Native HA Installation
 
     	 [bookmark: pgfId-310338]DCNM License Usage and Limitations
 
     	 [bookmark: pgfId-310347]Native HA Failover and Split-Brain
 
     	 [bookmark: pgfId-310372]Disk File Replication
 
     	 [bookmark: pgfId-310376]Replace HA Hosts
 
     	 [bookmark: pgfId-310383]DCNM Native HA with Scaled Up Test
 
     	 [bookmark: pgfId-310404]AAA Configuration
 
     	 [bookmark: pgfId-312236]Troubleshooting DCNM Native HA
 
    
 
   
 
    
     [bookmark: pgfId-310378][bookmark: 47565]DCNM HA Overview
 
    [bookmark: pgfId-311697]DCNM Native HA provides a high availability solution for the DCNM. It consists of two DCNM nodes in which one node assumes the role of the active node and the other node assumes the role of the standby node.
 
    [bookmark: pgfId-311698]The native HA is supported on Linux platform with ISO and OVA installation. For standalone installation, we will not support native HA as there might be missing Linux packages which are required for native HA. Native HA is also not supported on Windows platform.
 
    [bookmark: pgfId-257638]By default, DCNM is bundled with an embedded database engine PostgreSQL. The DCNM native HA is achieved by two DCNM’s running as Active / Warm Standby, with their embedded databases synchronized in real time. So once the active DCNM is down, the standby will take over with the same database data and resume the operation.
 
   
 
    
     [bookmark: pgfId-309385][bookmark: 44619]DCNM Native HA Installation
 
    [bookmark: pgfId-309463]For detailed DCNM native HA setup process, please refer to Cisco DCNM Installation Guide, Release 10.0(x). 
 
   
 
    
     [bookmark: pgfId-309455][bookmark: 15212]DCNM License Usage and Limitations
 
    [bookmark: pgfId-309540]Cisco DCNM license is tied to host Mac Address. In DCNM native HA setup, there are two hosts with different Mac addresses. Here is how it works:
 
    [bookmark: pgfId-309531]In DCNM native HA, only primary DCNM (node 1) is allowed to load license, the secondary (node 2) can only apply the licenses. This is similar to DCNM Federation where DCNM with Id 0 could load licenses, all others can only apply the licenses.
 
    [bookmark: pgfId-313496]In DCNM native HA, the licenses should be generated only for the primary DCNM. Only primary DCNM (node 1) is allowed to load license. There are no extra DCNM server license and switch-based license required for secondary DCNM in Native-HA.
 
     
      
    
 
    
 
    [bookmark: pgfId-310476]Note DCNM recommends having licenses on one instance and a spare matching license on the second instance.
 
     
     
 
    
 
    
 
   
 
    
     [bookmark: pgfId-309501][bookmark: 50650]Native HA Failover and Split-Brain 
 
    [bookmark: pgfId-309612]DCNM failover can be manually triggered, or if the standby DCNM detected the active DCNM is not responsive, the standby will then takeover and act as active.
 
    [bookmark: pgfId-309613]In DCNM native HA, the VIP(s) are always associated with active host. When failover occurs, the active host shall disassociate the VIP(s) and shutdown the DCNM process; and the standby shall associate the VIP(s) with the host, change the database from stream replication mode to normal mode, and start up the DCNM process.
 
    [bookmark: pgfId-309614]Split-Brain syndrome occurs when the communication on enhanced fabric interface between two HA peer is lost. As the result, both hosts will act as Active. When the communication resumes, both hosts shall negotiate and eventually one will become active, the other standby.
 
   
 
    
     [bookmark: pgfId-309603][bookmark: 67655]Disk File Replication
 
    [bookmark: pgfId-309682]In addition to database real-time synchronization between two DCNM HA peers, there are also bunch of disk files which need to be replicated.
 
    [bookmark: pgfId-309676]The disk files which need replication include POAP templates, performance data (RRD files), etc. 
 
   
 
    
     [bookmark: pgfId-310964][bookmark: 85989]Replace HA Hosts
 
    [bookmark: pgfId-310979]If you need to replace an HA host machine, please follow the procedures: 
 
     
      
    
 
    
 
    [bookmark: pgfId-310980]Note The IP addresses or VIPs are assumed not to be changed. 
Hosts that having "Deployed role: Standby" can only be replaced.
 
     
     
 
    
 
    
 
    
 
    [bookmark: pgfId-310981]Step 1 Stop the DCNM on the standby host (no IP change).
 
    [bookmark: pgfId-311044]Step 2 Stop the DCNM on the active host (no IP change).
 
    [bookmark: pgfId-311059]Step 3 Take backup of Standby DCNM.
 
    [bookmark: pgfId-311078]Step 4 [bookmark: 28443]Take a local copy of ha-properties file from /root/packaged-files/properties/ path.
 
    [bookmark: pgfId-309728]Step 5 On the new host which is supposed to replace the old host, configure the IP addresses on eth0 and eth1to be identical to the old host.
 
    [bookmark: pgfId-311142]Step 6 If the host is a virtual machine, configure the mac address to be identical to the old host, so there will be no need to get new licenses for the new host.
 
    [bookmark: pgfId-311165]Step 7 On the new host which will join the HA setup, run the HA setup script, just like in the normal HA setup procedure.
 
    [bookmark: pgfId-311192]Step 8 Restart the DCNM on the active host, then restart the DCNM on the standby host.
 
    [bookmark: pgfId-310053]
 
     
     
 
    
 
    
 
   
 
    
     [bookmark: pgfId-311351][bookmark: 16412]DCNM Native HA with Scaled Up Test
 
    [bookmark: pgfId-311352]Different HA scale limits have been mentioned under DCNM 10.x release. Please refer to Cisco DCNM Release Notes, Release 10 for scale requirement and scale limits.
 
   
 
    
     [bookmark: pgfId-309836][bookmark: 96496]AAA Configuration
 
    [bookmark: pgfId-311445]For AAA configuration, you need to install Cisco DCNM native HA with local user credentials. Once the installation is done, please log into the DCNM web client and go to Administrator > Management Users > Remote AAA and select the required authentication mode.
 
     
      
    
 
    
 
    [bookmark: pgfId-311536]Note When doing remote AAA authentication, Cisco DCNM is sending out request using its own eth0 IP rather than VIP. Therefore, on the AAA server, we need to put two entries for DCNM IP, one for active DCNM, the other for standby IP, but not VIP.
 
     
     
 
    
 
    
 
   
 
    
     [bookmark: pgfId-311850][bookmark: 27609]Troubleshooting DCNM Native HA
 
    [bookmark: pgfId-312295]When Cisco DCNM native HA setup is in an uncertain situation, stop both hosts and resolve the problem. Start only one host and ensure that it is fully functional, and the device data is correct before you bring up the second host as standby.
 
     
      
    
 
    
 
    [bookmark: pgfId-312296]Note Throughout this Troubleshooting procedure, dcnm1 is considered as the Active host and dcnm2 is considered for Secondary host.
 
     
     
 
    
 
    
 
    [bookmark: pgfId-312511]This contains the following sections:
 
     
     	 [bookmark: pgfId-312559]“Recovering DCNM when both hosts are Powered Down” section
 
     	 [bookmark: pgfId-312581]“Recovering from Split-Brain syndrome” section
 
     	 [bookmark: pgfId-312609]“Checking Cisco DCNM Native HA Status” section
 
     	 [bookmark: pgfId-312635]“Verifying if the Active and Standby Hosts are Operational” section
 
     	 [bookmark: pgfId-312656]“Verifying HA Database Synchronization” section
 
     	 [bookmark: pgfId-312670]“Resolving HA Status Failure condition” section
 
     	 [bookmark: pgfId-312684]“Bringing up Database on Standby Host” section
 
    
 
     
      [bookmark: pgfId-312297][bookmark: 34993]Recovering DCNM when both hosts are Powered Down
 
     [bookmark: pgfId-312298]Perform the following to troubleshoot the DCNM Native HA setup when both the hosts are powered down.
 
     
 
     [bookmark: pgfId-312299]Step 1 Power on dcnm1.
 
     [bookmark: pgfId-312300]Step 2 Wait for all the applications to be operational.
 
     [bookmark: pgfId-312305]Step 3 If the host fails to bring up all the applications, or if the device data is incorrect, use the appmgr stop all command to stop the process.
 
     [bookmark: pgfId-312306]Wait for all the applications to stop.
 
     [bookmark: pgfId-312307]Step 4 Power on dcnm2.
 
     [bookmark: pgfId-312308]Wait for all the applications to be operational.
 
     [bookmark: pgfId-312309]Step 5 Use the appmgr status all command to check the status of the applications.
 
      
      [bookmark: pgfId-312310]dcnm2# appmgr status all 
     
 
      
      [bookmark: pgfId-312311] 
     
 
     [bookmark: pgfId-312312]Logon to DCNM. Verify if it is fully functional. Check if the device data is correct. If success, power on dcnm1 as Secondary host. Terminate the troubleshooting procedure.
 
     [bookmark: pgfId-312313]Step 6 If dcnm2 fails to bring up all the applications, or if the device data is incorrect, use the appmgr stop all command to stop the process.
 
     [bookmark: pgfId-312720]Step 7 Restore both hosts from backup.
 
     [bookmark: pgfId-312314]
 
      
      
 
     
 
     
 
    
 
     
      [bookmark: pgfId-312315][bookmark: 52021]Recovering from Split-Brain syndrome
 
     [bookmark: pgfId-312316]Perform the following to recover Cisco DCNM from the split brain syndrome.
 
     
 
     [bookmark: pgfId-312317]Step 1 Stop both Active and Standby Cisco DCNM hosts.
 
     [bookmark: pgfId-312328]Step 3 Ping the peer host eth1 IP address from both hosts and make sure it is reachable.
 
     [bookmark: pgfId-312329]Step 4 Start all the applications on dcnm1. Wait for all the applications to be operational.
 
     [bookmark: pgfId-312330]Use the appmgr status all command to check the status of the applications.
 
     [bookmark: pgfId-312331]dcnm1# appmgr status all
 
     [bookmark: pgfId-312334]If all the data is correct, proceed to Step 7.
 
     [bookmark: pgfId-312783]If data loss is seen, proceed to Step 6.
 
     [bookmark: pgfId-312335]Step 6 [bookmark: 31684]Use the appmgr stop all command, to stop the applications
 
      
      [bookmark: pgfId-312336]dcnm1# appmgr stop all 
     
 
      
      [bookmark: pgfId-312337] 
     
 
     [bookmark: pgfId-312338]Step 7 [bookmark: 47486]Start all the applications on dcnm2. Wait for all the applications to be operational.
 
     [bookmark: pgfId-312339]Use the appmgr status all command to check the status of the applications.
 
     [bookmark: pgfId-312340]dcnm2# appmgr status all
 
     [bookmark: pgfId-312343]Check if the device data is correct. If success, power on dcnm1 as Secondary host. Terminate the troubleshooting procedure.
 
     [bookmark: pgfId-312344]Step 9 If data loss is seen on dcnm2, stop all the applications.
 
     [bookmark: pgfId-312349]
 
      
      
 
     
 
     
 
    
 
     
      [bookmark: pgfId-312350][bookmark: 79064]Checking Cisco DCNM Native HA Status
 
     [bookmark: pgfId-312351]Perform the following to determine the status of the Cisco DCNM Native HA.
 
     
 
     [bookmark: pgfId-312352]Step 1 Login into Cisco DCNM Web Client.
 
     [bookmark: pgfId-312353]Step 2 Navigate to Web Client > Administration > Native HA.
 
     [bookmark: pgfId-312354]Step 3 Check for HA Status.
 
      
       
        
         
         	 
           
           [bookmark: pgfId-312358]HA Status 
          
  
         	 
           
           [bookmark: pgfId-312360]Description 
          
  
        
 
         
         	[bookmark: pgfId-312362]OK
  
         	[bookmark: pgfId-312364]Implies that the Native HA is operational. Both the hosts on the Native HA are synchronized.
  
        
 
         
         	[bookmark: pgfId-312366]Stopped
  
         	[bookmark: pgfId-312368]Implies that the Standby host is not operation. The database is not synchronized.
  
        
 
         
         	[bookmark: pgfId-312370]Failed
  
         	[bookmark: pgfId-312372]Implies that the Active host is unable to synchronize with the Standby host. Check the log files for more information.
 [bookmark: pgfId-312373]The log file is located at: /usr/local/cisco/dcm/fm/logs/fms_ha.log
  
        
 
         
         	[bookmark: pgfId-312375]Not Ready
  
         	[bookmark: pgfId-312377]Implies that the Standby host is not setup or not configured.
  
        
 
        
      
 
     
 
     [bookmark: pgfId-312379]
 
      
      
 
     
 
     
 
    
 
     
      [bookmark: pgfId-312381][bookmark: 85115]Verifying if the Active and Standby Hosts are Operational
 
     [bookmark: pgfId-312382]Perform the following to determine if the hosts are operational.
 
     
 
     [bookmark: pgfId-312383]Step 1 Check the HA role on the host.
 
     [bookmark: pgfId-312384]Step 2 Use the appmgr show ha-role command to view the current role of the host.
 
      
      [bookmark: pgfId-312385]dcnm1# show ha-role 
     
 
      
      [bookmark: pgfId-312386]Active 
     
 
      
      [bookmark: pgfId-312387] 
     
 
      
      [bookmark: pgfId-312388]dcnm2# show ha-role 
     
 
      
      [bookmark: pgfId-312389]Standby 
     
 
      
      [bookmark: pgfId-312390] 
     
 
     [bookmark: pgfId-312391]Step 3 Check the VIP, using the ip address command.
 
     [bookmark: pgfId-312392]On the Active host, both eth0 and eth1 must have two IP addresses configured, with VIP assigned as the secondary IP address; on standby host, only one IP address for both eth0 and eth1 interfaces
 
     [bookmark: pgfId-312393]Step 4 Check the DCNM java process.
 
     [bookmark: pgfId-312394]Use ps -ef | grep java command to verify the java process associated with the DCNM.
 
      
      [bookmark: pgfId-312395]dcnm1# ps -ef | grep java 
     
 
     [bookmark: pgfId-312396]The results must show one Java process, appended with standalone-san.xml.
 
      
      [bookmark: pgfId-312397]dcnm2# ps -ef | grep java 
     
 
     [bookmark: pgfId-312398]There should no be any Java process, appended with standalone-san.xml.
 
     [bookmark: pgfId-312399]Step 5 Check the heartbeat of the DCNM hosts.
 
      
      [bookmark: pgfId-312400]dcnm1# /etc/init.d/heartbeat status 
     
 
      
      [bookmark: pgfId-312401]heartbeat OK 
     
 
      
      [bookmark: pgfId-312402] 
     
 
      
      [bookmark: pgfId-312403]dcnm2# /etc/init.d/heartbeat status 
     
 
      
      [bookmark: pgfId-312404]heartbeat OK 
     
 
      
      [bookmark: pgfId-312405] 
     
 
     [bookmark: pgfId-312406]Step 6 Check if the database engine PostgreSQL is operational.
 
      
      [bookmark: pgfId-312407]dcnm1# /etc/init.d/postgresql-9.4 status 
     
 
      
      [bookmark: pgfId-312408]server is running …… 
     
 
      
      [bookmark: pgfId-312409] 
     
 
      
      [bookmark: pgfId-312410]dcnm2# /etc/init.d/postgresql-9.4 status 
     
 
      
      [bookmark: pgfId-312411]server is running …… 
     
 
      
      [bookmark: pgfId-312412] 
     
 
     [bookmark: pgfId-312413]Step 7 Check the HA cluster information.
 
      
      [bookmark: pgfId-312414]dcnm1# cl_status listnodes 
     
 
      
      [bookmark: pgfId-312415]dcnm2# cl_status listnodes 
     
 
      
      [bookmark: pgfId-312416] 
     
 
     [bookmark: pgfId-312417]The two hostnames of the HA cluster will be displayed.
 
     [bookmark: pgfId-312418]Step 8 Check the HA heartbeat status.
 
      
      [bookmark: pgfId-312419]dcnm1# cl_status nodestatus <hostname> 
     
 
      
      [bookmark: pgfId-312420]dcnm2# cl_status nodestatus <hostname> 
     
 
      
      [bookmark: pgfId-312421] 
     
 
     [bookmark: pgfId-312422]If this command returns “active”, the heartbeat on the host is OK.
 
     [bookmark: pgfId-312423]If the command returns “dead”, the heartbeat on the host is not running or not recognized.
 
     [bookmark: pgfId-312424]
 
      
      
 
     
 
     
 
    
 
     
      [bookmark: pgfId-312425][bookmark: 12223]Verifying HA Database Synchronization
 
     [bookmark: pgfId-312426]Perform the following to verify if the databases synchronization on both hosts is in progress.
 
     [bookmark: pgfId-312427]When running DCNM Native HA, both the host database must be operational, one host as Active and another host as Standby. Any changes made in the Active database must synchronize with the Standby database in real time. 
 
     
 
     [bookmark: pgfId-312438]Step 1 Logon to Cisco DCNM Web UI.
 
     [bookmark: pgfId-312439]Step 2 Navigate to Administration > Native HA. 
 
     [bookmark: pgfId-312440]Click the Test icon.
 
     [bookmark: pgfId-312441]Check if there are errors. Click Detailed Logs for more information.
 
     [bookmark: pgfId-312442]Step 3 Check log file at the location.
 
      
      [bookmark: pgfId-312443]/usr/local/cisco/dcm/fm/logs/fms_ha.log 
     
 
      
      [bookmark: pgfId-312444] 
     
 
     [bookmark: pgfId-312445]There should be some log messages indicating why the HA status is Failed.
 
     [bookmark: pgfId-312446]Step 4 Verify if Standby host is running is operational.
 
     [bookmark: pgfId-312450]See Verifying if the Active and Standby Hosts are Operational, for more information. Check is any applications are not operational.
 
     [bookmark: pgfId-312451]Generally, the HA status shows Failed due to Standby database being down or rejected connection.
 
     [bookmark: pgfId-312456]If not, we recommend that you contact the Technical Support for further assistance.
 
     [bookmark: pgfId-312460]Step 5 If Standby database is completely down, see Bringing up Database on Standby Host.
 
     [bookmark: pgfId-312461]
 
      
      
 
     
 
     
 
    
 
     
      [bookmark: pgfId-312463][bookmark: 60098]Bringing up Database on Standby Host
 
     [bookmark: pgfId-312464]Normally, the database must be running on both Active or Standby host, regardless of DCNM being operational or stopped. However, the database could be down mostly because of the initial database synchronization failure.
 
     [bookmark: pgfId-312465]Perform the following to bring up the database on the Standby host.
 
     
 
     [bookmark: pgfId-312466]Step 1 Start the Standby database, using the /etc/init.d/postgresql-9.4 start command.
 
     [bookmark: pgfId-312467]Step 2 If the return value is PostgreSQL 9.4 started successfully, the Standby database is OK. The HA status shows OK within a few minutes.
 
     [bookmark: pgfId-312472]If the file exists, perform the following to restore database files, and start database again:.
 
     [bookmark: pgfId-312473] a. Enter the ps -ef | grep post command and ensure that the Postgres process is not running.
 
     [bookmark: pgfId-312474] b. If the Postgres process is running, stop by using the kill <pid> command.
 
     [bookmark: pgfId-312475] c. Remove all the database files by using the following commands:
 
      
      [bookmark: pgfId-312476]cd /usr/local/cisco/dcm/db 
     
 
      
      [bookmark: pgfId-312477]rm -rf data/* 
     
 
      
      [bookmark: pgfId-312478] 
     
 
     [bookmark: pgfId-312479] d. Restore the database files from the backup by using tar xzf replication/pgsql-standby-backup.tgz data command.
 
     [bookmark: pgfId-312480] e. Restart the database by using the /etc/init.d/postgresql-9.4 start command.
 
     [bookmark: pgfId-312481]Check if the database has started successfully.
 
     [bookmark: pgfId-312482]
 
      
      
 
     
 
     
 
    
 
   
 
  
 
  
  
   
   
    
     [bookmark: pgfId-1163974][bookmark: 883]Cisco DCNM-SAN Overview 
      
      
 
     
 
 
    [bookmark: pgfId-1163975]This chapter provides an overview of the basic Cisco DCNM-SAN components and includes the following sections: 
 
     
     	 [bookmark: pgfId-1162952]DCNM-SAN Server
 
     	 [bookmark: pgfId-1162012]Authentication in DCNM-SAN Client
 
     	 [bookmark: pgfId-1162013]DCNM-SAN Client
 
     	 [bookmark: pgfId-1162014]Device Manager
 
     	 [bookmark: pgfId-1162015]DCNM Web Client
 
     	 [bookmark: pgfId-1162016]Performance Manager
 
     	 [bookmark: pgfId-1162017]Cisco Traffic Analyzer
 
     	 [bookmark: pgfId-1163059]Network Monitoring
 
     	 [bookmark: pgfId-1163060]Performance Monitoring
 
    
 
     
      [bookmark: pgfId-1163837][bookmark: 27324]DCNM-SAN Server 
 
     [bookmark: pgfId-1163838]DCNM-SAN Server is a platform for advanced MDS monitoring, troubleshooting, and configuration capabilities. DCNM-SAN Server provides centralized MDS management services and performance monitoring. SNMP operations are used to efficiently collect fabric information. The Cisco DCNM-SAN software, including the server components, requires about 60 MB of hard disk space on your workstation. Cisco DCNM-SAN Server runs on Windows 2000, Windows 2003, Windows 2008, Windows XP, Windows 7, Solaris 9 and 10, and Red Hat Enterprise Linux AS Release 5.
 
     [bookmark: pgfId-1162303]Each computer configured as a Cisco DCNM-SAN Server can monitor multiple Fibre Channel SAN fabrics. Up to 16 clients (by default) can connect to a single Cisco DCNM-SAN Server concurrently. The Cisco DCNM-SAN Clients can also connect directly to an MDS switch in fabrics that are not monitored by a Cisco DCNM-SAN Server, which ensures that you can manage any of your MDS devices from a single console.
 
    
 
     
      [bookmark: pgfId-1162304][bookmark: 19728]DCNM-SAN Client
 
     [bookmark: pgfId-1162496]Cisco DCNM-SAN Client is a Java and SNMP-based network fabric and device management tool with a GUI that displays real-time views of your network fabric, including Cisco Nexus 5000 Series switches, Cisco MDS 9000 Family switches and third-party switches, hosts, and storage devices.
 
     [bookmark: pgfId-1162497]DCNM-SAN Client provides Fibre Channel troubleshooting tools, in addition to complete configuration and status monitoring capabilities for Cisco MDS 9000 Family switches and Cisco Nexus 5000 Series switches. You can use these health and configuration analysis tools on the MDS 9000 Family switch or Cisco Nexus 5000 Series switch to perform Fibre Channel ping and traceroute.
 
     [bookmark: pgfId-1162498]Fabric Manager Release 4.1(1b) and later releases provide a multilevel security system by adding a server admin role that allows access to limited features. The configuration capabilities of a server admin is limited to configuring FlexAttach and relevant data. Advanced mode option is available only for network administrators and provides all of the DCNM-SAN features, including security, IVR, iSCSI, and FICON. 
 
    
 
     
      [bookmark: pgfId-1162305][bookmark: 15424]Device Manager
 
     [bookmark: pgfId-1162521]Device Manager provides a graphical representation of a Cisco MDS 9000 Family switch chassis, Cisco Nexus 5000 Series switch chassis, or Cisco Nexus 7000 Series switch chassis (FCoE only) along with the installed switching modules, the supervisor modules, the status of each port within each module, the power supplies, and the fan assemblies.
 
     [bookmark: pgfId-1164351]The tables in the DCNM-SAN Information pane basically correspond to the dialog boxes that appear in Device Manager. However, while DCNM-SAN tables show values for one or more switches, a Device Manager dialog box shows values for a single switch. Device Manager also provides more detailed information for verifying or troubleshooting device-specific configuration than DCNM-SAN.
 
     [bookmark: pgfId-1162350]Device Manager provides two views: Device View and Summary View. Use Summary View to monitor interfaces on the switch. Use Device View to perform switch-level configurations including the following configurations:
 
      
      	 [bookmark: pgfId-1162536]Configuring virtual Fibre Channel interfaces
 
      	 [bookmark: pgfId-1162537]Configuring Fibre Channel over Ethernet (FCoE) features
 
      	 [bookmark: pgfId-1162538]Configuring zones for multiple VSANs
 
      	 [bookmark: pgfId-1162539]Managing ports, PortChannels, and trunking
 
      	 [bookmark: pgfId-1162540]Managing SNMPv3 security access to switches
 
      	 [bookmark: pgfId-1162541]Managing CLI security access to the switch
 
      	 [bookmark: pgfId-1162542]Managing alarms, events, and notifications
 
      	 [bookmark: pgfId-1162543]Saving and copying configuration files and software image
 
      	 [bookmark: pgfId-1162544]Viewing hardware configuration
 
      	 [bookmark: pgfId-1162530]Viewing chassis, module, port status, and statistics
 
     
 
    
 
     
      [bookmark: pgfId-1162306][bookmark: 40139]DCNM Web Client
 
     [bookmark: pgfId-1164125]With DCNM Web Client you can monitor Cisco MDS switch events, performance, and inventory from a remote location using a web browser. 
 
      
      	 [bookmark: pgfId-1162710]Performance Manager Summary reports—The Performance Manager summary report provides a high-level view of your network performance. These reports list the average and peak throughput and provides hot-links to additional performance graphs and tables with additional statistics. Both tabular and graphical reports are available for all interconnections monitored by Performance Manager. 
 
      	 [bookmark: pgfId-1163418]Performance Manager drill-down reports—Performance Manager can analyze daily, weekly, monthly and yearly trends. You can also view the results for specific time intervals using the interactive zooming functionality. These reports are only available if you create a collection using Performance Manager and start the collector.
 
      	 [bookmark: pgfId-1162681]Zero maintenance database for statistics storage—No maintenance is required to maintain Performance Manager’s round-robin database, because its size does not increase over time. At prescribed intervals the oldest samples are averaged (rolled-up) and saved. A full two days of raw samples are saved for maximum resolution. Gradually the resolution is reduced as groups of the oldest samples are rolled up together.
 
     
 
    
 
     
      [bookmark: pgfId-1162785][bookmark: 14816]Performance Manager
 
     [bookmark: pgfId-1162836]The primary purpose of DCNM-SAN is to manage the network. A key management capability is network performance monitoring. Performance Manager, which is part of DCNM server, gathers network device statistics historically and provides this information graphically using a web browser. Performance Manager presents recent statistics in detail and older statistics in summary. Performance Manager also integrates with external tools such as Cisco Traffic Analyzer.
 
     [bookmark: pgfId-1162839]Performance Manager has three operational stages:
 
      
      	 [bookmark: pgfId-1162840]Definition—The Flow Wizard sets up flows in the switches.
 
      	 [bookmark: pgfId-1162841]Collection—The Web Server Performance Collection screen collects information on desired fabrics.
 
      	 [bookmark: pgfId-1162842]Presentation—Generates web pages to present the collected data through DCNM-SAN Web Server.
 
     
 
     [bookmark: pgfId-1162843]Performance Manager can collect statistics for ISLs, hosts, storage elements, and configured flows. Flows are defined based on a host-to-storage (or storage-to-host) link. Performance Manager gathers statistics from across the fabric based on collection configuration files. These files determine which SAN elements and SAN links Performance Manager gathers statistics for. Based on this configuration, Performance Manager communicates with the appropriate devices (switches, hosts, or storage elements) and collects the appropriate information at fixed five-minute intervals.
 
    
 
     
      [bookmark: pgfId-1164041][bookmark: 57645]Authentication in DCNM-SAN Client
 
     [bookmark: pgfId-1164038]Administrators launch DCNM-SAN Client and select the seed switch that is used to discover the fabric. The user name and password are passed to DCNM-SAN Server and are used to authenticate to the seed switch. If this user name and password are not a recognized SNMP user name and password, either DCNM-SAN Client or DCNM-SAN Server opens a CLI session to the switch (SSH or Telnet) and retries the user name and password pair. If the user name and password are recognized by the switch in either the local switch authentication database or through a remote AAA server, then the switch creates a temporary SNMP user name that is used by DCNM-SAN Client and DCNM-SAN Server.
 
    
 
     
      [bookmark: pgfId-1162787][bookmark: 57115]Cisco Traffic Analyzer
 
     [bookmark: pgfId-1163580]Cisco Traffic Analyzer provides real-time analysis of SPAN traffic or analysis of captured traffic through a Web browser user interface. Traffic encapsulated by one or more Port Analyzer Adapter products can be analyzed concurrently with a single workstation running Cisco Traffic Analyzer, which is based on ntop, a public domain software enhanced by Cisco for Fibre Channel traffic analysis.
 
     [bookmark: pgfId-1163518]Cisco Traffic Analyzer monitors round-trip response times, SCSI I/Os per second, SCSI read or traffic throughput and frame counts, SCSI session status, and management task information. Additional statistics are also available on Fibre Channel frame sizes and network management protocols.
 
    
 
     
      [bookmark: pgfId-1162309][bookmark: 81780]Network Monitoring
 
     [bookmark: pgfId-1162880]DCNM-SAN provides extensive SAN discovery, topology mapping, and information viewing capabilities. DCNM-SAN collects information on the fabric topology through SNMP queries to the switches connected to it. DCNM-SAN recreates a fabric topology, presents it in a customizable map, and provides inventory and configuration information in multiple viewing options such as fabric view, device view, summary view, and operation view.
 
     [bookmark: pgfId-1162882]Once DCNM-SAN is invoked, a SAN discovery process begins. Using information polled from a seed Cisco MDS 9000 Family switch, including Name Server registrations, Fibre Channel Generic Services (FC-GS), Fabric Shortest Path First (FSPF), and SCSI-3, DCNM-SAN automatically discovers all devices and interconnects on one or more fabrics. All available switches, host bus adapters (HBAs), and storage devices are discovered. The Cisco MDS 9000 Family switches use Fabric-Device Management Interface (FMDI) to retrieve the HBA model, serial number and firmware version, and host operating-system type and version discovery without host agents. DCNM-SAN gathers this information through SNMP queries to each switch. The device information discovered includes device names, software revision levels, vendor, ISLs, PortChannels, and VSANs.
 
    
 
     
      [bookmark: pgfId-1162301][bookmark: 34090]Performance Monitoring
 
     [bookmark: pgfId-1162892]DCNM-SAN and Device Manager provide multiple tools for monitoring the performance of the overall fabric, SAN elements, and SAN links. These tools provide real-time statistics as well as historical performance monitoring.
 
     [bookmark: pgfId-1162899]Real-time performance statistics are a useful tool in dynamic troubleshooting and fault isolation within the fabric. Real-time statistics gather data on parts of the fabric in user-configurable intervals and display these results in DCNM-SAN and Device Manager.
 
     [bookmark: pgfId-1162901]Device Manager provides an easy tool for monitoring ports on the Cisco MDS 9000 Family switches. This tool gathers statistics at a configurable interval and displays the results in tables or charts. These statistics show the performance of the selected port in real-time and can be used for performance monitoring and troubleshooting. For a selected port, you can monitor any of a number of statistics including traffic in and out, errors, class 2 traffic, and FICON data. You can set the polling interval from ten seconds to one hour, and display the results based on a number of selectable options including absolute value, value per second, and minimum or maximum value per second.
 
    
 
   
 
  
 
  
  
   
   
    
     [bookmark: pgfId-280582][bookmark: 1072]Configuring Cisco DCNM-SAN Server 
      
      
 
     
 
 
    [bookmark: pgfId-279660]This chapter describes Cisco DCNM-SAN Server, which is a platform for advanced MDS monitoring, troubleshooting, and configuration capabilities. No additional software needs to be installed. The server capabilities are an integral part of the Cisco DCNM-SAN software. 
 
    [bookmark: pgfId-279661]This chapter contains the following sections:
 
     
     	 [bookmark: pgfId-257606]Information About Cisco DCNM-SAN Server
 
     	 [bookmark: pgfId-270238]Licensing Requirements For Cisco DCNM-SAN Server
 
     	 [bookmark: pgfId-257614]Installing and Configuring Cisco DCNM-SAN Server
 
     	 [bookmark: pgfId-257618]Managing a Cisco DCNM-SAN Server Fabric
 
     	 [bookmark: pgfId-257626]Modifying Cisco DCNM-SAN Server
 
     	 [bookmark: pgfId-265686]Server Federation
 
     	 [bookmark: pgfId-270281]Additional References
 
    
 
   
 
    
     [bookmark: pgfId-265693][bookmark: 65100]Information About Cisco DCNM-SAN [bookmark: marker-265692]Server
 
    [bookmark: pgfId-257633]Install Cisco DCNM-SAN Server on a computer that you want to provide centralized MDS management services and performance monitoring. SNMP operations are used to efficiently collect fabric information. The Cisco DCNM-SAN software, including the server components, requires about 60 MB of [bookmark: marker-257634]hard disk space on your workstation. Cisco DCNM-SAN Server runs on [bookmark: marker-257635]Windows 2000, Windows 2003, Windows XP, [bookmark: marker-257636]Solaris 9 and 10, and [bookmark: marker-257637]Red Hat Enterprise Linux AS Release 5.
 
    [bookmark: pgfId-257638]Each computer configured as a Cisco DCNM-SAN Server can monitor multiple Fibre Channel SAN fabrics. Up to 16 clients (by default) can connect to a single Cisco DCNM-SAN Server concurrently. The Cisco DCNM-SAN Clients can also connect directly to an MDS switch in fabrics that are not monitored by a Cisco DCNM-SAN Server, which ensures you can manage any of your MDS devices from a single console.
 
     
      [bookmark: pgfId-257644][bookmark: 44619]DCNM-SAN Server Features[bookmark: marker-257643]
 
     [bookmark: pgfId-257200]Cisco DCNM-SAN Server has the following features:
 
      
      	 [bookmark: pgfId-257201] Multiple fabric management — DCNM-SAN Server monitors multiple physical fabrics under the same user interface. This facilitates managing redundant fabrics. A licensed DCNM-SAN Server maintains up-to-date discovery information on all configured fabrics so device status and interconnections are immediately available when you open the DCNM-SAN Client.
 
      	 [bookmark: pgfId-257204] Continuous health monitoring— MDS health is monitored continuously, so any events that occurred since the last time you opened the DCNM-SAN Client are captured.
 
      	 [bookmark: pgfId-257205] Roaming user profiles —The licensed DCNM-SAN Server uses the roaming user profile feature to store your preferences and topology map layouts on the server, so that your user interface will be consistent regardless of what computer you use to manage your storage networks.
 
     
 
      
       
     
 
     
 
     [bookmark: pgfId-257206]Note You must have the same release of Cisco DCNM-SAN Client and Cisco DCNM-SAN Server.
 
      
      
 
     
 
     
 
      
       
     
 
     
 
     [bookmark: pgfId-280018]Note You will not be able to manage a SAN fabric if the DCNM-SAN Server is going through a IP NAT firewall to access the SAN fabric. All the IP addresses that are discovered in a SAN fabric must be directly reachable by the DCNM-SAN Server.
 
      
      
 
     
 
     
 
    
 
   
 
    
     [bookmark: pgfId-270131][bookmark: 57824]Licensing Requirements For Cisco DCNM-SAN Server
 
    [bookmark: pgfId-304451]When you first install Cisco DCNM-SAN, the basic unlicensed version of Cisco DCNM-SAN Server is installed with it. You get a 30-day trial license with the product. However, trial versions of the licensed features such as Performance Manager, remote client support, and continuously monitored fabrics are available. To enable the trial version of a feature, you run the feature as you would if you had purchased the license. You see a dialog box explaining that this is a demo version of the feature and that it is enabled for a limited time.
 
    [bookmark: pgfId-304447]To get the licensed version after 30 days, you need to buy and install the Cisco DCNM-SAN Server package. You need to get either a switch based FM_SERVER_PKG license file and install it on your switches, or you need to get DCNM server based license files and add them to your server. Please go to Administration > Licenses on the DCNM Web Client, or go to the license files tab of the DCNM-SAN Client control panel to find the license files. You can assign the licenses to the switches through either the Administration > Licenses window on the DCNM Web Client or the license assignment tab of the DCNM-SAN Client control panel.
 
   
 
    
     [bookmark: pgfId-257651][bookmark: 87127]Installing and Configuring Cisco DCNM-SAN Server[bookmark: marker-257650] 
 
     
      
    
 
    
 
    [bookmark: pgfId-274276]Note Prior to running Cisco DCNM-SAN Server, you should create a special Cisco DCNM-SAN administrative user on each switch in the fabric or on a remote AAA server. Use this user to discover your fabric topology. 
 
     
     
 
    
 
    
 
     
      [bookmark: pgfId-280792]DETAILED STEPS
 
     
 
     [bookmark: pgfId-257657]Step 1 Install Cisco DCNM-SAN Client and Cisco DCNM-SAN Server on your workstation. See the “Installing Cisco DCNM-SAN Server”.
 
     [bookmark: pgfId-257664]Step 2 [bookmark: 74149]Log in to DCNM-SAN.
 
     [bookmark: pgfId-257673]Step 3 [bookmark: 56908]Set Cisco DCNM-SAN Server to continuously monitor the fabric. See the “Managing a Cisco DCNM-SAN Server Fabric”.
 
     [bookmark: pgfId-257681]Step 4 Repeat Step 2 through Step 3 for each fabric that you want to manage through Cisco DCNM-SAN Server.
 
     [bookmark: pgfId-257684]Step 5 Install DCNM-SAN Web Server. See the “Verifying Performance Manager Collections”.
 
     [bookmark: pgfId-257688]Step 6 Verify Performance Manager is collecting data. See the “Verifying Performance Manager Collections”.
 
     [bookmark: pgfId-279716]
 
      
      
 
     
 
     
 
    
 
     
      [bookmark: pgfId-257693][bookmark: 64897]Installing [bookmark: marker-257692]Cisco DCNM-SAN Server
 
     [bookmark: pgfId-275952]When you firsts install Cisco DCNM, the basic version of the Cisco DCNM-SAN Server (unlicensed) is installed with it. After you click the DCNM-SAN icon, a dialog box opens and you can enter the IP address of a computer running the Cisco DCNM-SAN Server component. If you do not see the Cisco DCNM-SAN Server IP address text box, click Options to expand the list of configuration options. If the server component is running on your local machine, leave localhost in that field. If you try to run DCNM-SAN without specifying a valid server, you are prompted to start the Cisco DCNM-SAN Server locally.
 
     [bookmark: pgfId-304742]From Release 10.0(1), Cisco DCNM has supported to choose from the following options during installation. Based on the option you select, the application will be installed:
 
      
      	 [bookmark: pgfId-304743]DCNM Web Client
 
      	 [bookmark: pgfId-304983]DCNM SAN + LAN Client
 
     
 
     [bookmark: pgfId-305667]To download the software from Cisco.com, go to the following website:
 
     [bookmark: pgfId-305733]http://cisco.com/cgi-bin/tablebuild.pl/mds-fm
 
     [bookmark: pgfId-305734]For detailed Cisco DCNM installation steps, please refer to 
 
     [bookmark: pgfId-305911]Cisco DCNM Installation Guide, Release 10.0(x).
 
    
 
     
      [bookmark: pgfId-305735]Data Migration in Cisco DCNM-SAN Server
 
     [bookmark: pgfId-305736]The database migration should be limited to the existing database. Data collision can occur when you merge the data between the several databases.
 
     [bookmark: pgfId-262564]When you upgrade a non federation mode database to a federation mode database for the first time, the cluster sequence table is filled with the values larger than the corresponding ones in the sequence table and conforming to the cluster sequence number format for that server ID.
 
    
 
     
      [bookmark: pgfId-262569][bookmark: 42737][bookmark: 60758][bookmark: 88287]Verifying Performance [bookmark: marker-262568]Manager Collections
 
     [bookmark: pgfId-257718]Once Performance Manager collections have been running for five or more minutes, you can verify that the collections are gathering data by choosing Performance Manager > Reports in DCNM-SAN. You see the first few data points gathered in the graphs and tables.
 
    
 
   
 
    
     [bookmark: pgfId-257725][bookmark: 72565][bookmark: 55042]Managing a Cisco DCNM-SAN Server Fabric
 
    [bookmark: pgfId-257727]You can continuously[bookmark: marker-257726] manage a Cisco DCNM-SAN Server fabric, whether or not a client has that fabric open. A continuously managed fabric is automatically reloaded and managed by Cisco DCNM-SAN Server whenever the server starts.
 
     
      [bookmark: pgfId-280903][bookmark: 99610]Selecting a Fabric to Manage Continuously
 
    
 
     
      [bookmark: pgfId-280904]DETAILED STEPS
 
     
 
     [bookmark: pgfId-280905]Step 1 Choose Server > Admin.
 
     [bookmark: pgfId-280907]You see the Control Panel dialog box with the Fabrics tab ope.
 
      
       
     
 
     
 
     [bookmark: pgfId-257292]Note The Fabrics tab is only accessible to network administrators.
 
      
      
 
     
 
     
 
     [bookmark: pgfId-286830]
 
      
       
     
 
     
 
     [bookmark: pgfId-257299]Note You can preconfigure a user name and password to manage fabrics. In this instance, you should use a local switch account, not a TACACS+ server.
 
      
      
 
     
 
     
 
     [bookmark: pgfId-257300]Step 2 Choose one of the following Admin options:
 
     [bookmark: pgfId-257301] a. Manage Continuously—The fabric is automatically managed when Cisco DCNM-SAN Server starts and continues to be managed until this option is changed to Unmanage.
 
     [bookmark: pgfId-257302] b. Manage—The fabric is managed by Cisco DCNM-SAN Server until there are no instances of DCNM-SAN viewing the fabric.
 
     [bookmark: pgfId-257303] c. Unmanage—Cisco DCNM-SAN Server stops managing this fabric.
 
     [bookmark: pgfId-257304]Step 3 Click Apply.
 
     [bookmark: pgfId-257305]
 
      
      
 
     
 
     
 
      
       
     
 
     
 
     [bookmark: pgfId-274325]Note If you are collecting data on these fabrics using Performance Manager, you should now configure flows and define the data collections.
 
      
      
 
     
 
     
 
    
 
     
      [bookmark: pgfId-274331][bookmark: 24097]Cisco DCNM-SAN Server Properties File[bookmark: marker-274330]
 
     [bookmark: pgfId-257760]The Cisco DCNM-SAN Server properties file (MDS 9000\server.properties) contains a list of properties that determine how the Cisco DCNM-SAN Server will function. You can edit this file with a text editor, or you can set the properties through the DCNM-SAN Web Services GUI, under the Admin tab.
 
      
       
     
 
     
 
     [bookmark: pgfId-257761]Note As of Cisco NX-OS Release 4.1(1b) and later, you can optionally encrypt the password in the server.properties and the AAA.properties files.
 
      
      
 
     
 
     
 
     [bookmark: pgfId-257762]The server properties file contains these nine general sections:
 
      
      	 [bookmark: pgfId-257763] GENERAL —Contains the general settings for the server.
 
      	 [bookmark: pgfId-257764] SNMP SPECIFIC —Contains the settings for SNMP requests, responses, and traps.
 
      	 [bookmark: pgfId-257765] SNMP PROXY SERVER SPECIFIC —Contains the settings for SNMP proxy server configuration and TCP port designation.
 
      	 [bookmark: pgfId-257766] GLOBAL FABRIC —Contains the settings for fabrics, such as discovery and loading.
 
      	 [bookmark: pgfId-257767] CLIENT SESSION —Contains the settings for DCNM-SAN Clients that can log into the server.
 
      	 [bookmark: pgfId-257768] EVENTS —Contains the settings for syslog messages.
 
      	 [bookmark: pgfId-257769]PERFORMANCE CHART—Contains the settings for defining the end time to generate a Performance Manager chart.
 
      	 [bookmark: pgfId-257770]EMC CALL HOME—Contains the settings for the forwarding of traps as XML data using e-mail, according to EMC specifications.
 
      	 [bookmark: pgfId-257771]EVENT FORWARD SETUP—Contains the settings for forwarding events logged by Cisco DCNM-SAN Server through e-mail.
 
     
 
     [bookmark: pgfId-257772]The following server properties are added or changed in the Cisco DCNM-SAN Release 3.x and later.
 
     [bookmark: pgfId-257773]SNMP Specific
 
      
      	 [bookmark: pgfId-257774] snmp.preferTCP —If this option is set to true, TCP is the default protocol for Cisco DCNM-SAN Server to communicate with switches. By default, this setting is  true . For those switches that do not have TCP enabled, Cisco DCNM-SAN Server uses UDP. The advantage of this setting is the ability to designate one TCP session for each SNMP user on a switch. It also helps to reduce timeouts and increase scalability.
 
     
 
      
       
     
 
     
 
     [bookmark: pgfId-259206]Note If you set this option to false, the same choice must be set in DCNM-SAN. The default value of snmp.preferTCP for DCNM-SAN is true.
 
      
      
 
     
 
     
 
     [bookmark: pgfId-259207]Performance Chart
 
      
      	 [bookmark: pgfId-257777] pmchart.currenttime —Specifies the end time to generate a Performance Manager chart. This should only be used for debugging purposes.
 
     
 
     [bookmark: pgfId-257778]EMC Call Home
 
      
      	 [bookmark: pgfId-257779] server.callhome.enable —Enables or disables EMC Call Home. By default, it is disabled.
 
      	 [bookmark: pgfId-257780] server.callhome.location —Specifies the Location parameter.
 
      	 [bookmark: pgfId-257781] server.callhome.fromEmail —Specifies the From Email list. 
 
      	 [bookmark: pgfId-257782] server.callhome.recipientEmail —Specifies the recipientEmail list.
 
      	 [bookmark: pgfId-257783] server.callhome.smtphost —Specifies the SMTP host address for outbound e-mail.
 
      	 [bookmark: pgfId-257784] server.callhome.xmlDir —Specifies the path to store the XML message files.
 
      	 [bookmark: pgfId-257785] server.callhome.connectType —Specifies the method to use to remotely connect to the server.
 
      	 [bookmark: pgfId-257786] server.callhome.accessType —Specifies the method to use to establish remote communication with the server.
 
      	 [bookmark: pgfId-257787] server.callhome.version —Specifies the version number of the connection type.
 
      	 [bookmark: pgfId-257788] server.callhome.routerIp —Specifies the public IP address of the RSC router.
 
     
 
     [bookmark: pgfId-257789]Event Forwarding
 
      
      	 [bookmark: pgfId-257790] server.forward.event.enable —Enables or disables event forwarding.
 
      	 [bookmark: pgfId-257791] server.forward.email.fromAddress —Specifies the From Email list.
 
      	 [bookmark: pgfId-257792] server.forward.email.mailCC —Specifies the CC Email list.
 
      	 [bookmark: pgfId-257793]server.forward.email.mailBCC—Specifies the BCC Email list.
 
      	 [bookmark: pgfId-257794] server.forward.email.smtphost —Specifies the SMTP host address for outbound e-mail.
 
     
 
     [bookmark: pgfId-258854]Deactivation
 
      
      	 [bookmark: pgfId-258871] deactivate.confirm=deactivate —Specific Request for User to type a String for deactivation. 
 
     
 
      
       
     
 
     
 
     [bookmark: pgfId-264867]Note In a federated server environment, you should not change Cisco DCNM-SAN Server properties by modifying server.properties file. You must modify the server.properties using web client menu Admin > Configure > Preferences.
 
      
      
 
     
 
     
 
    
 
   
 
    
     [bookmark: pgfId-271024][bookmark: 28887]Modifying Cisco DCNM-SAN Server
 
    [bookmark: pgfId-271026]You can [bookmark: marker-271025]modify certain Cisco DCNM-SAN Server settings without stopping and starting the server. 
 
     
     	 [bookmark: pgfId-257806]Changing the Cisco DCNM-SAN Server Username and Password
 
     	 [bookmark: pgfId-265091]Changing the Cisco DCNM-SAN Server Username and Password
 
     	 [bookmark: pgfId-280516]Changing the DCNM-SAN Server Fabric Discovery Username and Password
 
     	 [bookmark: pgfId-284121]Changing the Polling Period and Fabric Rediscovery Time
 
     	 [bookmark: pgfId-284083]Changing the IP Address of the Cisco DCNM-SAN & DCNM-SMIS WINDOWS Server
 
     	 [bookmark: pgfId-284420]Changing the IP Address of the Cisco DCNM-SAN for Federated Windows Setup
 
     	 [bookmark: pgfId-284085]Changing the IP Address of the Cisco DCNM-SAN & DCNM-SMIS LINUX Server
 
     	 [bookmark: pgfId-265097]Using Device Aliases or FC Aliases
 
    
 
     
      [bookmark: pgfId-257464][bookmark: 76467][bookmark: 77508][bookmark: 11389]Changing the Cisco DCNM-SAN Server Username and Password
 
     [bookmark: pgfId-257466]You can modify the username or password[bookmark: marker-257465] used to access a fabric from DCNM-SAN Client without restarting Cisco DCNM-SAN Server.
 
    
 
     
      [bookmark: pgfId-257467]DETAILED STEPS
 
     
 
     [bookmark: pgfId-257468]Step 1 Choose Server > Admin. 
 
     [bookmark: pgfId-257847]You see the Control Panel dialog box with the Fabrics tab open.
 
     [bookmark: pgfId-257473]Step 2 Set the Name or Password for each fabric that you are monitoring with Cisco DCNM-SAN Server. 
 
     [bookmark: pgfId-257474]Step 3 Click Apply to save these changes.
 
     [bookmark: pgfId-280156]
 
      
      
 
     
 
     
 
    
 
     
      [bookmark: pgfId-280326][bookmark: 32129]Changing the DCNM-SAN Server Fabric Discovery Username and Password
 
    
 
     
      [bookmark: pgfId-280399]DETAILED STEPS
 
     
 
     [bookmark: pgfId-280427]Step 1 Click Server > Admin in Cisco DCNM-SAN.
 
     [bookmark: pgfId-303189]You see the Control Panel dialog box with the Fabrics tab open. 
 
     [bookmark: pgfId-303192]
 
     [bookmark: pgfId-303193]Step 2 Click the fabrics that have updated user name and password information.
 
     [bookmark: pgfId-280440]Step 3 [bookmark: 66295]From the Admin listbox, select Unmanage and then click Apply.
 
     [bookmark: pgfId-280442]Step 4 [bookmark: 50160]Enter the appropriate user name and password and then click Apply.
 
     [bookmark: pgfId-280422]For more information, see the ““Performance Manager Authentication” section”.
 
     [bookmark: pgfId-280492]
 
      
      
 
     
 
     
 
    
 
     
      [bookmark: pgfId-257478][bookmark: 93493][bookmark: 20202]Changing the [bookmark: marker-257477]Polling Period and Fabric Rediscovery Time
 
     [bookmark: pgfId-257479]Cisco DCNM-SAN Server periodically polls the monitored fabrics and periodically rediscovers the full fabric at a default interval of five cycles.You can modify these settings from DCNM-SAN Client without restarting Cisco DCNM-SAN Server.
 
    
 
     
      [bookmark: pgfId-257481]DETAILED STEPS
 
     
 
     [bookmark: pgfId-257482]Step 1 Choose Server > Admin.
 
     [bookmark: pgfId-257855]You see the Control Panel dialog box with the Fabrics tab open.
 
     [bookmark: pgfId-257487]Step 2 For each fabric that you are monitoring with Cisco DCNM-SAN Server, set the Polling Interval to determine how frequently Cisco DCNM-SAN Server polls the fabric elements for status and statistics.
 
     [bookmark: pgfId-257488]Step 3 For each fabric that you are monitoring with Cisco DCNM-SAN Server, set the Rediscover Cycles to determine how often Cisco DCNM-SAN Server rediscovers the full fabric.
 
     [bookmark: pgfId-270462]Step 4 Click Apply to save these changes.
 
     [bookmark: pgfId-270463]
 
      
      
 
     
 
     
 
    
 
     
      [bookmark: pgfId-283980][bookmark: 19615]Changing the IP Address of the Cisco DCNM-SAN & DCNM-SMIS WINDOWS Server
 
     [bookmark: pgfId-283981]To change the IP address of a Cisco DCNM-SAN & DCNM-SMIS Server, follow these steps:
 
    
 
     
      [bookmark: pgfId-283986]Detailed Steps
 
     
 
     [bookmark: pgfId-283987]Step 1 Stop the Cisco DCNM-SAN and DCNM-SMIS Servers.
 
     [bookmark: pgfId-283988]Step 2 Change the old IP Address with the new IP Address in the following files
 
      
      	 [bookmark: pgfId-283989] $INSTALLDIR\jboss-as-7.2.0.Final\bin\service\sanservice.bat 
 
      	 [bookmark: pgfId-283990] $INSTALLDIR\jboss-as-7.2.0.Final\standalone\configuration\standalone-san.xml(Including DB url) 
 
      	 [bookmark: pgfId-283991] $INSTALLDIR\fm\conf\server.properties 
 
     
 
     [bookmark: pgfId-283992]Step 3 Enter the following command to assign a new IP address.
 
      
      [bookmark: pgfId-283993]run $INSTALLDIR\fm\bin\PLMapping.bat -p newipaddress 0 
     
 
      
      [bookmark: pgfId-283994] 
     
 
     [bookmark: pgfId-283995]Assume $INSTALLDIR is the top directory of DCNM installation. The above command is for single server instance, where 0 is the server ID.
 
     [bookmark: pgfId-283996]Step 4 Change the old IP Address with the new IP Address in the file $INSTALLDIR\fm\conf\smis.properties
 
     [bookmark: pgfId-283997]Step 5 Start the Cisco DCNM-SAN and DCNM-SMIS Servers.
 
     [bookmark: pgfId-283998]
 
      
      
 
     
  
     
 
    
 
     
      [bookmark: pgfId-284423][bookmark: 79092]Changing the IP Address of the Cisco DCNM-SAN for Federated Windows Setup
 
     [bookmark: pgfId-284526]To change the IP address of a Cisco DCNM-SAN for federated Windows OS, follow these steps:
 
      
      	 [bookmark: pgfId-284657]Changing the IP address of primary server
 
      	 [bookmark: pgfId-284764]Changing the IP address of secondary server
 
     
 
    
 
     
      [bookmark: pgfId-284596][bookmark: 93031]Changing the IP address of primary server
 
     
 
     [bookmark: pgfId-284830]Step 1 Stop the Cisco DCNM-SAN and DCNM-SMIS Servers.
 
     [bookmark: pgfId-284931]Step 2 Change the old IP Address with the new IP Address in the file $INSTALLDIR\jboss-as-7.2.0.Final\bin\service\sanservice.bat
 
     [bookmark: pgfId-284932]Step 3 Change the old IP Address with the new IP Address in the file $INSTALLDIR\jboss-as-7.2.0.Final\standalone\configuration\standalone-san.xml.
 
     [bookmark: pgfId-284933]Step 4 Change the old IP Address with the new IP Address in the file $INSTALLDIR\fm\conf\server.properties
 
      
       
     
 
     
 
     [bookmark: pgfId-284934]Note If DB is installed locally(URL pointing to LocalHost),No DB URL change required in standalone-san.xml , server.properties .
 
      
      
 
     
 
     
 
     [bookmark: pgfId-284935]Step 5 Enter the following command to assign a new IP address.
 
     [bookmark: pgfId-284936]run $INSTALLDIR\fm\bin\PLMapping.bat -p newipaddress 0
 
     [bookmark: pgfId-285072]Assume $INSTALLDIR is the top directory of DCNM installation. The above command is for primary server instance, where 0 is the server ID.
 
     [bookmark: pgfId-284938]Step 6 Change the old IP Address with the new IP Address in the file $INSTALLDIR\fm\conf\smis.properties
 
     [bookmark: pgfId-284939]Step 7 Start the Cisco DCNM-SAN and DCNM-SMIS Servers.
 
     [bookmark: pgfId-284689]
 
      
      
 
     
 
     
 
    
 
     
      [bookmark: pgfId-284732][bookmark: 71439]Changing the IP address of secondary server
 
     
 
     [bookmark: pgfId-284734]Step 1 Stop the Cisco DCNM-SAN and DCNM-SMIS Servers.
 
     [bookmark: pgfId-285197]Step 2 Change the old IP Address with the new IP Address in the file $INSTALLDIR\jboss-as-7.2.0.Final\bin\service\sanservice.bat
 
     [bookmark: pgfId-285198]Step 3 Change the old IP Address with the new IP Address in the file $INSTALLDIR\jboss-as-7.2.0.Final\standalone\configuration\standalone-san.xml
 
     [bookmark: pgfId-285199]Step 4 Change the old IP Address with the new IP Address in the file $INSTALLDIR\fm\conf\server.properties.
 
     [bookmark: pgfId-285200]Step 5 Change DB URL in standalone-san.xml, server.properties, postgresql.cfg.xml\ oracle.cfg.xml files, if there is ipaddress change in primary server.
 
     [bookmark: pgfId-285201]postgresql.cfg.xml\ oracle.cfg.xml can be found under $INSTALLDIR\jboss-as-7.2.0.Final\standalone\ conf\ directory.
 
     [bookmark: pgfId-285202]Step 6 Enter the following command to assign a new IP address.
 
     [bookmark: pgfId-285203] run $INSTALLDIR\fm\bin\PLMapping.bat -p newipaddress 1 .
 
      
       
     
 
     
 
     [bookmark: pgfId-285204]Note ServerID can be got by run $INSTALLDIR\fm\bin\PLMapping.bat -show.
 
      
      
 
     
 
     
 
     [bookmark: pgfId-285205]Assume $INSTALLDIR is the top directory of DCNM installation. The above command 1 is the server ID.
 
     [bookmark: pgfId-285206]Step 7 Change the old IP Address with the new IP Address in the file $INSTALLDIR\fm\conf\smis.properties
 
     [bookmark: pgfId-285207]Step 8 Start the Cisco DCNM-SAN and DCNM-SMIS Servers.
 
     [bookmark: pgfId-284737]
 
      
      
 
     
 
     
 
    
 
     
      [bookmark: pgfId-284000][bookmark: 83394]Changing the IP Address of the Cisco DCNM-SAN & DCNM-SMIS LINUX Server
 
     [bookmark: pgfId-284001]To change the IP address of a Cisco DCNM-SAN & DCNM-SMIS Server, follow these steps:
 
    
 
     
      [bookmark: pgfId-284006]Detailed Steps
 
     
 
     [bookmark: pgfId-284007]Step 1 Stop the Cisco DCNM-SAN and DCNM-SMIS Servers.
 
     [bookmark: pgfId-284008]Step 2 Change the old IP Address with the new IP Address in the following files:
 
      
      	 [bookmark: pgfId-284009] $INSTALLDIR/jboss-as-7.2.0.Final/bin/init.d/sanservice.sh 
 
      	 [bookmark: pgfId-284010] /etc/init.d/FMServer 
 
      	 [bookmark: pgfId-284011] $INSTALLDIR/jboss-as-7.2.0.Final/standalone/configuration/standalone-san.xml (Including DB url) 
 
      	 [bookmark: pgfId-284012] $INSTALLDIR/fm/conf/server.properties 
 
     
 
     [bookmark: pgfId-284013]Step 3 Enter the following command to assign a new IP address.
 
      
      [bookmark: pgfId-284014]run $INSTALLDIR/fm/bin/PLMapping.sh -p newipaddress 0 
     
 
      
      [bookmark: pgfId-284015] 
     
 
     [bookmark: pgfId-284016]Assume $INSTALLDIR is the top directory of DCNM installation. The above command is for single server instance, where 0 is the server ID. 
 
     [bookmark: pgfId-284017]Step 4 Change the old IP Address with the new IP Address in the file $INSTALLDIR/fm/conf/smis.properties.
 
      
       
     
 
     
 
     [bookmark: pgfId-298320]Note If this is a DCNM virtual appliance (OVA/ISO) deployed without any Fabric enhancements, update the property DCNM_IP_ADDRESS in the file /root/packaged-files/properties/installer.properties with the new IP Address.
 
      
      
 
     
 
     
 
     [bookmark: pgfId-284018]Step 5 Start the Cisco DCNM-SAN and DCNM-SMIS Servers.
 
     [bookmark: pgfId-283969]
 
      
      
 
     
 
     
 
    
 
     
      [bookmark: pgfId-270466][bookmark: 10470]Using Device [bookmark: marker-270465]Aliases or FC Aliases
 
     [bookmark: pgfId-257494]You can change whether DCNM-SAN uses FC aliases or global device aliases[bookmark: marker-257493] from DCNM-SAN Client without restarting Cisco DCNM-SAN Server.
 
    
 
     
      [bookmark: pgfId-257495]DETAILED STEPS
 
     
 
     [bookmark: pgfId-257496]Step 1 Choose Server > Admin. 
 
     [bookmark: pgfId-257863]You see the Control Panel dialog box with the Fabrics tab open.
 
     [bookmark: pgfId-257501]Step 2 For each fabric that you are monitoring with Cisco DCNM-SAN Server, check or uncheckthe FC Alias check box.
 
     [bookmark: pgfId-282822]If you check the FC Alias checkbox, DCNM-SAN will use FC Alias from DCNM-SAN Client. If you uncheck the FC Alias checkbox, DCNM-SAN will use global device alias from DCNM-SAN Client.
 
     [bookmark: pgfId-257502]Step 3 Click Apply to save these changes.
 
     [bookmark: pgfId-259310]
 
      
      
 
     
 
     
 
    
 
   
 
    
     [bookmark: pgfId-286877]Configuring Security Manager
 
    [bookmark: pgfId-286878]The security at Fabric Manager Server level control access to different features of the Fabric Manager. The existing security controls in the Fabric Manager allows a user to continue even after many unsuccessful login attempts. With the new security manager, the Fabric Manager will perform a lock-out for the specific user after a specified number of unsuccessful login attempts. System administrators will be able to generate a report of login attempts.
 
    [bookmark: pgfId-286879]To see the number of failed login attempts, in the Fabric Manager Control Panel, click Local FM Users.
 
    [bookmark: pgfId-303174]You see the control panel.
 
   
 
    
     [bookmark: pgfId-224899][bookmark: 41089]Server Federation
 
    [bookmark: pgfId-261692]Server Federation is a distributed system that includes a collection of intercommunicated servers or computers that is utilized as a single, unified computing resource. With Cisco DCNM-SAN Server Federation, you can communicate with multiple servers together in order to provide scalability and easy manageability of data and programs running within the federation. The core of server federation includes several functional units such as Cisco DCNM-SAN Server, embedded web servers, database and DCNM-SAN Client that accesses the servers. 
 
    [bookmark: pgfId-261701]The Cisco DCNM-SAN Server in the federation uses the same database to store and retrieve data. The database is shared among different servers to share common information. A DCNM-SAN Client or DCNM-SAN Web Client can open fabrics from the Cisco DCNM-SAN Server using the mapping table. A fabric can be moved from one logical server to another. A logical server also can be moved from one physical machine to another machine.
 
     
      [bookmark: pgfId-270247]Restrictions
 
      
      	 [bookmark: pgfId-264946]You cannot upgrade more than one Cisco DCNM-SAN Server in an existing federation. If you choose to do so, you may not be able to migrate the Performance Manager statistics and other information on that server. 
 
      	 [bookmark: pgfId-265033]You may require to synchronize the time on all the DCNM-SAN Servers in a federated server environment. 
 
     
 
    
 
     
      [bookmark: pgfId-261708]Mapping Fabric ID to Server ID
 
     [bookmark: pgfId-261722]The IP address of the physical server will be mapped to the server ID during the installation of the Cisco DCNM-SAN Server whenever the IP address of the physical server is changed, you need to map the IP address to the server ID using the PLMapping script provided with the Cisco DCNM-SAN Server. Whenever the you open or discover a fabric, the fabric ID will be mapped to the server ID . You can move a fabric to a different server ID using the control panel. 
 
    
 
     
      [bookmark: pgfId-261747]DETAILED STEPS
 
     
 
     [bookmark: pgfId-261812]Step 1 Choose Server > Admin.
 
     [bookmark: pgfId-261836]You see the Control Panel.
 
     [bookmark: pgfId-261838]Step 2 Select the fabric that you want to move to a different server and then click Move.
 
     [bookmark: pgfId-261861]You see the Move Fabric dialog box.
 
     [bookmark: pgfId-261857]Step 3 You see the fabrics that you selected in the Fabrics to Move list box. From the Move To Server drop-down list select the server you want to move the fabric to. 
 
     [bookmark: pgfId-261930]Step 4 Click Move.
 
     [bookmark: pgfId-261937]
 
      
      
 
     
 
     
 
    
 
     
      [bookmark: pgfId-261709]Opening the Fabric on a Different Server
 
    
 
     
      [bookmark: pgfId-261957]DETAILED STEPS
 
     
 
     [bookmark: pgfId-261967]Step 1 Choose Server > Admin.
 
     [bookmark: pgfId-261965]You see the Control Panel.
 
     [bookmark: pgfId-279746]
 
     [bookmark: pgfId-264931]Step 2 Click Discover.
 
     [bookmark: pgfId-261996]You see the Discover New Fabric dialog box.
 
     [bookmark: pgfId-264939]Step 3 In the Seed Switch list box, enter the IP Address of the seed switch.
 
     [bookmark: pgfId-264940]Step 4 In the User Name field, enter the username.
 
     [bookmark: pgfId-264941]Step 5 In the password field, enter the password. 
 
     [bookmark: pgfId-261997]Step 6 From the Auth-Privacy drop-down list, choose the privacy protocol you want to apply.
 
     [bookmark: pgfId-264945]Step 7 To open the selected fabric in a different server, select the server ID from the Server drop-down list.
 
     [bookmark: pgfId-262057]Step 8 Click Discover. 
 
      
       
     
 
     
 
     [bookmark: pgfId-264964]Note You may receive an error message when you discover a fabric in a federation while another Cisco DCNM-SAN Server is joining the federation. You can discover the fabric on after the installation or upgradation is complete.
 
      
      
 
     
 
     
 
     [bookmark: pgfId-281235]
 
      
      
 
     
 
     
 
    
 
     
      [bookmark: pgfId-261707]Viewing the Sessions in a Federation
 
    
 
     
      [bookmark: pgfId-262078]DETAILED STEPS
 
     
 
     [bookmark: pgfId-262085]Step 1 Choose Server > Admin.
 
     [bookmark: pgfId-262095]Step 2 Click the Connected Clients tab.
 
     [bookmark: pgfId-281260]You see the Control Panel.
 
     [bookmark: pgfId-286976]
 
    
 
     
      [bookmark: pgfId-281256]Viewing the Servers in a Federation
 
    
 
     
      [bookmark: pgfId-262136]DETAILED STEPS
 
     
 
     [bookmark: pgfId-262137]Step 1 Choose Server > Admin.
 
     [bookmark: pgfId-262138]Step 2 Click the Servers tab.
 
     [bookmark: pgfId-283428]You see the Control Panel.
 
    
 
     
      [bookmark: pgfId-283437]Discover Devices Managed by SVI
 
     
 
     [bookmark: pgfId-283505]Step 1 Log on to the DCNM Web Client.
 
     [bookmark: pgfId-283506]Step 2 Select Admin>Server Properties.
 
     [bookmark: pgfId-283507]Step 3 Scroll down to the GENERAL->DATA SOURCE FABRIC section.
 
     [bookmark: pgfId-283508]Step 4 Set the fabric.managementIpOverwrite property to false.
 
     [bookmark: pgfId-283509]Step 5 Click Apply.
 
     [bookmark: pgfId-283510]Step 6 Restart the DCNM service.
 
      
       
     
 
     
 
     [bookmark: pgfId-283511]Note If you experiences technical issues using DCNM, you must restart the database service manually.
 
      
      
 
     
 
     
 
     [bookmark: pgfId-283512]Step 7 Delete any previously discovered switch that incorrectly shows the mgmt0 IP address.
 
     [bookmark: pgfId-283499]Step 8 Retry the discovery. 
 
      
       
     
 
     
 
     [bookmark: pgfId-283680]Note Each SVI switch must be discovered separately.
 
      
      
 
     
 
     
 
    
 
   
 
    
     [bookmark: pgfId-283431][bookmark: 14554]Additional References
 
     
     	 [bookmark: pgfId-283432]Server Federation is a licensed feature. For more information on Cisco DCNM-SAN Server Licensing, see Cisco MDS 9000 Family NX-OS Licensing Guide.
 
     	 [bookmark: pgfId-270275]For more information on deploying Cisco DCNM-SAN Server in a federation, see Cisco Fabric Manager Server Federation Deployment Guide.
 
    
 
    [bookmark: pgfId-270269]
 
   
 
  
 
  
  
   
   
    
     [bookmark: pgfId-226803]Configuring [bookmark: 1072]Authentication in Cisco DCNM-SAN 
      
      
 
     
 
 
    [bookmark: pgfId-226804]This chapter describes the interdependent software components in Cisco DCNM-SAN that communicate with the switches, authentication steps and the best practices for setting up your fabric and components for authentication.
 
    [bookmark: pgfId-226805]This chapter contains the following sections:
 
     
     	 [bookmark: pgfId-226809]Information About Cisco DCNM-SAN Authentication
 
     	 [bookmark: pgfId-226813]Best Practices for Discovering a Fabric
 
     	 [bookmark: pgfId-226817]Performance Manager Authentication
 
     	 [bookmark: pgfId-226821]Cisco DCNM-SAN Web Client Authentication
 
    
 
   
 
    
     [bookmark: pgfId-226827][bookmark: 65100]Information About Cisco DCNM-SAN [bookmark: marker-226826]Authentication
 
    [bookmark: pgfId-226829]Cisco DCNM-SAN contains multiple components that interact to manage a fabric. 
 
    [bookmark: pgfId-226830]These components include:
 
     
     	 [bookmark: pgfId-226831]Cisco DCNM-SAN Client
 
     	 [bookmark: pgfId-226832]Cisco DCNM-SAN Server
 
     	 [bookmark: pgfId-226833]Performance Manager
 
     	 [bookmark: pgfId-226834]Interconnected fabric of Cisco MDS 9000 switches and storage devices
 
     	 [bookmark: pgfId-226835]AAA server (optional)
 
    
 
    [bookmark: pgfId-236860]Figure 9-1 shows an example configuration for these components.
 
    [bookmark: pgfId-236863]Figure 9-1 [bookmark: 33746]Cisco DCNM-SAN Authentication[bookmark: marker-236862] Example
 
    [bookmark: pgfId-236867]
 
     
     [image: ] 
    
 
    [bookmark: pgfId-226849]Administrators launch Cisco DCNM-SAN Client and select the seed switch that is used to discover the fabric. The user name and password used are passed to Cisco DCNM-SAN Server and used to authenticate to the seed switch. If this user name and password are not a recognized SNMP user name and password, either Cisco DCNM-SAN Client or Cisco DCNM-SAN Server opens a CLI session to the switch (SSH or Telnet) and retries the user name and password pair. If the user name and password are recognized by the switch in either the local switch authentication database or through a remote AAA server, then the switch creates a temporary SNMP user name that is used by Cisco DCNM-SAN Client and server.
 
     
      
    
 
    
 
    [bookmark: pgfId-226851]Note You may encounter a delay in authentication if you use a [bookmark: marker-226850]remote AAA server to authenticate Cisco DCNM-SAN or Device Manager.
 
     
     
 
    
 
    
 
     
      
    
 
    
 
    [bookmark: pgfId-226853]Note You must allow CLI sessions to pass through any [bookmark: marker-226852]firewall that exists between Cisco DCNM-SAN Client and Cisco DCNM-SAN Server. 
 
     
     
 
    
 
    
 
     
      
    
 
    
 
    [bookmark: pgfId-244797]Note We recommend that you use the same password for the SNMPv3 user name authentication and privacy passwords as well as the matching CLI user name and password.
 
     
     
 
    
 
    
 
   
 
    
     [bookmark: pgfId-244801][bookmark: 44619]Best Practices for [bookmark: marker-244800]Discovering a Fabric
 
    [bookmark: pgfId-226864]Cisco DCNM-SAN Server monitors multiple physical fabrics under the same user interface. This facilitates managing redundant fabrics. A licensed Cisco DCNM-SAN Server maintains up-to-date discovery information on all configured fabrics so device status and interconnections are immediately available when you launch Cisco DCNM-SAN Client.
 
     
      
    
 
    
 
     
     [bookmark: pgfId-226865] 
     Caution If the Cisco DCNM-SAN Server’s CPU usage exceeds 50 percent, it is recommended that you switch to a higher CPU-class system. 
      
      
 
     
 
    
 
    [bookmark: pgfId-226869]We recommend that you use these best practices for discovering your network and setting up Performance Manager. This ensures that Cisco DCNM-SAN Server has a complete view of the fabric. Subsequent Cisco DCNM-SAN Client sessions can filter this complete view based on the privileges of the client logging in. For example, if you have multiple VSANs in your fabric and you create users that are limited to a subset of these VSANs, you want to initiate a fabric discovery through Cisco DCNM-SAN Server using a network administrator or network operator role so that Cisco DCNM-SAN Server has a view of all the VSANs in the fabric. When a VSAN-limited user launches Cisco DCNM-SAN Client, that user sees only the VSANs they are allowed to manage.
 
     
      
    
 
    
 
    [bookmark: pgfId-226870]Note Cisco DCNM-SAN Server should always monitor fabrics using a local switch account, do not use a AAA (RADIUS or TACACS+) server. You can use a AAA user account to log into the clients to provision fabric services. 
 
     
     
 
    
 
    
 
     
      
    
 
    
 
    [bookmark: pgfId-245013]Note Even when remote AAA server authentication is enabled on the switch, use the local switch account that is not defined in the remote AAA server for fabric discovery. In other words, when a user is not found in the remote AAA server, then local switch user authentication will be allowed by the switch for SNMPv3 clients like DCNM.
 
     
     
 
    
 
    
 
     
      [bookmark: pgfId-226874]Setting Up Discovery for a Fabric 
 
    
 
     
      [bookmark: pgfId-226875]DETAILED STEPS
 
     
 
     [bookmark: pgfId-226876]Step 1 Create a special Cisco DCNM-SAN administrative user name in each switch on your fabric with network administrator or network operator roles. Or, create a special Cisco DCNM-SAN administrative user name in your AAA server and set every switch in your fabric to use this AAA server for authentication.
 
     [bookmark: pgfId-226877]Step 2 Verify that the roles used by this Cisco DCNM-SAN administrative user name are the same on all switches in the fabric and that this role has access to all VSANs.
 
     [bookmark: pgfId-226878]Step 3 Launch Cisco DCNM-SAN Client using the Cisco DCNM-SAN administrative user. This step ensures that your fabric discovery includes all VSANs.
 
     [bookmark: pgfId-226880]Step 4 [bookmark: 56908]Set Cisco DCNM-SAN Server to continuously monitor the fabric. 
 
     [bookmark: pgfId-244921]Step 5 Repeat Step 4 for each fabric that you want to manage through Cisco DCNM-SAN Server.
 
     [bookmark: pgfId-244922]
 
      
      
 
     
. 
     
 
    
 
   
 
    
     [bookmark: pgfId-244926][bookmark: 68600][bookmark: 43309]Performance [bookmark: marker-244925]Manager Authentication
 
    [bookmark: pgfId-226895]Performance Manager uses the user name and password information stored in the Cisco DCNM-SAN Server database. If this information changes on the switches in your fabric while Performance Manager is running, you need to update the Cisco DCNM-SAN Server database and restart Performance Manager. Updating the Cisco DCNM-SAN Server database requires removing the fabric from Cisco DCNM-SAN Server and rediscovering the fabric.
 
     
      [bookmark: pgfId-226897]DETAILED STEPS
 
     
 
     [bookmark: pgfId-226898]Step 1 Click Server > Admin in Cisco DCNM-SAN.
 
     [bookmark: pgfId-226909]Step 2 Click the fabrics that have updated user name and password information.
 
     [bookmark: pgfId-226910]Step 3 [bookmark: 66295]From the Admin listbox, choose Unmanage and then click Apply.
 
     [bookmark: pgfId-226923]Step 4 [bookmark: 50160]Enter the appropriate user name and password and then click Apply.
 
     [bookmark: pgfId-233443]Step 5 From the Admin listbox, choose Manage and then click Apply.
 
     [bookmark: pgfId-233456]Step 6 To rediscover the fabric, click Open tab and check the check box(es) next to the fabric(s) you want to open in the Select column.
 
     [bookmark: pgfId-226925]Step 7 [bookmark: 70419]Click Open to rediscover the fabric. Cisco DCNM-SAN Server updates its user name and password information.
 
     [bookmark: pgfId-226932]Step 8 Repeat Step 3 through Step 7 for any fabric that you need to rediscover.
 
     [bookmark: pgfId-226933]Step 9 Choose Performance > Collector > Restart to restart Performance Manager and use the new user name and password.
 
     [bookmark: pgfId-236732]
 
      
      
 
     
 
     
 
    
 
   
 
    
     [bookmark: pgfId-236735][bookmark: 60758]Cisco DCNM-SAN [bookmark: marker-236734]Web Client Authentication
 
    [bookmark: pgfId-236736]Cisco DCNM-SAN Web Server does not communicate directly with any switches in the fabric. Cisco DCNM-SAN Web Server uses its own user name and password combination that is either stored locally or stored remotely on an AAA server.
 
    [bookmark: pgfId-226943]We recommend that you use a RADIUS or TACACS+ server to authenticate users in Cisco DCNM-SAN Web Server.
 
     
      [bookmark: pgfId-226946]DETAILED STEPS
 
     
 
     [bookmark: pgfId-226947]Step 1 Launch Cisco DCNM-SAN Web Client. 
 
     [bookmark: pgfId-226952]Step 2 Choose Admin > Management Users > Remote AAA to update the authentication used by Cisco DCNM-SAN Web Client.
 
     [bookmark: pgfId-226954]Step 3 Set the authentication mode attribute to radius.
 
     [bookmark: pgfId-226955]Step 4 Set the RADIUS server name, shared secret, authentication method, and ports used for up to three RADIUS servers.
 
     [bookmark: pgfId-226956]Step 5 Click Modify to save this information.
 
     [bookmark: pgfId-226957]
 
      
      
 
     
 
     
 
     
 
     [bookmark: pgfId-226960]Step 1 Launch Cisco DCNM-SAN Web Client. 
 
     [bookmark: pgfId-226965]Step 2 Choose Admin > Management Users > Remote AAA to update the authentication used by Cisco DCNM-SAN Web Client.
 
     [bookmark: pgfId-226967]Step 3 Set the authentication mode attribute to tacacs.
 
     [bookmark: pgfId-226968]Step 4 Set the TACACS+ server name, shared secret, authentication method, and port used for up to three TACACS+ servers.
 
     [bookmark: pgfId-226969]Step 5 Click Modify to save this information.
 
     [bookmark: pgfId-226970]
 
      
      
 
     
 
     
 
      
       
     
 
     
 
     [bookmark: pgfId-221891]Note Cisco DCNM-SAN does not support SecureID because it is not compatible with SNMP authentication. Cisco DCNM-SAN uses the same login credentials for all the switches in a fabric. Since SecureID cannot be used more than once for authentication, Cisco DCNM-SAN will not be able to establish a connection to the second switch using a SecureID.
 
      
      
 
     
 
     
 
    
 
   
 
  
 
  
  
   
   
    
     [bookmark: pgfId-344059]Configuring Cisco [bookmark: 71490]DCNM-SAN Client 
      
      
 
     
 
 
    [bookmark: pgfId-344060]This chapter describes about the Cisco DCNM-SAN Client, which is a java-based GUI application that provides access to the Cisco DCNM-SAN applications from a remote workstation.
 
    [bookmark: pgfId-394145]This chapter contains the following sections:
 
     
     	 [bookmark: pgfId-344065]Information About DCNM-SAN Client
 
     	 [bookmark: pgfId-344073]Cisco DCNM-SAN Client Quick Tour: Server Admin Perspective
 
     	 [bookmark: pgfId-309708]Cisco DCNM-SAN Client Quick Tour: Admin Perspective
 
     	 [bookmark: pgfId-381170]Launching Cisco DCNM-SAN Client
 
     	 [bookmark: pgfId-344085]Setting Cisco DCNM-SAN Preferences
 
     	 [bookmark: pgfId-344089]Network Fabric Discovery
 
     	 [bookmark: pgfId-344093]Modifying the Device Grouping
 
     	 [bookmark: pgfId-344097]Controlling Administrator Access with Users and Roles
 
     	 [bookmark: pgfId-344101]Using Cisco DCNM-SAN Wizards
 
     	 [bookmark: pgfId-344105]Cisco DCNM-SAN Troubleshooting Tools
 
     	 [bookmark: pgfId-377620]Integrating Cisco DCNM-SAN and Data Center Network Management Software
 
    
 
   
 
    
     [bookmark: pgfId-344111][bookmark: 34479]Information About DCNM-SAN Client[bookmark: marker-344110]
 
    [bookmark: pgfId-364571]Cisco DCNM-SAN is a Java and SNMP-based network fabric and device management tool with a GUI that displays real-time views of your network fabric, including Cisco Nexus 5000 Series switches, Cisco MDS 9000 Family and third-party switches, hosts, and storage devices.
 
    [bookmark: pgfId-381434]In addition to complete configuration and status monitoring capabilities for Cisco MDS 9000 Family switches and Cisco Nexus 5000 Series switches, Cisco DCNM-SAN Client provides Fibre Channel troubleshooting tools. You can use these health and configuration analysis tools on the MDS 9000 Family switch or Cisco Nexus 5000 Series switch to perform Fibre Channel ping and traceroute. 
 
    [bookmark: pgfId-381441]Cisco DCNM-SAN Release 4.1(1b) and later provides multilevel security system by adding a server admin role that allows access to limited features. The configuration capabilities of a server admin is limited to FlexAttach and relevant data. 
 
     
      
    
 
    
 
    [bookmark: pgfId-296145]Note You must use the same release of Cisco DCNM-SAN Client and Cisco DCNM-SAN Server.
 
     
     
 
    
 
    
 
     
      [bookmark: pgfId-344117]Cisco DCNM-SAN Advanced Mode[bookmark: marker-344116]
 
     [bookmark: pgfId-344118]Advanced mode is enabled by default and provides the full suite of Cisco DCNM-SAN features, including security, [bookmark: marker-344119]IVR, [bookmark: marker-344120]iSCSI, and [bookmark: marker-344121]FICON. To simplify the user interface, from the list box in the upper right corner of the Cisco DCNM-SAN Client, choose Simple. In simple mode, you can access basic MDS 9000 features such as VSANs, zoning, and configuring interfaces. Advanced mode option is not available for server admin role.
 
    
 
   
 
    
     [bookmark: pgfId-314707][bookmark: 10613][bookmark: 73390][bookmark: 67257][bookmark: 20981]Cisco DCNM-SAN Client Quick Tour: Server Admin Perspective
 
    [bookmark: pgfId-369514]Cisco DCNM-SAN provides a multilevel security system by adding a server admin role that allows access only to limited features. The configuration capabilities of a server admin role is limited to FlexAttach and relevant data. The server admin can pre-configure SAN for new servers, move a server to another port on the same NPV device or another NPV device and replace a failed server onto the same port without involving the SAN administrator. The server role admin will not be able to manage Cisco DCNM-SAN users or connected clients. 
 
    [bookmark: pgfId-369557]Cisco DCNM-SAN provides a much improved user interface by including movable and dockable panes to let users arrange the Physical Attributes pane, Logical Domains pane, Fabric pane and Information pane according to requirements, making it easier to manage the workflow. The dockable panes are also called as dockable frames. A dockable frame can be standalone (floating), minimized or maximized. The logical, physical, information and the fabric panes can be can be collapsed and expanded as needed. These panes can also be docked at either the right side left side or to the bottom of the workspace.
 
     
      [bookmark: pgfId-394158]Cisco DCNM-SAN Main Window 
 
     [bookmark: pgfId-394159]This section describes the Cisco DCNM-SAN Client interface that is specific to server admin users as shown in Figure 10-1.
 
     [bookmark: pgfId-394167]Figure 10-1 [bookmark: 57854]Cisco DCNM-SAN Main Window: Server Admin Perspective
 
      
      [image: ] 
     
 
      
      [bookmark: pgfId-394174]2 
     
 
     [bookmark: pgfId-394176]Toolbar—Provides icons for direct access to the most commonly used options on the File, Tools, and Help menus.
 
      
      [bookmark: pgfId-394178]3 
     
 
     [bookmark: pgfId-394180]Information pane—Displays information about whatever option is selected in the menu tree. 
 
      
      [bookmark: pgfId-394182]4 
     
 
     [bookmark: pgfId-394184]Status Bar (right side)—Shows the last entry displayed by the discovery process and the possible error message.
 
      
      [bookmark: pgfId-394186]5 
     
 
     [bookmark: pgfId-394188]Fabric pane—Displays a map of the network fabric, including switches, hosts, and storage. It also provides tabs for displaying log and event data.
 
      
      [bookmark: pgfId-394190]6 
     
 
     [bookmark: pgfId-394192]Status Bar (left side)—Shows short-term transient messages, such as the number of rows displayed in a table. 
 
      
      [bookmark: pgfId-394194]7 
     
 
     [bookmark: pgfId-394196]Physical Attributes pane—Displays a tree of available configuration tasks depending on the fabric, VSAN, or zone selected previously. Lists the switches in the logical selection. 
 
      
      [bookmark: pgfId-394198]8 
     
 
    
 
     
      [bookmark: pgfId-329199]Menu Bar
 
     [bookmark: pgfId-314763]The menu bar at the top of the Cisco DCNM-SAN main window provides options for managing and for controlling the display of information on the Fabric pane. Server admin will not have all the options that are available for SAN admin. The menu bar provides the following menus:
 
      
      	 [bookmark: pgfId-309343]File—Opens a new fabric, rediscovers the current fabric, locates switches, sets preferences, prints the map.
 
      	 [bookmark: pgfId-309344]View—Changes the appearance of the map (these options are duplicated on the Fabric pane toolbar).
 
      	 [bookmark: pgfId-309345]Tools—Manages the Server and configuration using the FlexAttach virtual pWWN feature.
 
      	 [bookmark: pgfId-316497]Help—Displays online help topics for specific dialog boxes in the Information pane.
 
     
 
    
 
     
      [bookmark: pgfId-344296]Tool Bar
 
     [bookmark: pgfId-344297]The Cisco DCNM-SAN main toolbar (specific to server admin) provides icons for accessing the most commonly used menu bar options as shown in Table 10-1.
 
      
      [bookmark: pgfId-394220]Icon 
     
 
      
      [bookmark: pgfId-394222]Description 
     
  
     
 
     [bookmark: pgfId-394229]Opens switch fabric.
  
     
 
     [bookmark: pgfId-394236]Rediscovers current fabric.
  
     
 
     [bookmark: pgfId-394243]Finds in the map.
  
     
 
     [bookmark: pgfId-394250]Shows online help.
 
    
 
   
 
    
     [bookmark: pgfId-344336]Logical Domains Pane 
 
    [bookmark: pgfId-360110]Use the Logical Domains pane to view fabrics and to access user-defined groups. You can expand the groups to see different user-defined groups. The non-editable groups created for each core switch contains their NPV switches.
 
    [bookmark: pgfId-344341]To select an option, click a folder to display the options available and then click the option. You see the table with information for the selected option in the Information pane. The Physical Attributes pane provides the following main folders:
 
     
     	 [bookmark: pgfId-344342]Switches—Views and configures hardware, system, licensing, and configuration files. 
 
     	 [bookmark: pgfId-344343]Interfaces—Views and configures FC physical, FC logical, VFC (FCoE), Ethernet, SVC, and PortChannel interfaces.
 
    
 
   
 
    
     [bookmark: pgfId-344344][bookmark: 34238]Information Pane
 
    [bookmark: pgfId-349696]Use the Information pane to display tables of information associated with the option selected from the menu tree in the Logical Domains or Physical Attributes panes. The Information pane toolbar provides buttons for performing one or more of the operations shown in Table 5-2.
 
     
     [bookmark: pgfId-349788]Icons 
    
 
     
     [bookmark: pgfId-349790]Description 
    
  
    
 
    [bookmark: pgfId-349845]Applies configuration changes.
  
    
 
    [bookmark: pgfId-349852]Refreshes table values.
  
    
 
    [bookmark: pgfId-349859]Copies data from one row to another.
  
    
 
    [bookmark: pgfId-349866]Pastes the data from one row to another.
  
    
 
    [bookmark: pgfId-349873]Undoes the most recent change.
  
    
 
    [bookmark: pgfId-349880]Finds a specified string in the table.
  
    
 
    [bookmark: pgfId-349887]Exports and saves information to a file.
  
    
 
    [bookmark: pgfId-350045]Prints the contents of the Information pane.
  
    
 
    [bookmark: pgfId-350052]Displays a non-editable copy of the table in the Information pane in its own window, which you can move around the screen.
 
   
 
    
     [bookmark: pgfId-349770][bookmark: 70248]Fabric Pane
 
    [bookmark: pgfId-344414]Use the Fabric pane to display the graphical representation of your fabric. Table 5-1 explains the graphics you may see displayed, depending on which devices you have in your fabric. 
 
    [bookmark: pgfId-344415]The bottom of the Fabric pane has the following tabs: 
 
     
     	 [bookmark: pgfId-344416]Fabric—When displaying multiple fabrics, each fabric has its own tab. You can switch between fabrics by clicking on their respective tabs. 
 
     	 [bookmark: pgfId-344417]Log—Displays messages that describe Cisco DCNM-SAN operations, such as fabric discovery. . 
 
    
 
     
      
    
 
    
 
    [bookmark: pgfId-316241]Note Fabric map display is based on what you select in the logical domain pane. When you select a fabric node, all the switches that belong to that fabric will be enabled. When you select the group node, all the switches that belong to the groups listed under that group node will be enabled. When you select only a group, all the switches that belong to the specific group will be enabled.
 
     
     
 
    
 
    
 
     
      
    
 
    
 
    [bookmark: pgfId-311387]Note You can view information about Events using the DCNM Web Client. 
 
     
     
 
    
 
    
 
   
 
    
     [bookmark: pgfId-344437][bookmark: 95985]Cisco DCNM-SAN Client Quick Tour: Admin Perspective
 
    [bookmark: pgfId-394269]This section describes the Cisco DCNM-SAN Client interface shown in Figure 10-2.
 
    [bookmark: pgfId-394272]Figure 10-2 [bookmark: 1085]Cisco DCNM-SAN Main Window[bookmark: marker-394271]
 
    [bookmark: pgfId-394276]
 
     
     [image: ] 
    
 
     
     [bookmark: pgfId-394283]2 
    
 
    [bookmark: pgfId-394285]Toolbar—Provides icons for direct access to the most commonly used options on the File, Tools, and Help menus.
 
     
     [bookmark: pgfId-394287]3 
    
 
    [bookmark: pgfId-394289]Information pane—Displays information about whatever option is selected in the menu tree.
 
     
     [bookmark: pgfId-394291]4 
    
 
    [bookmark: pgfId-394293]Status Bar (right side)—Shows the last entry displayed by the discovery process and the possible error message.
 
     
     [bookmark: pgfId-394295]5 
    
 
    [bookmark: pgfId-394297]Fabric pane—Displays a map of the network fabric, including switches, hosts, and storage. It also provides tabs for displaying log and event data.
 
     
     [bookmark: pgfId-394299]6 
    
 
    [bookmark: pgfId-394301]Status Bar (left side)—Shows short-term transient messages, such as the number of rows displayed in a table.
 
     
     [bookmark: pgfId-394303]7 
    
 
    [bookmark: pgfId-394305]Physical Attributes pane—Displays a tree of available configuration tasks depending on the fabric, VSAN, or zone selected previously. Lists the switches and end devices in the logical selection.
 
     
     [bookmark: pgfId-394307]8 
    
 
    [bookmark: pgfId-394309]Logical Domains pane—Displays a tree of configured SAN, fabrics, VSANs, and zones, and provides access to user-defined groups. The label next to the segmented VSAN indicates the number of segments.
 
   
 
    
     
   
 
   
 
   [bookmark: pgfId-394311]Note You can resize each pane by dragging the boundaries between each region or by clicking the Minimize or Maximize controls.
 
    
    
 
   
 
   
 
    
     [bookmark: pgfId-296321]Menu Bar
 
    [bookmark: pgfId-296323]The menu[bookmark: marker-296322] bar at the top of the Cisco DCNM-SAN main window provides options for managing and troubleshooting the current fabric and for controlling the display of information on the Fabric pane. The menu bar provides the following menus:
 
     
     	 [bookmark: pgfId-296324]File—Opens a new fabric, rediscovers the current fabric, locates switches, sets preferences, prints the map, and exports the Fabric pane log.
 
     	 [bookmark: pgfId-296325]View—Changes the appearance of the map (these options are duplicated on the Fabric pane toolbar).
 
     	 [bookmark: pgfId-296326]Zone—Manages zones, zone sets, and inter-VSAN routing (IVR).
 
     	 [bookmark: pgfId-296329]Tools—Verifies and troubleshoots connectivity and configuration, as described in the “Cisco DCNM-SAN Troubleshooting Tools”.
 
     	 [bookmark: pgfId-296331]Performance—Runs and configures Performance Manager and Cisco Traffic Analyzer, and generates reports.
 
     	 [bookmark: pgfId-296332]Server—Runs administrative tasks on clients and fabrics. Provides Cisco DCNM-SAN Server management and a  purge command. Lists fabrics being managed.
 
     	 [bookmark: pgfId-296333]Help—Displays online help topics for specific dialog boxes in the Information pane.
 
    
 
   
 
    
     [bookmark: pgfId-352384]File
 
    [bookmark: pgfId-352412]The file menu provides the following options: 
 
     
     	 [bookmark: pgfId-352392]Open Fabric—Opens a new switch fabric.
 
     	 [bookmark: pgfId-352854]Locate Switches and Devices— Uses the SNMPv2 protocol to discover devices responding to SNMP requests with the read-only community string public. You may use this feature if you want to locate other Cisco MDS 9000 switches in the subnet, but are not physically connected to the fabric.
 
     	 [bookmark: pgfId-352821]Rediscover—Initiates an on-demand discovery to learn recent changes from the switches and update the Cisco DCNM-SAN Client. You may use this option when Cisco DCNM-SAN Server is not in sync with switches in the fabric and you do not want to wait until the next polling cycle. The rediscover option does not delete the fabric and add it again. You may delete and add the fabric only if the rediscover option fails to update Cisco DCNM-SAN Server.
 
     	 [bookmark: pgfId-352442]Resync All Open Fabrics— Cisco DCNM-SAN Server forces all the fabrics to close and re-open. You may use this option when Cisco DCNM-SAN Client is not in sync with Cisco DCNM-SAN Server. 
 
     	 [bookmark: pgfId-352877]Rediscover SCSI Targets— Initiates an on-demand discovery to learn recent changes from the SCSI target switches. You may use this option when Cisco DCNM-SAN Server is not in sync with SCSI target switches in the fabric and you do not want to wait until the next polling cycle.
 
     	 [bookmark: pgfId-352878]Preferences—Sets your preferences to customize the behavior of the Cisco DCNM-SAN Client. 
 
     	 [bookmark: pgfId-352887]Import Enclosures—Imports saved enclosures.
 
     	 [bookmark: pgfId-352888]Export
 
    
 
    [bookmark: pgfId-352891] – Map Image—Generates and export the map to a specified location.
 
    [bookmark: pgfId-352895] – Visio—Exports the map to a Visio file.
 
    [bookmark: pgfId-352896] – Table—Exports the table data to a text file.
 
    [bookmark: pgfId-352897] – Log—Exports the log to a text file.
 
    [bookmark: pgfId-352898] – Events—Exports the events to a text file.
 
    [bookmark: pgfId-352899] – Enclosures—Exports the enclosure values to a text file.
 
     
     	 [bookmark: pgfId-352889]Print —Prints the map.
 
     	 [bookmark: pgfId-352900]Exit—Exit Cisco DCNM-SAN.
 
    
 
   
 
    
     [bookmark: pgfId-352903]View
 
    [bookmark: pgfId-354160]View menu provides the following options: 
 
     
     	 [bookmark: pgfId-352909]Refresh Map—Refreshes the current map.
 
     	 [bookmark: pgfId-352910]Layout
 
    
 
    [bookmark: pgfId-352920] – Cancel—Cancels the current layout.
 
    [bookmark: pgfId-352924] – Spring—Displays the layout based on spring algorithm.
 
    [bookmark: pgfId-352925] – Quick—Quickly displays the layout when the switch has many end devices. 
 
     
     	 [bookmark: pgfId-352914]Zoom
 
    
 
    [bookmark: pgfId-352928] – In—Zooms in the view.
 
    [bookmark: pgfId-352929] – Out—Zooms out the view.
 
    [bookmark: pgfId-352930] – Fit—Fits the view in the fabric pane.
 
     
     	 [bookmark: pgfId-352915]Grid—Enables the grid view.
 
     	 [bookmark: pgfId-352916]Overview Window—Allows you to center the Fabric pane on the area of the fabric that you want to see. This option is useful for large fabrics that cannot be displayed entirely within the Fabric pane.
 
     	 [bookmark: pgfId-352917]Legend—Shows all the legends used in the fabric map.
 
     	 [bookmark: pgfId-352918]Find in Map—Finds a device in the fabric map.
 
    
 
   
 
    
     [bookmark: pgfId-352389]Zone
 
    [bookmark: pgfId-354245]The zone menu provides the following options: 
 
     
     	 [bookmark: pgfId-352943]Edit Local Full Zone Database—Allows you to create zones across multiple switches. Zones provide a mechanism for specifying access control. Zone sets are a group of zones to enforce access control in the fabric. All zoning features are available through the Edit Local Full Zone Database dialog box. 
 
     	 [bookmark: pgfId-353895]Deactivate Zoneset—Deactivates an active zone set.
 
     	 [bookmark: pgfId-353901]Copy Full Zone Database—Creates a new zone set. On the Cisco MDS Family switches, you cannot edit an active zone set. However, you can copy an active zone set to create a new zone set that you can edit.
 
     	 [bookmark: pgfId-352947]Merge Analysis—Enables you to determine if zones will merge successfully when two Cisco MDS switches are interconnected. If the interconnected switch ports allow VSANs with identical names or contain zones with identical names, then Cisco DCNM-SAN verifies that the zones contain identical members. You can use merge analysis tool before attempting a merge, or after fabrics are interconnected to determine zone merge failure causes.
 
     	 [bookmark: pgfId-358172]Merge Fail Recovery—Recovers the port from its isolated state either by importing the neighboring switch's active zone set database and replacing the current active or by exporting the current database to the neighboring switch.
 
     	 [bookmark: pgfId-352940]Migrate Non-MDS Database—Migrate a non-MDS database using Cisco DCNM-SAN (you may need to use the Zone Migration Wizard to accomplish this task).
 
     	 [bookmark: pgfId-353915]IVR
 
    
 
    [bookmark: pgfId-353917] – Deactivate Zoneset—Deactivates an active zone set.
 
    [bookmark: pgfId-353028] – Copy Full Zone Database—Recovers an IVR zone database by copying the IVR full zone database from another switch.
 
    [bookmark: pgfId-353042] – Copy Full Topology—Recovers a topology by copying from the active zone database or the full zone database. 
 
   
 
    
     [bookmark: pgfId-353044]Tools
 
    [bookmark: pgfId-354250]Tools menu provides the following options: 
 
     
     	 [bookmark: pgfId-353048]Health
 
    
 
    [bookmark: pgfId-353059] – Switch Health—Determines the status of the components of a specific switch. 
 
    [bookmark: pgfId-353060] – Fabric Configuration—Analyzes the configuration of a switch by comparing the current configuration to a specific switch or to a policy file. You can save a switch configuration to a file and then compare all switches against the configuration in the file.
 
    [bookmark: pgfId-353061] – Show Tech Support—Collects large amount of information about your switch for troubleshooting purposes. When you issue a show tech support command from Cisco DCNM-SAN for one or more switches in a fabric, the results of each command are written to a text file, one file per switch, in a directory you specify. You can then view these files using Cisco DCNM-SAN.
 
     
     	 [bookmark: pgfId-353067]Connectivity
 
    
 
    [bookmark: pgfId-353068] – End to End Connectivity—Determines connectivity and routes among devices with the switch fabric. This tool checks to see that every pair of end devices can talk to each other, using a Ping test and by determining if they are in the same VSAN or in the same active zone. 
 
    [bookmark: pgfId-354313] – Ping—Determines connectivity from another switch to a port on your switch.
 
    [bookmark: pgfId-354314] – Trace Route—Verifies connectivity between two end devices that are currently selected on the Fabric pane.
 
    [bookmark: pgfId-358159] – Compact Flash Report—Automatically scans the fabric and generate a report that shows the status of CompactFlash.
 
     
     	 [bookmark: pgfId-353087]NPV
 
    
 
    [bookmark: pgfId-353091] – CFS Static Peer Setup—Manage the peer list used during CFS on NPV-enabled switches. After setting up the static peers list, the CFS discovery on the switches will be changed to static mode for all peers in the list. Cisco DCNM-SAN does not automatically update static peers list. You may need to update the list using the CFS Static Peer Setup Wizard when a new switch is added to the fabric.
 
    [bookmark: pgfId-357444] – Traffic Map Setup—Configures the list of external interfaces to the servers, and enabling or disabling disruptive load balancing. Using Traffic Map Setup you can specify the external ports that a server should use for traffic management. 
 
    [bookmark: pgfId-357372] – Flex Attach Pre-Configure Server—Sets the port configurations for all the ports in a switch such as enabling or disabling FlexAttach, setting the default VSAN ID, and setting the interface status.
 
    [bookmark: pgfId-353092] – Flex Attach Move Server—Moves a server to another port on the same NPV device or another NPV device without changing the SAN. 
 
    [bookmark: pgfId-353093] – Flex Attach Replace Server—Replaces a failed server with a new server on the same port without changing the SAN. 
 
     
     	 [bookmark: pgfId-353109]Data Mobility Manager
 
    
 
    [bookmark: pgfId-353110] – Server Based—Performs server-based data migration.
 
    [bookmark: pgfId-353127] – Storage based—Performs storage-based data migration.
 
    [bookmark: pgfId-353128] – Server LUN Discovery—Performs LUN discovery to select the LUNs available for migration and automates the session creation by matching the LUNs in the existing and new storage.
 
     
     	 [bookmark: pgfId-377340]FCoE—Launches the FCoE Configuration Wizard to create virtual Fibre Channel interfaces.
 
     	 [bookmark: pgfId-353126]Port Channel—Creates PortChannels from selected ISL either manually or automatically. 
 
     	 [bookmark: pgfId-354799]DPVM Setup—Establishes dynamic port VSAN membership, enables autolearning, and activates the DPVM database.
 
     	 [bookmark: pgfId-353112]IP SAN
 
    
 
    [bookmark: pgfId-353113] – FCIP Tunnel—Creates FCIP links between Gigabit Ethernet ports. Enables Fibre Channel write acceleration and IP compression.
 
    [bookmark: pgfId-353114] – iSCSI Setup—Creates zones for iSCSI initiators and adds a VSAN to a target-allowed VSAN list.
 
    [bookmark: pgfId-353107] – SAN Extension Tuner—Optimizes FCIP performance by generating either direct access (magnetic disk) or sequential access (magnetic tape) SCSI I/O commands and directing such traffic to a specific virtual target. This option is used to generate SCSI I/O commands (read and write) to the virtual target based on your configured options. 
 
     
     	 [bookmark: pgfId-353514]Security
 
    
 
    [bookmark: pgfId-353515] – Port Security—Prevents unauthorized access to a switch port in the Cisco MDS 9000 Family, rejects intrusion attempts and reports these intrusions to the administrator. 
 
    [bookmark: pgfId-353516] – IP ACL—Creates an ordered list of IP filters in a named IPv4-ACL or IPv6-ACL profile using the IPv4-ACL Wizard.
 
     
     	 [bookmark: pgfId-354808]Install 
 
    
 
    [bookmark: pgfId-354809] – License—Facilitate download and installation of licenses in selected switches in the fabric.
 
    [bookmark: pgfId-354810] – Software—Verifies image compatibility and installs software images on selected switches in the fabric.
 
     
     	 [bookmark: pgfId-354352]Flow Load Balance Calculator —Allows you to get the best load-balancing configuration for your FICON flows. The calculator does not rely on any switch or flow discovery in the fabric. 
 
     	 [bookmark: pgfId-354393]Device Manager—Invokes Device Manager for a switch.
 
     	 [bookmark: pgfId-353553]Command Line Interface —Enables command-line operations.
 
     	 [bookmark: pgfId-353554]Run CLI Commands—Runs command-line operations on more than one switch at a time.
 
    
 
   
 
    
     [bookmark: pgfId-353565]Performance
 
    [bookmark: pgfId-354255]The performance menu provides the following options: 
 
     
     	 [bookmark: pgfId-353566]Create Flows—Creates host-to-storage, storage-to-host, or bidirectional flows. You can add these flows to a collection configuration file to monitor the traffic between a host or storage element pair.
 
    
 
   
 
    
     [bookmark: pgfId-353568]Server
 
    [bookmark: pgfId-354273]The server menu provides the following options: 
 
     
     	 [bookmark: pgfId-353569]Admin—Opens the control panel.
 
     	 [bookmark: pgfId-353570]Purge Down Elements—Purges all down elements in the fabric.
 
    
 
   
 
    
     [bookmark: pgfId-353572]Help
 
    [bookmark: pgfId-354286]The help menu provides the following options: 
 
     
     	 [bookmark: pgfId-353573]Contents —Launches the online help contents.
 
     	 [bookmark: pgfId-355627]Config Guide—Launches the Cisco DCNM-SAN Configuration Guide.
 
     	 [bookmark: pgfId-355628]About—Displays information about Cisco DCNM-SAN.
 
    
 
   
 
    
     [bookmark: pgfId-355778]Toolbar
 
    [bookmark: pgfId-394332]The Cisco DCNM-SAN main toolbar provides[bookmark: marker-355373] icons for accessing the most commonly used menu bar options as shown in Table 10-3.
 
    [bookmark: pgfId-394507]
 
     
     
 
     
 
     
 
     
 
     
 
     
 
     
 
     
 
     
 
     
 
     
 
     
 
     
 
     
 
     
 
     
 
     
 
     
 
     
 
     
 
     
 
     
 
     
 
      
       
       [bookmark: pgfId-394339]Table 10-3 [bookmark: 19686]Cisco DCNM-SAN Client Main Toolbar 
 
       
       
        
        	 
          
          [bookmark: pgfId-394343]Icon 
         
  
        	 
          
          [bookmark: pgfId-394345]Description 
         
  
       
 
       
          
        	[bookmark: pgfId-394352]Opens switch fabric.
  
       
 
       
          
        	[bookmark: pgfId-394359]Rediscovers current fabric.
  
       
 
       
          
        	[bookmark: pgfId-394366]Finds in the map.
  
       
 
       
          
        	[bookmark: pgfId-394373]Creates VSAN.
  
       
 
       
          
        	[bookmark: pgfId-394380]Launches DPVM wizard.
  
       
 
       
          
        	[bookmark: pgfId-394387]Launches Port Security wizard.
  
       
 
       
          
        	[bookmark: pgfId-394394]Edits full zone database.
  
       
 
       
          
        	[bookmark: pgfId-394401]Launches IVR zone wizard.
  
       
 
       
          
        	[bookmark: pgfId-394408]Launches the FCoE configuration wizard.
  
       
 
       
          
        	[bookmark: pgfId-394415]Launches PortChannel wizard.
  
       
 
       
          
        	[bookmark: pgfId-394422]Launches FCIP wizard.
  
       
 
       
          
        	[bookmark: pgfId-394429]Launches iSCSI wizard.
  
       
 
       
          
        	[bookmark: pgfId-394436]Launches NPVM wizard.
  
       
 
       
          
        	[bookmark: pgfId-394443]Launches QoS wizard.
  
       
 
       
          
        	[bookmark: pgfId-394450]Configures users and roles.
  
       
 
       
          
        	[bookmark: pgfId-394457]Launches IP-ACL wizard.
  
       
 
       
          
        	[bookmark: pgfId-394464]Launches License Install wizard.
  
       
 
       
          
        	[bookmark: pgfId-394471]Launches Software Install wizard.
  
       
 
       
          
        	[bookmark: pgfId-394478]Performs switch health analysis.
  
       
 
       
          
        	[bookmark: pgfId-394485]Performs fabric configuration analysis.
  
       
 
       
          
        	[bookmark: pgfId-394492]Performs end-to-end connectivity analysis.
  
       
 
       
          
        	[bookmark: pgfId-394499]Monitors ISL performance. Brings up real-time ISL performance information for all interfaces in the fabric, in the Information pane.
  
       
 
       
          
        	[bookmark: pgfId-394506]Shows online help.
  
       
 
       
     
 
    
 
   
 
    
     [bookmark: pgfId-344670]Logical Domains Pane
 
    [bookmark: pgfId-381701]Use the Logical Domains pane to manage attributes for fabrics, VSANs, and zones, and to access user-defined groups. Starting from NX-OS Release 4.2(0), SAN and LAN nodes are listed under Datacenter node and all the fabrics are listed under SAN node. When you select Datacenter node in the tree, Cisco DCNM-SAN displays all the switches and ISLs. When you select LAN node, Cisco DCNM-SAN displays only Ethernet switches and Ethernet links. Under the fabric node, VSANs are ordered by a VSAN ID. The segmented VSANs are placed under the fabric node. The label next to the segmented VSAN indicates the number of segments. You can expand a segmented VSAN and the segments under that VSAN. Right-click one of the folders in the tree and click a menu item from the pop-up menu. You see the appropriate configuration dialog box. 
 
    [bookmark: pgfId-344672]The default name for the fabric is the name, IP address, or WWN for the principal switch in VSAN 1. If VSAN 1 is segmented, the default name is chosen from a principal switch with the smallest WWN. The fabric names you see are as follows:
 
     
     	 [bookmark: pgfId-344673]Fabric <sysName>
 
     	 [bookmark: pgfId-344674]Fabric <ipAddress>
 
     	 [bookmark: pgfId-344675]Fabric <sWWN>
 
    
 
    [bookmark: pgfId-344676]You can change the fabric name using Cisco DCNM-SAN.
 
   
 
    
     [bookmark: pgfId-398557]DETAILED STEPS
 
    
 
    [bookmark: pgfId-344677]Step 1 Choose Server > Admin.
 
    [bookmark: pgfId-344678]You see the Control Panel dialog box.
 
    [bookmark: pgfId-344679]Step 2 Double-click the fabric name and enter the new name of the fabric.
 
    [bookmark: pgfId-344680]Step 3 Click Apply to change the name.
 
    [bookmark: pgfId-394512]
 
     
     
 
    
 
    
 
   
 
    
     [bookmark: pgfId-344683]Filtering[bookmark: marker-344682]
 
    [bookmark: pgfId-344684]Cisco DCNM-SAN has a filtering mechanism that displays only the data that you are interested in. To filter, first select the fabric and VSAN from the Logical Domains pane. This action narrows the scope of what is displayed in the Fabric pane. Any information that does not belong to the selected items is dimmed. Also, any information that does not belong to the selected items is not displayed in the tables in the Information pane. The filter that you select is displayed at the top right of the Cisco DCNM-SAN window.
 
    [bookmark: pgfId-344688]To further narrow the scope, select attributes from the Physical Attributes pane. The Cisco DCNM-SAN table, display, and filter criteria change accordingly.
 
   
 
    
     [bookmark: pgfId-344690]Physical [bookmark: marker-344689]Attributes Pane
 
    [bookmark: pgfId-344691]Use the Physical Attributes pane to display a tree of the options available for managing the switches in the currently selected fabric, VSAN, or zone. 
 
    [bookmark: pgfId-344692]To select an option, click a folder to display the options available and then click the option. You see the table with information for the selected option in the Information pane. The Physical Attributes pane provides the following main folders:
 
     
     	 [bookmark: pgfId-344693]Switches—Views and configures hardware, system, licensing, and configuration files.
 
     	 [bookmark: pgfId-344694]Interfaces—Views and configures FC physical, FC logical, VFC (FCoE), Ethernet, SVC, and PortChannel interfaces.
 
     	 [bookmark: pgfId-344695]FC Services—Views and configures Fibre Channel network configurations.
 
     	 [bookmark: pgfId-344696]IP—Views and configures IP storage and IP services.
 
     	 [bookmark: pgfId-344698]Security—Views and configures MDS management and FC-SP security.
 
     	 [bookmark: pgfId-377387]FCoE—Views and configures FCoE interfaces.
 
     	 [bookmark: pgfId-344699]ISLs—Views and configures Inter-Switch Links.
 
     	 [bookmark: pgfId-347196]End Devices—Views and configures end devices.
 
    
 
     
      
    
 
    
 
    [bookmark: pgfId-360210]Note You cannot view the detailed physical attributes of the data center switches or monitor the connections. When you select either a data center node or a LAN node the physical attributes pane will be blank.
 
     
     
 
    
 
    
 
   
 
    
     [bookmark: pgfId-347365]Context Menu for Tables
 
    [bookmark: pgfId-347366]When you right-click in the table, you see a pop-up menu with options that vary depending on the type of option you selected in the Physical Attributes pane. You can perform various operations by right-clicking the device listed in the table. To view various options available for switches, ISLs, and end devices, refer to the procedures in the sections that follows:
 
   
 
    
     [bookmark: pgfId-347431]Viewing Switch Options
 
    [bookmark: pgfId-347458]When you select the datacenter node, the switch table displays all the switches that are discovered. When you select the SAN node or the fabric node, the switch table displays all the Fibre Channel switches and when you select the LAN node, the switch table displays all the Ethernet switches. 
 
   
 
    
     [bookmark: pgfId-360323]DETAILED STEPS
 
    
 
    [bookmark: pgfId-347894]Step 1 Click Switches in the Physical Attributes pane.
 
    [bookmark: pgfId-347896]Step 2 Right-click the device in the table. 
 
    [bookmark: pgfId-347898]The pop-up menu provides the following options:
 
     
     	 [bookmark: pgfId-347568]Apply Changes—Applies the changes to the switch.
 
     	 [bookmark: pgfId-347663]Refresh Values—Refreshes the current values.
 
     	 [bookmark: pgfId-347668]Undo Changes—Undoes modifications to the switch.
 
     	 [bookmark: pgfId-347694]Export to File—Export the values to a file.
 
     	 [bookmark: pgfId-347707]Print Table—Prints the table.
 
     	 [bookmark: pgfId-347720]Detach Table—Detaches the table.
 
     	 [bookmark: pgfId-347658]Switch Attributes—Changes the switch properties.
 
     	 [bookmark: pgfId-365218]Interface Attributes—Changes the interface properties.
 
     	 [bookmark: pgfId-365219]Element Manager—Manages this switch.
 
     	 [bookmark: pgfId-365220]Command Line Interface—Enables to perform command line operations.
 
     	 [bookmark: pgfId-347462]Copy—Copies the switch.
 
     	 [bookmark: pgfId-347463]Purge—Purges the switch.
 
     	 [bookmark: pgfId-347464]Fix Location—Fixes the switch in the current location.
 
     	 [bookmark: pgfId-347465]Align—Aligns the switch.
 
     	 [bookmark: pgfId-347466]Show End Devices—Shows the end devices.
 
     	 [bookmark: pgfId-347467]Expand Multiple Links—Expands the links to this switch.
 
     	 [bookmark: pgfId-347468]Other—Other options.
 
     	 [bookmark: pgfId-360268]Group—Groups switches.
 
    
 
    [bookmark: pgfId-360269]
 
     
     
 
    
 
    
 
   
 
    
     [bookmark: pgfId-360270]Viewing ISL Options
 
    [bookmark: pgfId-347737]When you select the data center node, the ISLs table displays all of the Fibre Channel and Ethernet links. When you select the LAN node, the ISLs table displays all the Ethernet links. 
 
   
 
    
     [bookmark: pgfId-360334]DETAILED STEPS
 
    
 
    [bookmark: pgfId-347855]Step 1 In the Physical Attributes pane, click ISLs and then click Summary tab. 
 
    [bookmark: pgfId-347859]Step 2 Right-click the device in the table. 
 
    [bookmark: pgfId-347860]The pop-up menu provides the following options:
 
     
     	 [bookmark: pgfId-347739]Refresh Values—Refreshes the current values.
 
     	 [bookmark: pgfId-350535]Copy—Copies information from a specific field.
 
     	 [bookmark: pgfId-347741]Find—Conducts search based on the input string.
 
     	 [bookmark: pgfId-350547]Export to File—Exports the values to a file.
 
     	 [bookmark: pgfId-347742]Print Table—Prints the table.
 
     	 [bookmark: pgfId-347743]Detach Table—Detaches the table.
 
     	 [bookmark: pgfId-347745]Interface Attributes—Changes the interface properties.
 
     	 [bookmark: pgfId-347746]Element Manager—Manages the device.
 
     	 [bookmark: pgfId-347999]FCIP Tunnel Attributes—Changes FCIP tunneling properties.
 
     	 [bookmark: pgfId-348000]Create Port Channel—Creates port channel.
 
     	 [bookmark: pgfId-348024]Re-enable—Reenables a disabled device.
 
     	 [bookmark: pgfId-348002]Enable FC-SP—Enables FC-SP.
 
     	 [bookmark: pgfId-347752]SAN Extention Tuner—Optimizes FCIP performance.
 
     	 [bookmark: pgfId-347648]Purge—Purges the device.
 
    
 
     
      
    
 
    
 
    [bookmark: pgfId-348059]Note When you select a port channel from the table, the pop-up menu will have the following additional options:
 
     
     	 [bookmark: pgfId-348114]Member Attributes—Changes the member properties.
 
     	 [bookmark: pgfId-348212]Channel Attributes—Changes the port channel properties.
 
     	 [bookmark: pgfId-348213]Edit—Edits the channel properties.
 
    
 
    [bookmark: pgfId-348214]
 
     
     
 
    
 
    
 
   
 
    
     [bookmark: pgfId-347883]Viewing End Device Options
 
   
 
    
     [bookmark: pgfId-348257]DETAILED STEPS 
 
    
 
    [bookmark: pgfId-348293]Step 1 In the Physical Attributes pane, click End Devices and then click the Summary tab. 
 
    [bookmark: pgfId-348373]Step 2 Right-click the device in the table.
 
    [bookmark: pgfId-348379]The pop-up menu provides the following options:
 
     
     	 [bookmark: pgfId-348477]Apply Changes—Applies the changes to the device.
 
     	 [bookmark: pgfId-348381]Refresh Values—Refreshes the current values.
 
     	 [bookmark: pgfId-350557]Copy—Copies the information specific to the field.
 
     	 [bookmark: pgfId-350558]Paste—Pastes the copied text.
 
     	 [bookmark: pgfId-348382]Undo Changes—Undoes modifications to the device.
 
     	 [bookmark: pgfId-350567]Find—Searches for information depending on the input string.
 
     	 [bookmark: pgfId-348383]Export to File—Exports the values to a file.
 
     	 [bookmark: pgfId-348384]Print Table—Prints the table.
 
     	 [bookmark: pgfId-348385]Detach Table—Detaches the table.
 
     	 [bookmark: pgfId-348386]Device Attributes—Changes the device properties.
 
     	 [bookmark: pgfId-348387]Interface Attributes—Changes the interface properties.
 
     	 [bookmark: pgfId-348388]Element Manager—Manages this device.
 
     	 [bookmark: pgfId-348389]Command Line Interface—Enables you to perform command line operations.
 
     	 [bookmark: pgfId-348390]Copy—Copies the switch.
 
     	 [bookmark: pgfId-348391]Purge—Purges the switch.
 
     	 [bookmark: pgfId-348392]Fix Location—Fixes the switch in the current location.
 
     	 [bookmark: pgfId-348393]Align—Aligns the switch.
 
     	 [bookmark: pgfId-348394]Ping—Pings another device.
 
     	 [bookmark: pgfId-348395]Trace Route—Determines the route taken by packets across the network.
 
     	 [bookmark: pgfId-348396]Select Dependent Ports—Selects dependent ports.
 
     	 [bookmark: pgfId-348397]Group—Groups devices.
 
    
 
   
 
    
     [bookmark: pgfId-347199]Information [bookmark: marker-347198]Pane
 
    [bookmark: pgfId-394525]Use the Information pane to display tables of information associated with the option selected from the menu tree in the Logical Domains or Physical Attributes panes. The Information pane toolbar provides buttons for performing one or more of the operations shown in Table 10-4.
 
    [bookmark: pgfId-394619]
 
     
     
 
     
 
     
 
     
 
     
 
     
 
     
 
     
 
     
 
     
 
     
 
      
       
       [bookmark: pgfId-394535]Table 10-4 [bookmark: 47737]Information Pane Toolbar 
 
       
       
        
        	 
          
          [bookmark: pgfId-394539]Icon 
         
  
        	 
          
          [bookmark: pgfId-394541]Description 
         
  
       
 
       
          
        	[bookmark: pgfId-394548]Applies configuration changes.
  
       
 
       
          
        	[bookmark: pgfId-394555]Refreshes table values.
  
       
 
       
          
        	[bookmark: pgfId-394562]Opens the appropriate dialog box to make a new row in the table.
  
       
 
       
          
        	[bookmark: pgfId-394569]Deletes the currently highlighted rows from the table.
  
       
 
       
          
        	[bookmark: pgfId-394576]Copies data from one row to another.
  
       
 
       
          
        	[bookmark: pgfId-394583]Pastes the data from one row to another.
  
       
 
       
          
        	[bookmark: pgfId-394590]Undoes the most recent change.
  
       
 
       
          
        	[bookmark: pgfId-394597]Finds a specified string in the table.
  
       
 
       
          
        	[bookmark: pgfId-394604]Exports and saves information to a file.
  
       
 
       
          
        	[bookmark: pgfId-394611]Prints the contents of the Information pane.
  
       
 
       
          
        	[bookmark: pgfId-394618]Displays a non-editable copy of the table in the Information pane in its own window, which you can move around the screen.
  
       
 
       
     
 
    
 
     
      
    
 
    
 
    [bookmark: pgfId-344792]Note After making changes, you must save the configuration or the changes will be lost when the device is restarted. 
 
     
     
 
    
 
    
 
     
      
    
 
    
 
    [bookmark: pgfId-344793]Note The buttons that appear on the toolbar vary according to the option that you select. They are activated or deactivated (dimmed) according to the field or other object that you select in the Information pane.
 
     
     
 
    
 
    
 
   
 
    
     [bookmark: pgfId-344795]Detachable Tables[bookmark: marker-344794]
 
    [bookmark: pgfId-344796]Detachable tables in Cisco DCNM-SAN allow you to detach tables and move them to different areas on your desktop so that you can compare similar tables from different VSANs. You can keep informational tables open from one view while you examine a different area in Cisco DCNM-SAN. To detach tables, click the Detach Table icon in the Information pane in Cisco DCNM-SAN.
 
   
 
    
     [bookmark: pgfId-344797]Fabric Pane
 
    [bookmark: pgfId-394628]Use the Fabric pane to display the graphical representation of your fabric. Table 10-5 explains the graphics you may see displayed, depending on[bookmark: marker-394627] which devices you have in your fabric.
 
    [bookmark: pgfId-394803]
 
     
     
 
     
 
     
 
     
 
     
 
     
 
     
 
     
 
     
 
     
 
     
 
     
 
     
 
     
 
     
 
     
 
     
 
     
 
     
 
     
 
     
 
     
 
     
 
      
       
       [bookmark: pgfId-394635]Table 10-5 [bookmark: 1171]Cisco DCNM-SAN Graphics 
 
       
       
        
        	 
          
          [bookmark: pgfId-394639]Icon or Graphic 
         
  
        	 
          
          [bookmark: pgfId-394641]Description 
         
  
       
 
       
          
        	[bookmark: pgfId-394648]Director class MDS 9000 Fibre Channel switch.
  
       
 
       
          
        	[bookmark: pgfId-394655]Non-director class MDS 9000 Fibre Channel switch.
  
       
 
       
          
        	[bookmark: pgfId-394662]Nexus 7000 switch.
  
       
 
       
          
        	[bookmark: pgfId-394669]Nexus FCoE or Fibre Channel switch.
  
       
 
       
          
        	[bookmark: pgfId-394676]Catalyst LAN switch.
  
       
 
       
          
        	[bookmark: pgfId-394683]Generic Fibre Channel switch.
  
       
 
       
          
        	[bookmark: pgfId-394690]Cisco SN5428.
  
       
 
       
          
        	[bookmark: pgfId-394697]Dashed or dotted orange line through a device indicates that the device is manageable but there are operational problems.
  
       
 
       
          
        	[bookmark: pgfId-394704]Dashed or dotted orange X through a device or link indicates that the device or ISL is not working properly.
  
       
 
       
          
        	[bookmark: pgfId-394711]A red line through a device indicates that the device is not manageable.
  
       
 
       
          
        	[bookmark: pgfId-394718]A red X through a device or link indicates that the device is down or that the ISL is down.
  
       
 
       
          
        	[bookmark: pgfId-394725]Fibre Channel HBA (or enclosure).
  
       
 
       
          
        	[bookmark: pgfId-394732]Fibre Channel target (or enclosure).
  
       
 
       
          
        	[bookmark: pgfId-394739]iSCSI host.
  
       
 
       
          
        	[bookmark: pgfId-394746]Fibre Channel ISL and edge connection.
  
       
 
       
          
        	[bookmark: pgfId-394753]Fibre Channel PortChannel.
  
       
 
       
          
        	[bookmark: pgfId-394760]IP ISL and edge connection.
  
       
 
       
          
        	[bookmark: pgfId-394767]IP PortChannel.
  
       
 
       
          
        	[bookmark: pgfId-394774]DWDM connection.
  
       
 
       
          
        	[bookmark: pgfId-394781]NPV connection.
  
       
 
       
          
        	[bookmark: pgfId-394788]Fibre Channel loop (storage).
  
       
 
       
          
        	[bookmark: pgfId-394795]IP cloud (hosts). This icon is also used to represent a fabric when viewing a SAN (multiple fabrics) in the Cisco DCNM-SAN Fabric pane.
  
       
 
       
          
        	[bookmark: pgfId-394802]Any device, cloud, or loop with a box around it means that there are hidden links attached.
  
       
 
       
     
 
    
 
    [bookmark: pgfId-344957]If a switch or director is grayed out, Cisco DCNM-SAN can no longer communicate with it.
 
    [bookmark: pgfId-344959]The bottom of the Fabric pane has the following [bookmark: marker-344958]tabs:
 
     
     	 [bookmark: pgfId-344960]Fabric—When displaying multiple fabrics, each fabric has its own tab. You can switch between fabrics by clicking on their respective tabs.
 
     	 [bookmark: pgfId-344961]Log—Displays messages that describe Cisco DCNM-SAN operations, such as fabric discovery.
 
    
 
    [bookmark: pgfId-344964]When viewing [bookmark: marker-344963]large fabrics in the Fabric pane, it is helpful to do the following tasks:
 
     
     	 [bookmark: pgfId-344965]Turn off end device labels.
 
     	 [bookmark: pgfId-344966]Collapse loops.
 
     	 [bookmark: pgfId-344967]Collapse expanded multiple links (collapsed multiple links are shown as very thick single lines).
 
     	 [bookmark: pgfId-344968]Dim or hide portions of your fabric by VSAN.
 
    
 
     
      
    
 
    
 
    [bookmark: pgfId-344970]Note When a VSAN, zone, or zone member is selected in the VSAN tree, the [bookmark: marker-344969]map highlighting changes to identify the selected objects. To remove this highlighting, click the Clear Highlight button on the Fabric pane toolbar or choose Clear Highlight from the pop-up menu.
 
     
     
 
    
 
    
 
   
 
    
     [bookmark: pgfId-344971]Context Menus
 
    [bookmark: pgfId-344972]When you right-click an icon in the Fabric pane, you see a pop-up menu with options that vary depending on the type of icon selected. The various options available for different objects include the following:
 
     
     	 [bookmark: pgfId-344973]Open an instance of Device Manager for the selected switch.
 
     	 [bookmark: pgfId-344974]Open a CLI session for the selected switch.
 
     	 [bookmark: pgfId-344975]Copy the display name of the selected object.
 
     	 [bookmark: pgfId-344976]Execute a  ping or  traceroute command for the device.
 
     	 [bookmark: pgfId-344977]Show or hide end devices.
 
     	 [bookmark: pgfId-344978]View attributes.
 
     	 [bookmark: pgfId-344979]Quiesce and disable members for PortChannels.
 
     	 [bookmark: pgfId-344980]Set the trunking mode for an ISL.
 
     	 [bookmark: pgfId-344981]Create or add to a PortChannel for selected ISLs.
 
    
 
    [bookmark: pgfId-344982]The Fabric pane has its own toolbar with options for saving, printing, and changing the appearance of the map. When you right-click the map, a pop-up menu appears that provides options (duplicated on the toolbar) for changing the appearance of the map.
 
     
      
    
 
    
 
    [bookmark: pgfId-344983]Note You can launch web-based or non-web-based applications from the Fabric pane. To do this, you assign an IP address to the storage port or enclosure. Then right-click to bring up the pop-up menu, and select Device Manager.
 
     
     
 
    
 
    
 
   
 
    
     [bookmark: pgfId-344984]Saving the Map
 
    [bookmark: pgfId-344986]You can save the [bookmark: marker-344985]map in the Fabric Pane as an image, or as an editable Visio diagram. You can save the map with or without labels on the links. The created Visio diagram is editable and saved in two layers:
 
     
     	 [bookmark: pgfId-344987]The default layer includes all switches and links in the fabric.
 
     	 [bookmark: pgfId-344988]The end devices layer includes the end devices and can be turned off to remove end devices from the Visio diagram.
 
    
 
    [bookmark: pgfId-344991]To save the [bookmark: marker-344989]map as a [bookmark: marker-344990]Visio diagram, choose Files > Export > Visio and choose Map or Map with link labels. The saved Visio diagram retains the viewing options that you selected from the Fabric pane. For example, if you collapse multiple links in the map and export the links as a Visio diagram, the Visio diagram shows those multiple links as one solid link.
 
    [bookmark: pgfId-344992]The Show Tech Support option from the Tools menu also supports saving the map as a Visio diagram.
 
   
 
    
     [bookmark: pgfId-344993]Purging Down Elements
 
    [bookmark: pgfId-344995]The Fabric pane allows you to refresh the [bookmark: marker-344994]map at any time by clicking the Refresh Map icon. The Refresh Map icon redraws the map but does not [bookmark: marker-344996]purge elements that are down. To purge down elements you can:
 
     
     	 [bookmark: pgfId-344997]Choose Server > Purge Down Elements. This purges all down elements in the fabric.
 
     	 [bookmark: pgfId-344998]Right-click the  Fabric pane and choose Purge Down Elements.
 
     	 [bookmark: pgfId-344999]Right-click a down element and choose Purge. This action purges only this element from the fabric.
 
    
 
     
      
    
 
    
 
    [bookmark: pgfId-345000]Note If you select an element that is not down and purge it, that element will reappear on the next fabric discovery cycle.
 
     
     
 
    
 
    
 
   
 
    
     [bookmark: pgfId-345001]Multiple Fabric Display
 
    [bookmark: pgfId-345005]Cisco DCNM-SAN can display multiple fabrics in the same pane as shown in Figure 10-3.
 
    [bookmark: pgfId-406061]Figure 10-3 [bookmark: 63407]Cisco DCNM-SAN’s Multiple Fabric Display Window
 
    [bookmark: pgfId-406065]
 
     
     [image: ] 
    
 
     
     [bookmark: pgfId-406072]2 
    
 
    [bookmark: pgfId-406074]The Fabric view tab for fabric 172.23.46.153. When selected, the Fabric view displays fabric 172.23.46.153.
 
     
     [bookmark: pgfId-406076]3 
    
 
    [bookmark: pgfId-406078]SAN tab (selected), showing two fabrics.
 
   
 
   [bookmark: pgfId-345017]The information for both fabrics is displayed; you do not need to select a seed switch. To see details of a fabric, select the tab for that fabric at the bottom of the Fabric pane, or double-click the Cloud icon for the fabric in the SAN tab.
 
    
     
   
 
   
 
   [bookmark: pgfId-345018]Note Enclosure names should be unique. If the same enclosure name is used for each port, Cisco DCNM-SAN shows a host/target enclosure connected to both fabrics. To fix this problem, you can either disable auto-creation or create unique enclosure names.
 
    
    
 
   
 
   
 
    
     [bookmark: pgfId-345019]Filtering by Groups
 
    [bookmark: pgfId-345021]You can filter the Fabric pane display by creating [bookmark: marker-345020]groups of switches or end ports. 
 
   
 
    
     [bookmark: pgfId-398630]DETAILED STEPS
 
    
 
    [bookmark: pgfId-345022]Step 1 Right-click a switch or end port in the Fabric pane map and select Group > Create. 
 
    [bookmark: pgfId-345026]You see the Edit User Defined Group dialog box as shown in Figure 10-4. 
 
    [bookmark: pgfId-406093]Figure 10-4 [bookmark: 52125]Edit User Defined Group Dialog Box
 
    [bookmark: pgfId-406097]
 
     
     [image: ] 
    
 
    [bookmark: pgfId-345033]Step 2 Enter a group name in the Name field. 
 
    [bookmark: pgfId-351267]Step 3 Use the arrows to move additional switches or end ports from the Available column to the Selected column.
 
    [bookmark: pgfId-345035]Step 4 Click OK to save the group.
 
    [bookmark: pgfId-345036]
 
     
     
 
    
 
    
 
    [bookmark: pgfId-345037]To add a switch or end port to an existing group in Cisco DCNM-SAN.
 
   
 
    
     [bookmark: pgfId-398664]DETAILED STEPS
 
    
 
    [bookmark: pgfId-345038]Step 1 Right-click a switch or end device and select Group > Add To > YourGroupName. 
 
    [bookmark: pgfId-345042]You see the Edit User Defined Group dialog box.
 
    [bookmark: pgfId-345043]Step 2 Use the arrows to move additional switches or end ports from the Available column to the Selected column.
 
    [bookmark: pgfId-345044]Step 3 Click OK to save the updated group.
 
    [bookmark: pgfId-345045]
 
     
     
 
    
 
    
 
    [bookmark: pgfId-345046]To filter the display by a group you have created.
 
   
 
    
     [bookmark: pgfId-398728]DETAILED STEPS
 
    
 
    [bookmark: pgfId-345047]Step 1 Expand the Groups folder in the Logical Domains pane. 
 
    [bookmark: pgfId-345058]Step 2 Click the name of the group that you want to filter.
 
    [bookmark: pgfId-345059]In the Fabric pane, the switches or end devices in your group are shown normally; all other switches and end devices are shown in gray.
 
    [bookmark: pgfId-345060]Step 3 Click the Groups folder in the Logical Domains pane to return the display to normal.
 
     
      
    
 
    
 
    [bookmark: pgfId-350690]Note User-defined groups tables are filtered based on switches in the group except for switches where CFS-controlled features are enabled when all CFS member switches are displayed to avoid misconfigurations.
 
     
     
 
    
 
    
 
    [bookmark: pgfId-394850]
 
     
     
 
    
 
    
 
   
 
    
     [bookmark: pgfId-296873]Status Bar
 
    [bookmark: pgfId-296875]The status bar[bookmark: marker-296874] at the bottom of the Cisco DCNM-SAN window shows the last entry displayed by the discovery process, and the possible error message on the right side. The status bar displays a message stating that something has changed in the fabric and a new discovery is needed. The status bar shows both short-term, transient messages (such as the number of rows displayed in the table) and long-term discovery issues.
 
   
 
    
     [bookmark: pgfId-381726][bookmark: 62032]Launching Cisco DCNM-SAN Client
 
    [bookmark: pgfId-394855]As of Cisco SAN-OS 3.x and NX-OS Release 4.x, the Fabric Manager Client login procedure has changed.
 
     
      [bookmark: pgfId-394862]Launching Fabric Manager Client in Cisco SAN-OS Release 3.2(1) and Later
 
     [bookmark: pgfId-394863]You can launch Fabric Manager Client.
 
      
       
     
 
     
 
     [bookmark: pgfId-394864]Note Network administrators must initially launch Cisco DCNM-SAN Client using Cisco DCNM-SAN Web Server, as described in the following procedure. Once an administrator has installed the Cisco DCNM-SAN Client icon on your desktop, you can double-click the icon to launch the Cisco DCNM-SAN Client.
 
      
      
 
     
 
     
 
    
 
     
      [bookmark: pgfId-398760]DETAILED STEPS
 
     
 
     [bookmark: pgfId-394865]Step 1 Open your browser and enter the IP address where you installed Cisco DCNM-SAN Server, or enter localhost if you installed Cisco DCNM-SAN Server on your local workstation. 
 
     [bookmark: pgfId-394866]You see the Cisco DCNM Web Client Login dialog box.
 
     [bookmark: pgfId-394871]Step 2 Enter your user name and password and click Login.
 
     [bookmark: pgfId-394872]You see the Cisco DCNM Web Client Summary page.
 
     [bookmark: pgfId-394873]Step 3 Click the Download link in the upper right corner of the page.
 
     [bookmark: pgfId-394874]You see the Download page for Cisco DCNM-SAN and Device Manager.
 
     [bookmark: pgfId-394879]Step 4 Click the link for Cisco DCNM-SAN.
 
     [bookmark: pgfId-394880]If you are launching Cisco DCNM-SAN Client for the first time, you see a message asking whether you want to create shortcuts for Cisco DCNM-SAN.
 
     [bookmark: pgfId-406147]Figure 10-5 DCNM-SAN Create Shortcut(s) Message
 
      
      [image: ] 
     
 
     [bookmark: pgfId-394885]Step 5 Click Yes to create shortcuts for Cisco DCNM-SAN.
 
      
       
     
 
     
 
     [bookmark: pgfId-394886]Note This message only appears the first time you launch Cisco DCNM-SAN Client. If you select No, your selection will be remembered and you will not be prompted to make a selection again. In this case, you will need to launch Cisco DCNM-SAN Client using the Cisco DCNM-SAN Web Client.
 
      
      
 
     
 
     
 
     [bookmark: pgfId-394887]Step 6 When the software is installed and icons are created on your desktop, double-click the Cisco DCNM-SAN icon to launch Cisco DCNM-SAN.
 
     [bookmark: pgfId-394894]Step 7 Enter the Cisco DCNM-SAN Server user name and password.
 
     [bookmark: pgfId-394895]Step 8 Check the Use SNMP Proxy check box if you want Cisco DCNM-SAN Client to communicate with Cisco DCNM-SAN Server through a TCP-based proxy server.
 
     [bookmark: pgfId-394896]Step 9 Click Login. Once you successfully log in to Cisco DCNM-SAN Server, you can set the seed switch and open the fabrics that you are entitled to access.
 
      
       
     
 
     
 
     [bookmark: pgfId-394897]Note When you launch Cisco DCNM-SAN Client for the first time or when there are no available fabrics, you see the Discover New Fabric dialog box.
 
      
      
 
     
 
     
 
      
       
     
 
     
 
     [bookmark: pgfId-394904]Note Only network administrators can discover new fabrics.
 
      
      
 
     
 
     
 
      
       
     
 
     
 
     [bookmark: pgfId-441224]Note Even when remote AAA server authentication is enabled on the switch, use the local switch account that is not defined in the remote AAA server for fabric discovery. In other words, when a user is not found in the remote AAA server, then local switch user authentication will be allowed by the switch for SNMPv3 clients like DCNM.
 
      
      
 
     
 
     
 
     [bookmark: pgfId-394905]Step 10 Click the Ethernet (CDP) radio button to discover using Cisco Discovery Protocol (CDP).
 
     [bookmark: pgfId-394906]Step 11 Starting from NX-OS Release 4.2(0), Fabric Manager uses Cisco Discovery Protocol to discover Ethernet switches such as Nexus 5000, Nexus 7000, Catalyst 4000, and Catalyst 6000 switches. You need to use a CDP seed switch for a CDP discovery. 
Set the fabric seed switch to the Cisco MDS 9000 Family switch or Cisco Nexus 5000 Series that you want Fabric Manager to use. 
 
     [bookmark: pgfId-394910]Step 12 Choose the Auth-Privacy option according to the privacy protocol you have configured on your switch:
 
     [bookmark: pgfId-394911] a. If you have not configured the switch with a privacy protocol, then choose Auth-Privacy option MD5 (no privacy). 
 
     [bookmark: pgfId-394912] b. If you have configured the switch with your privacy protocol, choose your Auth-Privacy choice.
 
      
       
     
 
     
 
     [bookmark: pgfId-394913]Note You may use SNMP v2 credentials for CDP discovery as the most of the Catalyst switches do not use MD5-DES for configuration.
 
      
      
 
     
 
     
 
      
       
     
 
     
 
     [bookmark: pgfId-394914]Note If you want a clean fabric discovery, remove the fabric and rediscover it. If you want a clean LAN discovery, unmanage LAN, remove the CDP seed switch and then rediscover it.
 
      
      
 
     
 
     
 
     [bookmark: pgfId-394915]Step 13 Enter the username and password for the switch.
 
     [bookmark: pgfId-394916]Step 14 (Optionsl) To limit the discovery, specify the VSAN range. 
Scoping limits the resources discovered by Cisco DCNM-SAN client. You can either include a range of VSANs to be discovered or exclude a range of VSANs from being discovered.
 
     [bookmark: pgfId-394917] a. To limit the discovery to a range of VSANs, click Included VSAN List radio button. Specify the range of VSANs.
 
     [bookmark: pgfId-394918] b. To exclude a range of VSANs from being discovered, click Excluded VSAN List radio button. Specify the range of VSANs to be excluded.
 
     [bookmark: pgfId-394919]Step 15 Click Discover.
 
     [bookmark: pgfId-380138]You see the included and excluded VSANs list under the Fabric tab.
 
      
       
     
 
     
 
     [bookmark: pgfId-395032]Note You see a message in the dialog box when the server and client are running on the same workstation and there are unlicensed fabrics in the database. You also see a message when there are unmanaged fabrics (the state of the licenses is unknown).
 
      
      
 
     
 
     
 
      
       
     
 
     
 
     [bookmark: pgfId-395033]Note In the open tab, you see all the discovered fabrics displayed in the control panel. You need to click on the Open button to see all the discovered Ethernet switches.
 
      
      
 
     
 
     
 
     [bookmark: pgfId-395034]Step 16 Check the check box(es) next to the fabric(s) you want to open in the Select column, or click Discover to add a new fabric.
 
      
       
     
 
     
 
     [bookmark: pgfId-395035]Note Only network administrators can continuously manage or unmanage fabrics. For more information, see the “Selecting a Fabric to Manage Continuously” section.
 
      
      
 
     
 
     
 
     [bookmark: pgfId-395039]Step 17 Click Open to open the selected fabric(s).
 
      
       
     
 
     
 
     [bookmark: pgfId-395040]Note • If you have an incomplete view of your fabric, rediscover the fabric with a user that has no 
 VSAN restriction.
 • If the fabric includes a Cisco Nexus 5000 Series switch, then the Layer 2 node appears under 
 the Switches > Interfaces > Ethernet tree, the VFC (FCoE) node appears under the 
 Switches > Interfaces tree, and the FCoE node appears under the Switches tree in the 
 Physical Attributes pane.
 • For Cisco Nexus 5000 Series switches in the fabric, the tooltip for the switch shows the bind
 information of a virtual Fibre Channel interface to its corresponding Ethernet interface, such
 as vfc2(eth1/4).
 
      
      
 
     
 
     
 
     [bookmark: pgfId-395047]
 
      
      
 
     
 
     
 
     [bookmark: pgfId-395048]You can launch Cisco DCNM-SAN Client from within a running instance of Cisco DCNM-SAN.
 
    
 
     
      [bookmark: pgfId-398849]DETAILED STEPS
 
     
 
     [bookmark: pgfId-395049]Step 1 Choose File > Open or click the Open Switch Fabric icon on the Cisco DCNM-SAN toolbar. 
 
     [bookmark: pgfId-395050]You see the Control Panel dialog box.
 
     [bookmark: pgfId-395051]Step 2 Check the check box(es) next to the fabric(s) you want to open in the Select column and click Open. 
 
      
       
     
 
     
 
     [bookmark: pgfId-395052]Note Changes made using Cisco DCNM-SAN are applied to the running configuration of the switches that you are managing. If you have made changes to the configuration or performed an operation (such as activating zones), Cisco DCNM-SAN prompts you to save your changes before you exit.
 
      
      
 
     
 
     
 
     [bookmark: pgfId-380169]
 
      
      
 
     
 
     
 
    
 
     
      [bookmark: pgfId-395057]Launching Cisco DCNM-SAN Client Using Launch Pad
 
     [bookmark: pgfId-395058]Starting from Cisco NX-OS Release 4.2(0), you can use Cisco DCNM-SAN launch pad to connect to any server by specifying the IP address of the server. With launch pad, you can connect to any Cisco DCNM-SAN Server version 3.3(0) and later. Launch pad establishes connection with the server using HTTP protocol.
 
    
 
     
      [bookmark: pgfId-395059]DETAILED STEPS
 
     
 
     [bookmark: pgfId-395060]Step 1 Open your browser and enter the IP address where you installed Cisco DCNM-SAN Server, or enter localhost if you installed Cisco DCNM-SAN Server on your local workstation. 
 
     [bookmark: pgfId-395061]You see the Cisco DCNM-SAN Web Server Login dialog box.
 
     [bookmark: pgfId-395066]Step 2 Enter your user name and password and click Login.
 
     [bookmark: pgfId-395067]You see the Cisco DCNM-SAN Web Client Summary page.
 
     [bookmark: pgfId-395068]Step 3 Click the Download link in the upper right corner of the page.
 
     [bookmark: pgfId-395069]You see the Download page for Cisco DCNM-SAN and Device Manager.
 
     [bookmark: pgfId-395074]Step 4 Click the link for Cisco DCNM-SAN.
 
     [bookmark: pgfId-380200]You see the Cisco DCNM-SAN Server launch pad.
 
     [bookmark: pgfId-395112]Step 5 Enter the host name of the server or IP address in the Server URL drop-down list. 
 
     [bookmark: pgfId-395113]Step 6 Click Start.
 
      
       
     
 
     
 
     [bookmark: pgfId-395119]Note Launch pad retains the history of the server URLs used. You can choose one of the previously user Server URLs from the drop-down list.
 
      
      
 
     
 
     
 
     [bookmark: pgfId-380210]
 
      
      
 
     
 
     
 
    
 
   
 
    
     [bookmark: pgfId-345070][bookmark: 58950]Setting [bookmark: marker-345068]Cisco DCNM-SAN Preferences[bookmark: marker-345069]
 
    [bookmark: pgfId-345071]To set your preferences for the behavior of the Cisco DCNM-SAN, choose File > Preferences from the Cisco DCNM-SAN menu bar. You see the Preferences dialog box with the following tabs for setting different components of the application:
 
     
     	 [bookmark: pgfId-345072]General
 
     	 [bookmark: pgfId-345073]SNMP
 
     	 [bookmark: pgfId-345074]Map
 
    
 
    [bookmark: pgfId-345076]The default [bookmark: marker-345075]General preferences for Cisco DCNM-SAN are as follows:
 
     
     	 [bookmark: pgfId-345078] Show Device Name by [bookmark: marker-345077]—Displays the switches in the Fabric pane by IP address, DNS name, or logical name. The default setting for this value is Logical Name.
 
     	 [bookmark: pgfId-345080] Show WorldWideName (WWN) Vendor [bookmark: marker-345079]—Displays the world wide name vendor name in any table or listing displayed by Cisco DCNM-SAN. Check the Prepend Name check box to display the name in front of the IP address of the switch. Check the Replacing Vendor Bytes check box to display the name instead of the IP address. The default is the Prepend Name option.
 
     	 [bookmark: pgfId-345082] Show End Device Using [bookmark: marker-345081]—Displays end devices in the Fabric pane using alias or pWWN alias. The default setting for this value is Alias.
 
     	 [bookmark: pgfId-345084] Show Shortened iSCSI Names [bookmark: marker-345083]—Displays the default setting for this value is OFF.
 
     	 [bookmark: pgfId-345086] Show Timestamps as Date/Time [bookmark: marker-345085]—Displays timestamps in the date/time format. If this preference is not checked, timestamps are displayed as elapsed time. The default setting is enabled (checked).
 
     	 [bookmark: pgfId-345088] Telnet Path [bookmark: marker-345087]—Displays the path for the telnet.exe file on your system. The default is  telnet.exe , but you need to browse for the correct location.
 
    
 
     
      
    
 
    
 
    [bookmark: pgfId-345089]Note If you browse for a path or enter a path and you have a space in the pathname (for example, c:\program files\telnet.exe), then the path will not work. To get the path to work, you must manually place quotes around it (for example, "c:\program files\telnet.exe").
 
     
     
 
    
 
    
 
     
     	 [bookmark: pgfId-345091] Use Secure Shell instead of Telnet [bookmark: marker-345090]—Specifies whether to use SSH or Telnet when using the CLI to communicate with the switch. If enabled, you must specify the path to your SSH application. The default setting is disabled.
 
     	 [bookmark: pgfId-345093] Confirm Deletion [bookmark: marker-345092]—Displays a confirmation pop-up window when you delete part of your configuration using Cisco DCNM-SAN. The default setting is enabled (checked).
 
     	 [bookmark: pgfId-345095] Export Tables with Format [bookmark: marker-345094]—Specifies the type of file that is created when you export a table using Device Manager. The options are tab-delimited or XML. The default setting is Tab-Delimited.
 
     	 [bookmark: pgfId-345097][bookmark: marker-345096]Show CFS Warnings—Shows warning messages if CFS is not enabled on all switches for a selected feature.
 
    
 
    [bookmark: pgfId-345098]The default SNMP preferences for Cisco DCNM-SAN are as follows:
 
     
     	 [bookmark: pgfId-345100] Retry request 1 time(s) after 5 sec timeout [bookmark: marker-345099]—You can set the retry value to 0-5, and the timeout value to 3-30.
 
     	 [bookmark: pgfId-345102] Trace SNMP packets in Log [bookmark: marker-345101]—The default setting for this value is ON.
 
     	 [bookmark: pgfId-345104] Enable Audible Alert when Event Received [bookmark: marker-345103]—The default setting for this value is OFF.
 
    
 
    [bookmark: pgfId-345106]The default M[bookmark: marker-345105]ap preferences for Cisco DCNM-SAN are as follows:
 
     
     	 [bookmark: pgfId-345108] Display Unselected VSAN Members [bookmark: marker-345107]—Displays the unselected VSAN members in the Fabric pane. The default setting for this value is ON.
 
     	 [bookmark: pgfId-345110] Display End Devices [bookmark: marker-345109]—Displays the fabric’s end devices in the Fabric pane. The default setting for this value is ON.
 
     	 [bookmark: pgfId-345112] Display End Device Labels [bookmark: marker-345111]—Displays the fabric’s end device labels in the Fabric pane. The default setting for this value is OFF.
 
     	 [bookmark: pgfId-345114] Expand Loops [bookmark: marker-345113]—Displays the loops in the fabric as individual connections in the Fabric pane. The default setting for this value is OFF.
 
     	 [bookmark: pgfId-345116] Expand Multiple Links [bookmark: marker-345115]—Displays multiple links in the Fabric pane as separate lines instead of one thick line. The default setting for this value is OFF.
 
     	 [bookmark: pgfId-345118] Open New Device Manager Each Time [bookmark: marker-345117]—Opens a new instance of Device Manager each time that you invoke it from a switch in your fabric. The default value is OFF, which means that only one instance of Device Manager is open at a time.
 
     	 [bookmark: pgfId-345120] Select Switch or Link from Table [bookmark: marker-345119]—Allows you to select a switch or link in the Fabric pane by clicking the switch or link in a table in the Information pane. The default setting for this value is disabled (unchecked), which means clicking a switch or link in the table does not change the switch or link selection in the Fabric pane.
 
     	 [bookmark: pgfId-345122] Layout New Devices Automatically [bookmark: marker-345121]—Automatically places new devices in the Fabric pane in an optimal configuration. The default setting for this value is OFF. In this mode, when you add a new device, you must manually reposition it if the initial position does not suit your needs.
 
     	 [bookmark: pgfId-345124] Use Quick Layout when Switch has 30 or more End Devices [bookmark: marker-345123]—Displays the default setting for this value (30). You can enter any number in this field. Enter 0 to disable Quick Layout.
 
     	 [bookmark: pgfId-345126] Override Preferences for Non-default Layout [bookmark: marker-345125]—Displays the default setting for this value (ON).
 
     	 [bookmark: pgfId-345128] Automatically Save Layout [bookmark: marker-345127]—If this option is enabled, any changes in the layout are automatically saved. The default setting for this value is ON. 
 
     	 [bookmark: pgfId-345130] Detach Overview Window [bookmark: marker-345129]—Allows you to easily center the Fabric pane on the area of the fabric that you want to see. (This feature is useful for large fabrics that cannot be displayed entirely within the Fabric pane.) Bring up the overview window by clicking the Show/Hide Overview Window button. It overlays the fabric window and remains there until you click the Show/Hide Overview Window button again. If you enable this preference, you can detach the overview window and move it to one side while you access the Fabric pane. The default setting for this value is disabled (unchecked).
 
    
 
   
 
    
     [bookmark: pgfId-345133][bookmark: 1323]Network [bookmark: marker-345132]Fabric Discovery
 
    [bookmark: pgfId-345134]Cisco DCNM-SAN collects information about the fabric topology through SNMP queries to the switches that are connected to Cisco DCNM-SAN. The switch replies after having discovered all devices connected to the fabric by using the information from its FSPF technology database and the Name Server database and collected using the Fabric Configuration Server’s request/response mechanisms that are defined by the FC-GS-3/4 standard. When you start Cisco DCNM-SAN, you enter the IP address (or host name) of a seed switch for discovery.
 
    [bookmark: pgfId-345135]After you start Cisco DCNM-SAN and the discovery completes, Cisco DCNM-SAN presents you with a view of your network fabric, including all discovered switches, hosts, and storage devices.
 
   
 
    
     [bookmark: pgfId-369178]Network LAN Discovery
 
    [bookmark: pgfId-369179]Starting from NX-OS Release 4.2(0), you can discover Nexus and Catalyst Ethernet switches using Cisco Discovery Protocol (CDP). DataCenter 3(DC3) switches are displayed under Datacenter and LAN nodes. Cisco DCNM-SAN displays basic information about DC3 switches and its ISLs. 
 
     
      [bookmark: pgfId-366421]Viewing Ethernet Switches
 
    
 
     
      [bookmark: pgfId-367123]DETAILED STEPS
 
     
 
     [bookmark: pgfId-377966]Step 1 Click the LAN node under Datacenter node.
 
     [bookmark: pgfId-377967]Step 2 Click Switches tab in the Information pane.
 
     [bookmark: pgfId-377971]You can see the switch information as shown in Figure 10-6. 
 
     [bookmark: pgfId-406220]Figure 10-6 [bookmark: 34146]Ethernet Switch Information
 
     [bookmark: pgfId-406224]
 
      
      [image: ] 
     
 
     [bookmark: pgfId-367903]
 
      
       
     
 
     
 
     [bookmark: pgfId-367908]Note Datacenter is the parent node of SAN and LAN nodes. The SAN node remains in the tree as the parent for all the fabrics.
 
      
      
 
     
 
     
 
     [bookmark: pgfId-367933]
 
      
      
 
     
 
     
 
    
 
     
      [bookmark: pgfId-368203]Removing a LAN 
 
    
 
     
      [bookmark: pgfId-368504]DETAILED STEPS
 
     
 
     [bookmark: pgfId-368542]Step 1 Choose Server > Admin.
 
     [bookmark: pgfId-368861]You can see the switch information.
 
     [bookmark: pgfId-368900]Step 2 Click to select the switch IP of the LAN you want to remove.
 
     [bookmark: pgfId-368976]Step 3 Click Remove.
 
     [bookmark: pgfId-368863]
 
      
      
 
     
 
     
 
    
 
   
 
    
     [bookmark: pgfId-367427][bookmark: 1333]Modifying the Device Grouping[bookmark: marker-367426]
 
    [bookmark: pgfId-345140]Because not all devices are capable of responding to [bookmark: marker-345139]FC-GS-3 requests, different ports of a single server or storage subsystem may be displayed as individual end devices on the Cisco DCNM-SAN map.
 
     
      [bookmark: pgfId-345142]DETAILED STEPS
 
     
 
     [bookmark: pgfId-345144]Step 1 [bookmark: 1338 ]Expand End Devices and then choose Storage or Hosts in the Physical Attributes pane.
 
     [bookmark: pgfId-345145]You see the end devices displayed in the Information pane.
 
     [bookmark: pgfId-345147]Step 2 [bookmark: 1341 ]Click one of the devices in the Fabric pane, or click the Enclosures tab of the Information pane, and then click the device name (in the Name field) that you want to include in the enclosure.
 
     [bookmark: pgfId-345149]Step 3 [bookmark: 1343 ]Enter a name to identify the new enclosure in the Fabric pane map.
 
     [bookmark: pgfId-345151]Step 4 [bookmark: 1345 ]Click once on the device name in the Name field. To select more than one name, press the Shift key and click each of the other names.
 
     [bookmark: pgfId-345153]Step 5 [bookmark: 1347 ]Press Ctrl-C to copy the selected name(s).
 
     [bookmark: pgfId-345155]Step 6 [bookmark: 1349 ]Press Ctrl-V to paste the device name into the Name field.
 
      
       
     
 
     
 
     [bookmark: pgfId-345156]Note To remove devices from an enclosure, triple click the device name and press Delete. To remove an enclosure, repeat this step for each device in the enclosure.
 
      
      
 
     
 
     
 
     [bookmark: pgfId-398964]
 
      
      
 
     
 
     
 
    
 
     
      [bookmark: pgfId-345158]Using Alias Names as Enclosures
 
    
 
     
      [bookmark: pgfId-345160]DETAILED STEPS
 
     
 
     [bookmark: pgfId-345161]Step 1 Expand End Devices and choose Hosts or Storage from the Physical Attributes pane. 
 
     [bookmark: pgfId-345162]You see the list of devices in the Information pane. The NxPorts tab is the default.
 
     [bookmark: pgfId-345163]Step 2 Right-click the enclosure names that you want to convert to alias names and choose Alias > Enclosure.
 
     [bookmark: pgfId-406259]
 
     [bookmark: pgfId-351837]The Ailas > Enclosures window appears. It contains a list of expressions. You can also add expressions to the list and modify expressions in the current list. 
 
     [bookmark: pgfId-351668]Step 3 Click the Apply Changes icon to save the changes and then click Close.
 
      
       
     
 
     
 
     [bookmark: pgfId-351616]Note Cisco DCNM-SAN uses the regular expressions to convert multiple alias names into one enclosure. The alias names should be in the same expression pattern rule. You can create enclosure names from selected aliases using the regular expresssions list.
 
      
      
 
     
 
     
 
     [bookmark: pgfId-395189]
 
      
      
 
     
 
     
 
    
 
     
      [bookmark: pgfId-359874]Using Alias Names as Descriptions
 
    
 
     
      [bookmark: pgfId-359876]DETAILED STEPS
 
     
 
     [bookmark: pgfId-359647]Step 1 Choose End Devices and from the Physical Attributes pane.
 
     [bookmark: pgfId-359669]Step 2 Click the General tab.
 
     [bookmark: pgfId-359674]You see the list of devices in the Information pane. 
 
     [bookmark: pgfId-359718]Step 3 Select the device names that you want to populate the description with alias names and then click Alias > Enclosure button.
 
     [bookmark: pgfId-359719]You see the alias names are copied to corresponding rows in the description column.
 
      
       
     
 
     
 
     [bookmark: pgfId-359771]Note Cisco DCNM-SAN does not parse or format the alias name while copying.
 
      
      
 
     
 
     
 
     [bookmark: pgfId-359770]
 
      
      
 
     
 
     
 
     [bookmark: pgfId-345179]The default-role contains the access permissions needed by a user to access the GUI (Cisco DCNM-SAN and Device Manager). These access permissions are automatically granted to all users in order for them to use the GUI.
 
     [bookmark: pgfId-345180]Cisco Cisco DCNM-SAN uses SNMPv3 to establish role-based management access. After completing the setup routine, a single role, user name, and password are established. The role assigned to this user allows the highest level of [bookmark: marker-345181]privileges, which includes creating users and roles. Use the Cisco Cisco DCNM-SAN to create roles and users and to assign [bookmark: marker-345182]passwords as required for secure management access in your network.
 
      
       
     
 
     
 
     [bookmark: pgfId-444138]Note Either to create a new SNMPv3 user or modify password of SNMPv3 user, the DCNM login user need to have enabled with DES/AES privacy password. Since the creating and modifying SNMP SET request need to be encrypted, the login user password needs to have the privacy password.
 
      
      
 
     
 
     
 
    
 
     
      [bookmark: pgfId-345185][bookmark: 10418][bookmark: 31611]Using Cisco DCNM-SAN Wizards[bookmark: marker-345184]
 
     [bookmark: pgfId-345187]Cisco DCNM-SAN Client provides the following [bookmark: marker-345186]wizards to facilitate common configuration tasks:
 
      
      	 [bookmark: pgfId-345189][bookmark: marker-345188]VSAN—Creates VSANs on multiple switches in the fabric and sets VSAN attributes including interop mode, load balancing, and FICON.
 
      	 [bookmark: pgfId-345191][bookmark: marker-345190]Zone Edit Tool—Creates zone sets, zones, and aliases. Adds members to zones and edits the zone database.
 
      	 [bookmark: pgfId-345193][bookmark: marker-345192]IVR Zone—Creates IVR zone sets, zones, and aliases. Enables IVR NAT and auto-topology. Adds members to IVR zones, and edits the IVR zone database.
 
      	 [bookmark: pgfId-377300][bookmark: marker-377299]FCoE—Creates virtual Fibre Channel (FC) interfaces and VLAN-VSAN mappings, and binds virtual FC interfaces to Ethernet interfaces or PortChannels.
 
      	 [bookmark: pgfId-345195][bookmark: marker-345194]PortChannel—Creates PortChannels from selected ISLs either manually or automatically. Sets PortChannel attributes such as channel ID and trunking mode. 
 
      	 [bookmark: pgfId-345197][bookmark: marker-345196]FCIP—Creates FCIP links between Gigabit Ethernet ports. Enables Fibre Channel write acceleration and IP compression.
 
      	 [bookmark: pgfId-345199][bookmark: marker-345198]DPVM—Establishes dynamic port VSAN membership, enables autolearning, and activates the DPVM database.
 
      	 [bookmark: pgfId-345201][bookmark: marker-345200]Port Security—Prevents unauthorized access to Cisco MDS switches and reports these intrusions to the administrator.
 
      	 [bookmark: pgfId-345203][bookmark: marker-345202]iSCSI—Creates zones for iSCSI initiators and adds a VSAN to a target-allowed VSAN list. 
 
      	 [bookmark: pgfId-345205][bookmark: marker-345204]NPV—Reduces the number of Fibre Channel domain IDs in SANs.
 
      	 [bookmark: pgfId-345207][bookmark: marker-345206]QoS—Sets QoS attributes for zones in the selected VSAN. 
 
      	 [bookmark: pgfId-345209][bookmark: marker-345208]IP ACL—Creates ordered IP access control lists and distributes to selected switches in the fabric.
 
      	 [bookmark: pgfId-345211][bookmark: marker-345210]License Install—Facilitates download and installation of licenses in selected switches in the fabric.
 
      	 [bookmark: pgfId-345213][bookmark: marker-345212]Software Install—Verifies image compatibility and installs software images on selected switches in the fabric.
 
     
 
    
 
     
      [bookmark: pgfId-371002][bookmark: 13144]Cisco DCNM-SAN Troubleshooting Tools[bookmark: marker-371001]
 
     [bookmark: pgfId-371004]Cisco DCNM-SAN has several [bookmark: marker-371003]troubleshooting tools available from the toolbar or Tools menu
 
      
      	 [bookmark: pgfId-371009] Zone Merge Analysis [bookmark: marker-371008]—The zone merge analysis tool (available from the Zone menu) enables you to determine if zones will merge successfully when two Cisco MDS switches are interconnected. If the interconnected switch ports allow VSANs with identical names or contain zones with identical names, then Cisco DCNM-SAN verifies that the zones contain identical members. The merge analysis tool can be run before attempting a merge or after fabrics are interconnected to determine zone merge failure causes.
 
      	 [bookmark: pgfId-345225] End-to-End Connectivity [bookmark: marker-345224]—Cisco DCNM-SAN’s end-to-end connectivity analysis tool uses FC Ping to verify interconnections between Cisco MDS switches and end-device (HBAs and storage devices) in a particular VSAN. In addition to basic connectivity, Cisco DCNM-SAN can optionally verify the following:
 
     
 
     [bookmark: pgfId-345226] – Paths are redundant.
 
     [bookmark: pgfId-345227] – Zones contain at least two members.
 
     [bookmark: pgfId-345228]End devices are connected to a manageable switch (have a currently active in-band or out-of-band management path.)
 
      
      	 [bookmark: pgfId-345229] Switch Health Analysis —You can run an in-depth switch health analysis with Cisco DCNM-SAN. It verifies the status of all critical Cisco MDS switches, modules, ports, and Fibre Channel services. Over 40 conditions are checked. This tool provides a very fast, simple, and thorough way to assess Cisco MDS switch health.
 
      	 [bookmark: pgfId-345230] Fabric Configuration Analysis —Cisco DCNM-SAN includes a fabric configuration analysis tool. It compares the configurations of all Cisco MDS switches in a fabric to a reference switch or a policy file. You can define what functions to check and what type of checks to perform. The analysis can look for mismatched values, and missing or extra values. If all configuration checking is performed for all functions, over 200 checks are performed for each Cisco MDS switch.
 
     
 
     [bookmark: pgfId-345231]After the analysis is run, the results are displayed with details about the issues that were discovered. You can automatically resolve configuration differences by selecting them and clicking the Resolve button. Cisco DCNM-SAN automatically changes the configuration to match the reference switch or policy file.
 
    
 
     
      [bookmark: pgfId-291154][bookmark: 80568]Integrating Cisco DCNM-SAN and Data Center Network Management Software
 
     [bookmark: pgfId-372411]Cisco DCNM-SAN and Data Center Network Management (DCNM) software are the two major components in the Cisco next-generation data center environment. Cisco DCNM-SAN configures Cisco Nexus 5000 Series switches and Cisco MDS 9000 Series switches. DCNM software configures Cisco Nexus 5000 and Cisco Nexus 7000 Series switches. The Scope of the Cisco DCNM-SAN software is confined to SAN while the scope of the DCNM-LAN software is limited to the LAN network. 
 
     [bookmark: pgfId-372507]In a typical data center environment, the mixture of SAN and LAN topology are becoming increasingly common. Since the two management software are not designed to work across their topology limits, users are not able to navigate to Cisco DCNM-SAN from DCNM-LAN software and vice versa. 
 
     [bookmark: pgfId-372521]Integrating Cisco DCNM-SAN and DCNM-LAN provides a single platform to manage the networks in data center 3.0 and it provides seamless user experience under specific configuration. Starting from Cisco MDS NX-OS Release 4.2, the directory structure has changed to accommodate the integration of Cisco DCNM-SAN with Cisco Nexus 5000 Series products. 
 
      
       [bookmark: pgfId-372412]Launching a Switch from the Topology Map
 
     
 
      
       [bookmark: pgfId-372562]DETAILED STEPS
 
      
 
      [bookmark: pgfId-372564]Step 1 In the Cisco DCNM-SAN fabric pane, right-click the Nexus switch in the LAN map that you want to open with DCNM.
 
      [bookmark: pgfId-372735]You see the pop-up men.
 
      [bookmark: pgfId-372718]Step 2 In the pop up menu, click DCNM and select appropriate context.
 
      [bookmark: pgfId-372758]
 
       
       
 
      
 
      
 
     
 
    
 
   
 
  
 
  
  
   
   
    
     [bookmark: pgfId-255677][bookmark: 21918]Device Manager 
      
      
 
     
 
 
    [bookmark: pgfId-258659]This chapter contains descriptions and instructions for using the Device Manager. This chapter contains the following sections:
 
     
     	 [bookmark: pgfId-254782]Information About Device Manager
 
     	 [bookmark: pgfId-257366]Device Manager Features
 
     	 [bookmark: pgfId-254786]Using Device Manager Interface
 
     	 [bookmark: pgfId-254794]Setting Device Manager Preferences
 
    
 
   
 
    
     [bookmark: pgfId-246879]Information [bookmark: 65260]About Device Manager[bookmark: marker-253689]
 
    [bookmark: pgfId-246881]Device Manager provides a graphical representation of a Cisco MDS 9000 Family switch chassis, a Cisco Nexus 5000 Series switch chassis, or a Cisco Nexus 7000 Series switch chassis including the installed switching modules, the supervisor modules, the status of each port within each module, the power supplies, and the fan assemblies.
 
     
      
    
 
    
 
    [bookmark: pgfId-259782]Note Device Manager support for Cisco Nexus 7000 Series switches is only for FCoE. Non-FCoE modules appear as Unsupported Card.
 
     
     
 
    
 
    
 
    [bookmark: pgfId-253876]The tables in the DCNM-SAN Information pane basically correspond to the dialog boxes that appear in Device Manager. However, while DCNM-SAN tables show values for one or more switches, a Device Manager dialog box shows values for a single switch. Also, Device Manager provides more detailed information for verifying or troubleshooting device-specific configuration than DCNM-SAN.
 
    [bookmark: pgfId-253877]Device Manager Release 4.2 and later provides enhanced security using multiple perspectives (simple and advanced) allowing role based-access to its features. The Device Manager perspective filters out menu items that are not relevant to the user. Users with server admin role, can only access a subset of the fabric related features. The server admin role will not be able to manage Device Manager users or connected clients. 
 
    [bookmark: pgfId-256691]Device Manager Release 5.0 and later supports all the software features that are offered by Cisco NX-OS for managing Cisco MDS 9148 and 9124 Multilayer Fabric switches. Cisco MDS 9148 Multilayer Fabric Switch is a 48-port (1/2/4/8G) FC 1RU switch based on the Sabre ASIC andCisco MDS 9124 Multilayer Fabric switch is a 1/2/4/8G switch module for HP BladeServer based on the Sabre ASIC. Device Manager and DCNM-SAN allow you to discover, display, configure, monitor and service both these new switches. Device Manager also supports the following Cisco Nexus 2000 Series Fabric Extenders on a Cisco Nexus 5000 Series switch that runs Cisco NX-OS Release 5.0(1):
 
     
     	 [bookmark: pgfId-256243]Cisco Nexus 2148T Fabric Extender—It has four 10-Gigabit Ethernet fabric interfaces for its uplink connection to the parent Cisco Nexus 5000 Series switch and eight 1-Gigabit Ethernet or 10-Gigabit Ethernet host interfaces for its downlink connection to servers or hosts.
 
     	 [bookmark: pgfId-256244]Cisco Nexus 2232PP Fabric Extender—It has eight 10-Gigabit Ethernet fabric interfaces with SFP+ interface adapters for its uplink connection to the parent Cisco Nexus 5000 Series switch and 32 10-Gigabit Ethernet fabric interfaces with SFP+ interface adapters for its downlink connection to servers or hosts.
 
     	 [bookmark: pgfId-256318]Cisco Nexus 2248TP Fabric Extender—It has four 10-Gigabit Ethernet fabric interfaces with small form-factor pluggable (SFP+) interface adapters for its uplink connection to the parent Cisco Nexus 5000 Series switch and 48 1000BASE-T (1-Gigabit) Ethernet host interfaces for its downlink connection to servers or hosts.
 
    
 
    [bookmark: pgfId-256245]Device Manager allows you to discover and display these Fabric Extenders. Cisco Device Manager and the Cisco DCNM-SAN client support provisioning and monitoring of the 48-port 8-Gbps Advanced Fibre Channel switching module (DS-X9248-256K9) and the 32-port 8-Gbps Advanced Fibre Channel switching module (DS-X9232-256K9).
 
     
      [bookmark: pgfId-254943][bookmark: 16205]Device Manager Features
 
     [bookmark: pgfId-254945]Device Manager provides two views: Device View and Summary View. Use Summary View to monitor interfaces on the switch. Use Device View to perform switch-level configurations including the following:
 
      
      	 [bookmark: pgfId-253695]Configure virtual Fibre Channel interfaces.
 
      	 [bookmark: pgfId-253696]Configure Fibre Channel over Ethernet (FCoE).
 
      	 [bookmark: pgfId-246890]Configure zones for multiple VSANs.
 
      	 [bookmark: pgfId-246891]Manage ports, PortChannels, and trunking.
 
      	 [bookmark: pgfId-246892]Manage SNMPv3 security access to switches.
 
      	 [bookmark: pgfId-246893]Manage CLI security access to the switch.
 
      	 [bookmark: pgfId-246894]Manage alarms, events, and notifications.
 
      	 [bookmark: pgfId-246895]Save and copy configuration files and software image.
 
      	 [bookmark: pgfId-246896]View hardware configuration.
 
      	 [bookmark: pgfId-246897]View chassis, module, port status, and statistics.
 
     
 
    
 
     
      [bookmark: pgfId-256009][bookmark: 85361][bookmark: 10419]Using Device Manager Interface
 
     [bookmark: pgfId-258667]This section describes the Device Manager interface as shown in Figure 11-1.
 
     [bookmark: pgfId-258670]Figure 11-1 [bookmark: 48952]Device Manager, Device Tab[bookmark: marker-258669]
 
     [bookmark: pgfId-258696]
 
      
       
        
         
         	 
           
           [bookmark: pgfId-227905]1 
          
  
         	[bookmark: pgfId-227907]Menu bar
  
         	 
           
           [bookmark: pgfId-227909]5 
          
  
         	[bookmark: pgfId-227911]Status
  
        
 
         
         	 
           
           [bookmark: pgfId-227913]2 
          
  
         	[bookmark: pgfId-227915]Toolbar
  
         	 
           
           [bookmark: pgfId-227917]6 
          
  
         	[bookmark: pgfId-227919]Supervisor modules
  
        
 
         
         	 
           
           [bookmark: pgfId-227921]3 
          
  
         	[bookmark: pgfId-227923]Tabs
  
         	 
           
           [bookmark: pgfId-227925]7 
          
  
         	[bookmark: pgfId-227927]Switching or services modules
  
        
 
         
         	 
           
           [bookmark: pgfId-235260]4 
          
  
         	 
        
 
        
      
 
     
 
    
 
     
      [bookmark: pgfId-246941]Menu Bar
 
     [bookmark: pgfId-246942]The menu bar at the top of the Device Manager main window provides options for managing and troubleshooting a single switch. The menu bar provides the following options:
 
      
      	 [bookmark: pgfId-246943]Device—Opens an instance of Device Manager, sets management preferences, sets the page layout, opens a Telnet/SSH session with the current switch, exports a device image, and closes the Device Manager application.
 
      	 [bookmark: pgfId-246944]Physical—Allows you to view and manage inventory, modules, temperature sensors, power supplies, fans, and the entire system.
 
      	 [bookmark: pgfId-246945]Interface—Allows you to configure and manage PortChannels, as well as Fibre Channel, Ethernet, iSCSI, and FICON ports. Also provides diagnostic, management and monitoring capabilities, as well as SPAN and port tracking.
 
     
 
      
       
     
 
     
 
     [bookmark: pgfId-256266]Note The Interface > Port Channels menu option does not appear if the Cisco Nexus 5000 Series switch is in NPV mode and runs a Cisco NX-OS release prior to 4.2(1).
 
      
      
 
     
 
     
 
      
      	 [bookmark: pgfId-256558]FC—Allows you to configure and manage VSAN, domain, and name server characteristics. Also provides advanced configuration capabilities.
 
      	 [bookmark: pgfId-253955]FCoE—Allows you to configure the FCoE parameters and map VSANs to VLANs on a Cisco Nexus 5000 Series switch.
 
     
 
      
       
     
 
     
 
     [bookmark: pgfId-253963]Note The FCoE menu option appears only if the Cisco Nexus 5000 Series switch runs Cisco NX-OS Release 4.0(1a) or later releases.
 
      
      
 
     
 
     
 
      
      	 [bookmark: pgfId-246947]FICON—Allows you to configure and manage FICON VSANs, configure RLIR ERL information, swap selected FICON ports, and view FICON port numbers.
 
      	 [bookmark: pgfId-246948]IP—Allows you to configure and manage the following types of information: FCIP, iSCSI, iSNS, routes, VRRP, and CDP.
 
      	 [bookmark: pgfId-246949]Security—Allows you to configure and manage FCSP, port security, iSCSI security, SNMP security, common roles, SSH, AAA, and IP ACLs.
 
      	 [bookmark: pgfId-246950]Admin—Allows you to save, copy, edit, and erase the switch configuration, monitor events, manipulate Flash files, manage licenses, configure NTP, use CFS, and reset the switch. Also enables you to use the show tech support, show cores, and show image commands.
 
      	 [bookmark: pgfId-246951]Logs—Shows the various logs: message, hardware, events, and accounting. Also displays FICON link incidents, and allows you to configure the syslog setup.
 
      	 [bookmark: pgfId-246952]Help—Displays online help topics for specific dialog boxes in the Information pane.
 
     
 
    
 
     
      [bookmark: pgfId-256031]Toolbar Icons
 
      
      
 
      
 
      
 
      
 
      
 
      
 
      
 
      
 
      
 
      
 
      
 
       
        
        [bookmark: pgfId-235606]Table 11-1 [bookmark: 80867][bookmark: marker-256054]Device Manager Main Toolbar 
 
        
        
         
         	 
           
           [bookmark: pgfId-235610]Icon 
          
  
         	 
           
           [bookmark: pgfId-235612]Description 
          
  
        
 
        
          Open Device 
         	[bookmark: pgfId-235619]Opens the Device Manager view for another switch, with the option to open this view in a separate window.
  
        
 
        
          Refresh Display 
         	[bookmark: pgfId-235626]Communicates with the switch and displays the information in the Device Manager view.
  
        
 
        
          Command-Line Interface 
         	[bookmark: pgfId-235633]Opens a separate CLI command window to the switch.
  
        
 
        
          Configure Selected 
         	[bookmark: pgfId-235640]Opens a configuration dialog box for the selected component (line card or port).
  
        
 
        
          SysLog 
         	[bookmark: pgfId-235647]Opens a window that lists the latest system messages that occurred on the switch.
  
        
 
        
          VSANs 
         	[bookmark: pgfId-235661]Opens the VSAN dialog box that provides VSAN configuration for the switch.
  
        
 
        
          Save Configuration 
         	[bookmark: pgfId-235675]Saves the current running configuration to the startup configuration.
  
        
 
        
          Copy 
         	[bookmark: pgfId-235682]Copies configuration file between server and switch.
  
        
 
        
          Toggle FICON/Interface Port Labels 
         	[bookmark: pgfId-235689]Toggles the FICON and interface port labels.
  
        
 
        
          Select VSAN 
         	[bookmark: pgfId-237289]Filters the port display to show only those ports belonging to the selected VSAN.
  
        
 
        
          Help 
         	[bookmark: pgfId-235752]Accesses online help for Device Manager.
  
        
 
        
      
 
     
 
    
 
     
      [bookmark: pgfId-256044]Dialog Boxes
 
     [bookmark: pgfId-256045]If a toolbar icon is selected, a dialog box may open that allows configuration of the selected feature. The dialog box may include table manipulation icons. See the “Information Pane” for descriptions of these icons.
 
    
 
     
      [bookmark: pgfId-255292]Tabs[bookmark: marker-255291]
 
     [bookmark: pgfId-255293]Click the Device tab on the Device Manager main window to see a graphical representation of the switch chassis and components.
 
      
       
     
 
     
 
     [bookmark: pgfId-256290]Note The Device view also shows the switch chassis information of the Cisco Nexus 2000 Series Fabric Extenders (FEXs) that are connected to a Cisco Nexus 5000 Series switch that runs Cisco NX-OS Release 5.0(1).
 
      
      
 
     
 
     
 
     [bookmark: pgfId-255294]Click the Summary tab on the Device Manager main window to see a summary of active interfaces on a single switch, as well as Fibre Channel and IP neighbor devices. The Summary View also displays port speed, link utilization, and other traffic statistics. There are two buttons in the upper left corner of the Summary View tab used to monitor traffic. To monitor traffic for selected objects, click the Monitor Selected Interface Traffic Util% button. To display detailed statistics for selected objects, click the Monitor Selected Interface Traffic Details button. You can set the poll interval, the type or Rx/Tx display, and the thresholds.
 
      
       
     
 
     
 
     [bookmark: pgfId-255295]Note The Summary tab does not display the utilization statistics (Util%) of virtual Fibre Channel interfaces for Cisco Nexus 5000 Series switches that run Cisco NX-OS Release 4.2.
 
      
      
 
     
 
     
 
    
 
     
      [bookmark: pgfId-246976]Legend[bookmark: marker-246975]
 
     [bookmark: pgfId-246978]The legend at the bottom right of the Device Manager indicates [bookmark: marker-246977]port status, as follows:
 
     [bookmark: pgfId-246979]Colors
 
      
      	 [bookmark: pgfId-246980]Green—The port is up.
 
      	 [bookmark: pgfId-246981]Brown—The port is administratively down.
 
      	 [bookmark: pgfId-246982]Red cross—The port is down or has failed as a result of either hardware failure, loopback Diagnostic failure, or link failure.
 
      	 [bookmark: pgfId-260139]Red square—The port is down or has failed as a result of failure other than described for red cross.
 
      	 [bookmark: pgfId-246983]Amber—The port has a minor fault condition as a result of either signal loss, synchronization loss, credit loss, LIP F8 receiver failure, non operational sequence receiver, or off-line sequence receiver failure.
 
      	 [bookmark: pgfId-246984]Gray—The port is unreachable.
 
      	 [bookmark: pgfId-246985]Blue—The port is out of service.
 
     
 
     [bookmark: pgfId-246986]Labels
 
      
      	 [bookmark: pgfId-246987]X—Link failure
 
      	 [bookmark: pgfId-246988]E—ISL
 
      	 [bookmark: pgfId-246989]TE—Multi-VSAN ISL
 
      	 [bookmark: pgfId-246990]F—Host/storage
 
      	 [bookmark: pgfId-260194]FL—F loop
 
      	 [bookmark: pgfId-260195]I— iSCSI 
 
      	 [bookmark: pgfId-260196]SD—SPAN destination
 
      	 [bookmark: pgfId-246994]CH—Channel
 
      	 [bookmark: pgfId-246995]CU—Control Unit
 
      	 [bookmark: pgfId-253710]NP—Proxy N-Port (NPV Mode)
 
      	 [bookmark: pgfId-254378]TNP—Trunking NP_Port (NPV Mode)
 
      	 [bookmark: pgfId-254391]TF—Trunking F_Port
 
      	 [bookmark: pgfId-253714]f—vFC Present (Cisco Nexus 5000 Series switches only)
 
     
 
    
 
     
      [bookmark: pgfId-255305]Supervisor and [bookmark: marker-255303]Switching Modules[bookmark: marker-255304]
 
     [bookmark: pgfId-255306]In the Device View, you can right-click an object and get information on it, or configure it. If you right-click a module, the menu shows the module number and gives you the option to configure or reset the module. If you right-click a port, the menu shows the port number and gives you the option to configure, monitor, enable/disable, set beacon mode, or perform diagnostics on the port.
 
      
       
     
 
     
 
     [bookmark: pgfId-255307]Tip You can select multiple ports in Device Manager and apply options to all the selected ports at one time. Either select the ports by clicking the mouse and dragging it around them, or hold down the Control key and click each port.
 
      
      
 
     
 
     
 
     [bookmark: pgfId-255309]To [bookmark: marker-255308]enable or disable a port, right-click the port and click Enable or Disable from the pop-up menu. To enable or disable multiple ports, drag the mouse to select the ports and then right-click the selected ports. Then click Enable or Disable from the pop-up menu.
 
     [bookmark: pgfId-255311]To manage [bookmark: marker-255310]trunking on one or more ports, right-click the ports and click Configure. In the dialog box that appears, right-click the current value in the Trunk column and click nonTrunk, trunk, or auto from the pull-down list.
 
     [bookmark: pgfId-255313]To create [bookmark: marker-255312]PortChannels using Device Manager, click PortChannels from the Interface menu. 
 
      
       
     
 
     
 
     [bookmark: pgfId-255314]Note To create a PortChannel, all the ports on both ends of the link must have the same port speed, trunking type, and administrative state.
 
      
      
 
     
 
     
 
    
 
     
      [bookmark: pgfId-247011]Context Menus
 
     [bookmark: pgfId-247013]C[bookmark: marker-247012]ontext menus are available in both Device Manager views by right-clicking a device or table.
 
     [bookmark: pgfId-247014]From Device View:
 
      
      	 [bookmark: pgfId-247015]Device—Right-click a system, module, or power supply to bring up a menu that gives you the option to configure or reset the device.
 
      	 [bookmark: pgfId-247016]Port— Right-click a port to bring up a menu that shows you the number of the port you have clicked, and to give you the option to configure, monitor, enable, disable, set beacon mode, or perform diagnostics on the port.
 
     
 
     [bookmark: pgfId-247017]From Summary View:
 
      
      	 [bookmark: pgfId-247018]Table— Right-click the table header to show a list of which columns to display in that table: Interface, Description, VSANs, Mode, Connected To, Speed (Gb), Rx, Tx, Errors, Discards, and Log. Click the Description field to bring up the appropriate configuration dialog box for the port type.
 
     
 
    
 
   
 
    
     [bookmark: pgfId-257273]Launching Device Manager
 
    [bookmark: pgfId-258730]To launch Device Manager from your desktop, double-click the Device Manager icon and follow the instructions described in the Cisco DCNM Installation and Licensing Guide.
 
     
      [bookmark: pgfId-257278]DETAILED STEPS
 
     
 
     [bookmark: pgfId-257279]Step 1 You can choose one of the following three steps
 
     [bookmark: pgfId-257280] a. Right-click the switch you want to manage on the Fabric pane map and choose Device Manager from the menu that appears.
 
     [bookmark: pgfId-257281] b. Double-click a switch in the Fabric pane map.
 
     [bookmark: pgfId-257282] c. Select a switch in the Fabric pane map and choose Tools > Device Manager.
 
     [bookmark: pgfId-257286]You see the Device Manager open dialog box as shown in Figure 11-2
 
     [bookmark: pgfId-261281]Figure 11-2 [bookmark: 39362]Device Manager: Open Dialog Box
 
      
      [image: ] 
     
 
     [bookmark: pgfId-257292]Step 2 Enter the IP adress of the device.
 
     [bookmark: pgfId-257293]Step 3 Enter the user name and password.
 
     [bookmark: pgfId-257294]Step 4 Check the Proxy SNMP through FMS check box if you want Device Manager Client to use a TCP-based proxy server.
 
     [bookmark: pgfId-257295]Step 5 Choose the Auth-Privacy option according to the privacy protocol you have configured on your switch:
 
     [bookmark: pgfId-257296] a. If you have not configured the switch with a privacy protocol, then choose Auth-Privacy option MD5 (no privacy).
 
     [bookmark: pgfId-257297] b. If you have configured the switch with your privacy protocol, choose your Auth-Privacy choice.
 
     [bookmark: pgfId-257298]Step 6 Click Open to open the Device Manager.
 
     [bookmark: pgfId-259264]
 
      
      
 
     
 
     
 
    
 
   
 
    
     [bookmark: pgfId-255320][bookmark: 1610]Setting Device Manager Preferences[bookmark: marker-255319]
 
    [bookmark: pgfId-255322]To set your [bookmark: marker-255321]preferences for the behavior of the Device Manager application, choose Device > Preferences from the Device menu. You can set the following preferences:
 
     
     	 [bookmark: pgfId-255323] Retry Requests x Time(s) After x sec Timeout —Allows you to set the retry request values. The default settings are 1 time after a 5-second timeout.
 
     	 [bookmark: pgfId-255324] Enable Status Polling Every x secs —Allows you to set the status polling value. The default setting is enabled (checked) with a time of 40 seconds.
 
     	 [bookmark: pgfId-255325] Trace SNMP Packets in Message Lo g—Allows you to set whether Device Manager traces SNMP packets and logs the trace. The default setting is disabled (unchecked).
 
     	 [bookmark: pgfId-255326] Register for Events After Open, Listen on Port 116 3—Allows you to register this switch so that events are logged once you open Device Manager. The default setting is enabled (checked).
 
     	 [bookmark: pgfId-255327] Show WorldWideName (WWN) Vendor —Displays the world wide name vendor name in any table or listing displayed by Device Manager. If Prepend is checked, the name is displayed in front of the IP address of the switch. If Replace is checked, the name is displayed instead of the IP address. The default setting is enabled (checked) with the Prepend option.
 
     	 [bookmark: pgfId-255328] Show Timestamps as Date/Time —Displays timestamps in the date/time format. If this preference is not checked, timestamps are displayed as elapsed time. The default setting is enabled (checked).
 
     	 [bookmark: pgfId-255329] Telnet Path —Sets the path for the telnet.exe file on your system. The default is  telnet.exe , but you need to browse for the correct location.
 
    
 
     
      
    
 
    
 
    [bookmark: pgfId-255330]Note If you browse for a path or enter a path and you have a space in the pathname (for example, c:\program files\telnet.exe, then the path will not work. To get the path to work, manually place quotes around it (for example, "c:\program files\telnet.exe").
 
     
     
 
    
 
    
 
     
     	 [bookmark: pgfId-261286] Use Secure Shell Instead of Telnet —Specifies whether to use SSH or Telnet when using the CLI to communicate with the switch. If enabled, you must specify the path to your SSH application. The default setting is disabled.
 
     	 [bookmark: pgfId-255332] CLI Session Timeout x secs (0= disable) —Specifies the timeout interval for a CLI session. Enter 0 to disable (no timeout value). The default setting is 30 seconds.
 
     	 [bookmark: pgfId-255333] Show Tooltips in Physical View —Determines whether tooltips are displayed in Physical (Device) View. The default setting is enabled (checked).
 
     	 [bookmark: pgfId-255334] Label Physical View Ports With: —Specifies the type of label to assign to the ports when you are in Physical (Device) View. The options are FICON and Interface. The default setting is Interface.
 
     	 [bookmark: pgfId-255335] Export Table —Specifies the type of file that is created when you export a table using Device Manager. The options are Tab-Delimited or XML. The default setting is Tab-Delimited.
 
    
 
   
 
  
 
  
  
   
   
    
     [bookmark: pgfId-1277444]Configuring [bookmark: 47275]Performance Manager 
      
      
 
     
 
 
    [bookmark: pgfId-1277445]This chapter describes how DCNM-SAN is used to monitor and manage a network. This chapter includes the following topics:
 
     
     	 [bookmark: pgfId-1277450]Information About Performance Manager
 
     	 [bookmark: pgfId-1277454]Flow Statistics
 
     	 [bookmark: pgfId-1286093]Flow Setup Wizards
 
    
 
   
 
    
     [bookmark: pgfId-1277460]Information About [bookmark: 48420]Performance Manager
 
    [bookmark: pgfId-1286104]This section includes the following topics:
 
     
     	 [bookmark: pgfId-1286118]Data Interpolation
 
     	 [bookmark: pgfId-1286150]Data Collection
 
     	 [bookmark: pgfId-1286161]Using Performance Thresholds
 
     	 [bookmark: pgfId-1286165]Creating a Flow Using Performance Manager Flow Wizard
 
    
 
    [bookmark: pgfId-1286177]Performance Manager gathers network device statistics historically and provides this information graphically using a web browser. It presents recent statistics in detail and older statistics in summary. Performance Manager also integrates with external tools such as Cisco Traffic Analyzer.
 
    [bookmark: pgfId-1286173]The Performance Manager has three operational stages:
 
     
     	 [bookmark: pgfId-1277465]Definition—The Flow Wizard sets up flows in the switches.
 
     	 [bookmark: pgfId-1277466]Collection—The Web Server Performance Collection screen collects information on desired fabrics.
 
     	 [bookmark: pgfId-1277467]Presentation—Generates web pages to present the collected data through DCNM-SAN Web Server.
 
    
 
    [bookmark: pgfId-1277472]Performance Manager can collect statistics for [bookmark: marker-1277468]ISLs, [bookmark: marker-1277469]hosts, [bookmark: marker-1277470]storage elements, and configured [bookmark: marker-1277471]flows. Flows are defined based on a host-to-storage (or storage-to-host) link. Performance Manager gathers statistics from across the fabric based on collection configuration files. These files determine which SAN elements and SAN links Performance Manager gathers statistics for. Based on this configuration, Performance Manager communicates with the appropriate devices (switches, hosts, or storage elements) and collects the appropriate information at fixed five-minute intervals.
 
    [bookmark: pgfId-1277473]Performance Manager uses a round-robin database to hold the statistical data collected from the fabric. This data is stored based on the configured parameters in the collection configuration file. At each polling interval, Performance Manager gathers the relevant statistics and stores them in the round-robin database. This database is a fixed size and will not grow beyond its preset limits.
 
    [bookmark: pgfId-1277474]Performance Manager creates a series of archived data to hold summarized information present in the real-time round-robin database. This archived data is used to generate daily, weekly, monthly, and yearly consolidated reports. In this way, Performance Manager maintains significant historical data without the cost of an ever-increasing database size.
 
     
      
    
 
    
 
    [bookmark: pgfId-1277475]Note You must restart Performance Manager if you change the user credentials on DCNM-SAN Server.
 
     
     
 
    
 
    
 
     
      [bookmark: pgfId-1277477][bookmark: 94195]Data Interpolation[bookmark: marker-1277476]
 
     [bookmark: pgfId-1287366]One of the unique features of Performance Manager is its ability to interpolate data when statistical polling results are missing or delayed. Other performance tools may store the missing data point as zero, but this can distort historical trending. Performance Manager interpolates the missing data point by comparing the data point that preceded the missing data and the data point stored in the polling interval after the missing data. This maintains the continuity of the performance information.
 
    
 
     
      [bookmark: pgfId-1287369][bookmark: 34520]Data Collection[bookmark: marker-1287368]
 
     [bookmark: pgfId-1287370]One year’s worth of data for two variables (Rx and Tx bytes) requires a round-robin database (rrd) file size of 76 K. If errors and discards are also collected, the rrd file size becomes 110 K. The default internal values are as follows:
 
      
      	 [bookmark: pgfId-1277482]600 samples of 5 minutes (2 days and 2 hours)
 
      	 [bookmark: pgfId-1277483]700 samples of 30 minutes (14 days)
 
      	 [bookmark: pgfId-1277484]775 samples of 2 hours (64 days)
 
      	 [bookmark: pgfId-1277485]300 samples of 1 day
 
     
 
     [bookmark: pgfId-1277486]A 1000-port SAN requires 110 MB for a year’s worth of historical data that includes errors and discards. If there were 20 switches in this SAN with equal distribution of fabric ports, about two to three SNMP packets per switch would be sent every 5 minutes for a total of about 100 request or response SNMP packets required to monitor the data.
 
     [bookmark: pgfId-1277487]Because of their variable counter requests, flows are more difficult to predict storage space requirements for. But in general you can expect that, each extra flow adds another 76 KB.
 
      
       
     
 
     
 
     [bookmark: pgfId-1277488]Note Performance Manager does not collect statistics on nonmanageable and non-MDS switches. Loop devices (FL/NL) are not collected.
 
      
      
 
     
 
     
 
     [bookmark: pgfId-1296927]To setup a shared RRD path to collect PM data, perform these steps:
 
     
 
     [bookmark: pgfId-1296928]Step 1 Locate the server.properties file.
 
     [bookmark: pgfId-1296929]For Windows setup, location is: C:\Program Files\Cisco Systems\dcm\fm\conf
 
     [bookmark: pgfId-1296930]For Linux setup, location is: /usr/local/cisco/dcm/fm/conf.
 
     [bookmark: pgfId-1296931]Step 2 Add pm.rrdpath property file information to the server.properties file.
 
     [bookmark: pgfId-1296932]For example:
 
     [bookmark: pgfId-1296933]Add server location accessible from the DCNM server in the format:
 
     [bookmark: pgfId-1296934]pm.rrdpath=\\server_ip\\public\\cisco\\data
 
     [bookmark: pgfId-1296935]Step 3 Save server.properties file.
 
     [bookmark: pgfId-1296936]Step 4 Restart the Cisco DCNM server.
 
     [bookmark: pgfId-1297029]
 
      
      
 
     
 
     
 
      
       
     
 
     
 
     [bookmark: pgfId-1296937]Note After the Performance Manager server is ready, the new updated location will be used to save the RRD files. Performance Manager creates a new directory pm\db under the specified location. Ensure that RRD files are not altered, as the Performance Manager server is actively writing into the rrd files.
 
      
      
 
     
 
     
 
    
 
     
      [bookmark: pgfId-1277494][bookmark: 29640][bookmark: 34082]Using Performance Thresholds[bookmark: marker-1277493]
 
     [bookmark: pgfId-1277495]The Performance Manager Configuration Wizard allows you to set up two thresholds that will trigger events when the monitored traffic exceeds the percent utilization configured. These [bookmark: marker-1277496]event triggers can be set as either Critical or Warning events that are reported on the DCNM-SAN web client Events browser page.
 
     [bookmark: pgfId-1277497]Absolute value thresholds apply directly to the statistics gathered. These statistics, as a percent of the total link capacity, are compared to the percent utilization configured for the threshold type. If the statistics exceed either configured threshold, an event is shown on the DCNM-SAN web client Events tab.
 
     [bookmark: pgfId-1277499]B[bookmark: marker-1277498]aseline thresholds create a threshold that adapts to the typical traffic pattern for each link for the same time window each day, week, or every two weeks. Baseline thresholds are set as a percent of the average (110% to 500%), where 100% equals the calculated weighted average. Figure 12-1 shows an example of setting a baseline threshold for a weekly or daily option. 
 
     [bookmark: pgfId-1286988]Figure 12-1 [bookmark: 88907]Baseline Threshold Example
 
     [bookmark: pgfId-1286992]
 
      
      [image: ] 
     
 
     [bookmark: pgfId-1286993]The threshold is set for Monday at 2 p.m. The baseline threshold is set at 130% of the average for that statistic. The average is calculated from the statistics value that occurred at 2 p.m. on Monday, for every prior Monday (for the weekly option) or the statistics value that occurred at 2 p.m. on each day, for every prior day (for the daily option).
 
    
 
   
 
    
     [bookmark: pgfId-1286014][bookmark: 89844]Flow [bookmark: marker-1286013]Statistics 
 
    [bookmark: pgfId-1286015]Flow statistics count the ingress traffic in the aggregated statistics table. You can collect two kinds of statistics:
 
     
     	 [bookmark: pgfId-1286017]Aggregated flow statistics to count the traffic for a [bookmark: marker-1286016]VSAN.
 
     	 [bookmark: pgfId-1286018]Flow statistics to count the traffic for a source and destination ID pair in a VSAN.
 
    
 
    [bookmark: pgfId-1286020][bookmark: 76160]If you enable flow counters, you can enable a maximum of 1 K entries for aggregate flow and flow statistics. Be sure to assign an unused flow index to a module for each new flow. Flow indexes can be repeated across modules. The number space for flow index is shared between the aggregate flow statistics and the flow statistics. 
 
    [bookmark: pgfId-1286021]Generation 1 modules allow a maximum of 1024 flow statements per module. Generation 2 modules allow a maximum of 2048-128 flow statements per module.
 
     
      
       
       [bookmark: pgfId-1286029]Table 12-1 [bookmark: 13921]Performance Manager Flow Types
 
       
       
        
        	 
          
          [bookmark: pgfId-1286033]Flow type 
         
  
        	 
          
          [bookmark: pgfId-1286035]Description 
         
  
       
 
        
        	[bookmark: pgfId-1286037]Host->Storage
  
        	[bookmark: pgfId-1286039]Unidirectional flow, monitoring data from the host to the storage element
  
       
 
        
        	[bookmark: pgfId-1286041]Storage->Host
  
        	[bookmark: pgfId-1286043]Unidirectional flow, monitoring data from the storage element to the host
  
       
 
        
        	[bookmark: pgfId-1286045]Both
  
        	[bookmark: pgfId-1286047]Bidirectional flow, monitoring data to and from the host and storage elements
  
       
 
       
     
 
    
 
   
 
    
     [bookmark: pgfId-1277511][bookmark: 55827]Flow [bookmark: marker-1277510]Setup Wizards
 
    [bookmark: pgfId-1277512]The Performance Manager Flow and Performance Manager Setup wizards greatly simplify configuration. All you need to do is select the categories of statistics to capture and the wizards provide a list of flows and links to monitor. You can remove entries if desired, or just accept the provided list and start data collection. Statistics for host and storage links are not associated with a specific port on a switch, so you do not lose long term statistics if a connection is moved to a different port.
 
     
      [bookmark: pgfId-1282574][bookmark: 79550]Creating a Flow Using Performance Manager Flow Wizard
 
    
 
     
      [bookmark: pgfId-1282575]DETAILED STEPS
 
     
 
     [bookmark: pgfId-1282576]Step 1 Choose Performance > Create Flows. 
 
     [bookmark: pgfId-1287484]Specify how you want to determine and add new flows as shown in Figure 12-2. For this, you have to define traffic counters between source and destination devices, via one of these options:
 
      
       
       	 [bookmark: pgfId-1287486]In a VSAN - For this option, click VSAN.
 
       	 [bookmark: pgfId-1282565]Based on high traffic devices - For this option, click Device Traffic. Note that PM collections must already be turned on in order to use this option. If PM collection is not turned on for the selected fabric, then an error message will appear and you cannot continue.
 
      
 
     
 
     [bookmark: pgfId-1287599]Step 2 If you have clicked VSAN, then:
 
     [bookmark: pgfId-1288374]Figure 12-2 [bookmark: 42574]Create Flows Dialog Box
 
      
      [image: ] 
     
 
     [bookmark: pgfId-1282621] a. Click the drop-down menu in the VSAN field.
 
     [bookmark: pgfId-1282622] b. Choose the list of VSANs provided by the flow configuration wizard.
 
     [bookmark: pgfId-1284938] c. Click the drop-down menu in the Zone field.
 
     [bookmark: pgfId-1284969] d. Choose the list of zones provided by the flow configuration wizard.
 
     [bookmark: pgfId-1282626] e. Click Next to continue to the next windowas shown in Figure 12-3).
 
     [bookmark: pgfId-1288391]Figure 12-3 [bookmark: 59806]Review Traffic Flows Dialog Box
 
      
      [image: ] 
     
 
     [bookmark: pgfId-1282661] f. Choose items in the Possible Flow Pairs area.
 
     [bookmark: pgfId-1282662] g. The Review Traffic Flows window displays all VSAN flow pairs in the Exisitng Flows for Vsan area.
 
     [bookmark: pgfId-1282663] h. Click Add to create the selected flow.
 
     [bookmark: pgfId-1282664] i. Choose items in the Existing Flows for Vsan area.
 
     [bookmark: pgfId-1282665] j. Click Remove to remove the selected flow.
 
     [bookmark: pgfId-1287643]Step 3 If you have clicked Device Traffic, then:
 
     [bookmark: pgfId-1287644] a. Click Next.
 
     [bookmark: pgfId-1287692]You see the Define Traffic Flows page.
 
     [bookmark: pgfId-1287645] b. Specify a traffic utilization percentage threshold vlaue in the Show device ports with traffic > text box.
 
     [bookmark: pgfId-1287646] c. Specify whether you want to look at the peak or average traffic values, over the last day or last week, for the traffic types:
 
     [bookmark: pgfId-1287647] – Host<->Storage
 
     [bookmark: pgfId-1287648] – Storage<->Storage
 
     [bookmark: pgfId-1287649] – Both
 
     [bookmark: pgfId-1287650] d. Click Next.
 
     [bookmark: pgfId-1287710]If new flow pairs are found, you will see the Review Traffic Flows page, where possible flow pairs are shown in a table, along with the traffic parameters used to identify them.
 
     [bookmark: pgfId-1287816] e. To see only rows having a specific source or destination device, specify the name of the device in the Filter text box.
 
     [bookmark: pgfId-1287817] f. To create a flow, click the corresponding row in the Possible Flow Pairs table, and then click Add.
 
     [bookmark: pgfId-1287818]To remove an existing flow, click the corresponding row in the Existing Flow Pairs table, and then click Remove.
 
     [bookmark: pgfId-1287676]Step 4 Click Finish to restart the Performance Manager collection.
 
     [bookmark: pgfId-1282670]You see the Confirmation dialog box as shown in Figure 12-4.
 
     [bookmark: pgfId-1288408]Figure 12-4 [bookmark: 13922]Confirmation Dialog Box
 
      
      [image: ] 
     
 
     [bookmark: pgfId-1282728]To verify the newly created flow, choose Physical Attributes > End Devices > Flow Statistics. The newly created flows are displayed.
 
      
       
     
 
     
 
     [bookmark: pgfId-1287384]Note Performance Manager Collection can be enabled for LAN devices and traffice counters are collected periodically.
 
      
      
 
     
 
     
 
     [bookmark: pgfId-1282726]
 
      
      
 
     
 
     
 
    
 
   
 
  
 
  
  
   
   
    
     [bookmark: pgfId-1287412]Monitoring [bookmark: 47275]the Network 
      
      
 
     
 
 
    [bookmark: pgfId-1290634]This chapter describes how the DCNM-SAN manages the network. In particular, SAN discovery and network monitoring are two of its key network management capabilities.
 
    [bookmark: pgfId-1279945]This chapter contains the following sections:
 
     
     	 [bookmark: pgfId-1279953]Information About Network Monitoring
 
     	 [bookmark: pgfId-1291644]Device Discovery
 
     	 [bookmark: pgfId-1289967]Topology Mapping
 
    
 
   
 
    
     [bookmark: pgfId-1290013][bookmark: 15538]Information About Network Monitoring
 
    [bookmark: pgfId-1290113]DCNM-SAN provides extensive SAN discovery, topology mapping, and information viewing capabilities. DCNM-SAN collects information on the fabric topology through SNMP queries to the switches connected to it. DCNM-SAN recreates a fabric topology, presents it in a customizable map, and provides inventory and configuration information in multiple viewing options such as fabric view, device view, summary view, and operation view.
 
    [bookmark: pgfId-1290109]Once DCNM-SAN is invoked, a SAN discovery process begins. Using information polled from a seed Cisco MDS 9000 Family switch, including Name Server registrations, Fibre Channel Generic Services (FC-GS), Fabric Shortest Path First (FSPF), and SCSI-3, DCNM-SAN automatically discovers all devices and interconnects on one or more fabrics. All available switches, host bus adapters (HBAs), and storage devices are discovered. The Cisco MDS 9000 Family switches use Fabric-Device Management Interface (FMDI) to retrieve the HBA model, serial number and firmware version, and host operating-system type and version discovery without host agents. DCNM-SAN gathers this information through SNMP queries to each switch. The device information discovered includes device names, software revision levels, vendor, ISLs, PortChannels, and VSANs.
 
     
      [bookmark: pgfId-1290096]Monitoring Health and Events
 
     [bookmark: pgfId-1290014]DCNM-SAN works with the Cisco MDS 9000 Family switches to show the health and status of the fabric and switches. Information about the fabric and its components is gathered from multiple sources, including Online System Health Management, Call Home, system messages, and SNMP notifications. This information is then made available from multiple menus on DCNM-SAN or Device Manager.
 
    
 
     
      [bookmark: pgfId-1290015]DCNM-SAN Events Tab
 
     [bookmark: pgfId-1290017]The DCNM-SAN Events[bookmark: marker-1290016] tab, available from the topology window, displays the events DCNM-SAN received from sources within the fabric. These sources include SNMP events, RMON events, system messages, and system health messages. The Events tab shows a table of events, including the event name, the source and time of the event, a severity level, and a description of the event. The table is sortable by any of these column headings.
 
      
       
     
 
     
 
     [bookmark: pgfId-1293608]Note Cisco DCNM SAN client displays events that are created after the client session is started. Any event created before the current user login session will not be retrieved and displayed.
 
      
      
 
     
 
     
 
    
 
     
      [bookmark: pgfId-1290018]Event Information in DCNM-SAN Web Server Reports
 
     [bookmark: pgfId-1290019]The DCNM-SAN web server client displays collections of information gathered by the Performance Manager. This information includes events sent to the DCNM-SAN Server from the fabric. To open these reports, choose Performance Manager > Reports. This opens the web client in a web browser and displays a summary of all fabrics monitored by the DCNM-SAN Server. Choose a fabric and then click the Events[bookmark: marker-1290020] tab to see a summary or detailed report of the events that have occurred in the selected fabric. The summary view shows how many switches, ISLs, hosts, or storage elements are down on the fabric and how many warnings have been logged for that SAN entity. The detailed view shows a list of all events that have been logged from the fabric and can be filtered by severity, time period, or type.
 
    
 
     
      [bookmark: pgfId-1290021]Events in Device Manager
 
     [bookmark: pgfId-1290023]Device Manager displays the events when you choose Logs > Events.[bookmark: marker-1290022] Device Manager can display the current list of events or an older list of events that has been stored on the DCNM-SAN host. The event table shows details on each event, including time, source, severity, and a brief description of the event.
 
    
 
     
      [bookmark: pgfId-1279960][bookmark: 75846]SAN Discovery and Topology Mapping
 
     [bookmark: pgfId-1279962]DCNM-SAN provides extensive SAN discovery, topology mapping, and information viewing capabilities. DCNM-SAN collects information on the fabric topology through SNMP queries to the switches connected to it. DCNM-SAN recreates a fabric topology, presents it in a customizable map, and provides inventory and configuration information in multiple viewing options.
 
    
 
     
      [bookmark: pgfId-1279964][bookmark: 48122]Device [bookmark: marker-1279963]Discovery
 
     [bookmark: pgfId-1279965]Once DCNM-SAN is invoked, a SAN discovery process begins. Using information polled from a seed Cisco MDS 9000 Family switch, including Name Server registrations, Fibre Channel Generic Services (FC-GS), Fabric Shortest Path First (FSPF), and SCSI-3, DCNM-SAN automatically discovers all devices and interconnects on one or more fabrics. All available switches, host bus adapters (HBAs), and storage devices are discovered. The Cisco MDS 9000 Family switches use Fabric-Device Management Interface (FMDI) to retrieve HBA model, serial number and firmware version, and host operating-system type and version discovery without host agents. DCNM-SAN gathers this information through SNMP queries to each switch. The device information discovered includes device names, software revision levels, vendor, ISLs, PortChannels, and VSANs.
 
     [bookmark: pgfId-1287577]For a VSAN change involving a third-party switch, DCNM-SAN will need a second discovery to show the correct topology due to the discovery dependency when there is any change in a mixed VSAN. The first discovery finds the third-party switch and the subsequent discovery will show the information on which VSAN it is going to join and can discover the end devices connected to it. You can wait for the subsequent discovery or trigger a manual discovery.
 
    
 
     
      [bookmark: pgfId-1279967][bookmark: 42879]Topology [bookmark: marker-1279966]Mapping
 
     [bookmark: pgfId-1287504]DCNM-SAN is built upon a topology representation[bookmark: marker-1287503] of the fabric. DCNM-SAN provides an accurate view of multiple fabrics in a single window by displaying topology maps based on device discovery information. You can modify the topology map icon layout with an easy-to-use, drag-and-drop interface. The topology map visualizes device interconnections, highlights configuration information such as zones, VSANs, and ISLs exceeding utilization thresholds. The topology map also provides a visual context for launching command-line interface (CLI) sessions, configuring PortChannels, and opening device managers. 
 
    
 
     
      [bookmark: pgfId-1287506]Using the Topology Map
 
     [bookmark: pgfId-1279972]The DCNM-SAN topology map [bookmark: marker-1279971]can be customized to provide a view into the fabric that varies from showing all switches, end devices, and links, to showing only the core switches with single bold lines for any multiple links between switches. Use the icons along the left side of the topology map to control these views or right-click anywhere in the topology map to access the map controls.
 
     [bookmark: pgfId-1279973]You can zoom in or out on the topology map to see an overview of the SAN or focus on an area of importance. You can also open an overview window that shows the entire fabric. From this window, you can right-click and draw a box around the area you want to view in the main topology map view.
 
     [bookmark: pgfId-1279974]Another way to limit the scope of the topology display is to select a fabric or VSAN from the Logical Domains pane. The topology map displays only that fabric or VSAN.
 
     [bookmark: pgfId-1279975]Moving the mouse pointer over a link or switch provides a simple summary of that SAN component, along with a status indication. Right-clicking on the component brings up a pop-up menu. You can view the component in detail or access configuration or test features for that component.
 
     [bookmark: pgfId-1279976]Double-click a link to bring link status and configuration information to the information pane. Double-click a switch to bring up Device Manager for that switch.
 
    
 
     
      [bookmark: pgfId-1279977]Saving a Customized Topology Map Layout
 
     [bookmark: pgfId-1279982]Changes made to the topology map can be saved so that the customized view is available any time you open the DCNM-SAN Client for that fabric. 
 
    
 
     
      [bookmark: pgfId-1290266]DETAILED STEPS
 
     
 
     [bookmark: pgfId-1279987]Step 1 Click File > Preferences to open the DCNM-SAN preferences dialog box.
 
     [bookmark: pgfId-1279988]Step 2 Click the Map tab and check the Automatically Save Layout check box to save any changes to the topology map as shown in Figure 13-1.
 
     [bookmark: pgfId-1293869]Figure 13-1 [bookmark: 33584]DCNM-SAN Preferences
 
     [bookmark: pgfId-1293873]
 
      
      [image: ] 
     
 
     [bookmark: pgfId-1279998]Step 3 Click Apply, and then click OK to save this change.
 
     [bookmark: pgfId-1279999]
 
      
      
 
     
 
     
 
    
 
     
      [bookmark: pgfId-1280001]Using Enclosures   [bookmark: marker-1280000]with DCNM-SAN Topology Maps
 
     [bookmark: pgfId-1289373]Because not all devices are capable of responding to FC-GS-3 requests, different ports of a single server or storage subsystem may be displayed as individual end devices on the topology map. See the “Modifying the Device Grouping” section to group these ports into a single enclosure for DCNM-SAN. 
 
     [bookmark: pgfId-1280006]Clicking Alias->Enclosure displays hosts and storage elements in the Information pane. This is a shortcut to naming enclosures. To use this shortcut, highlight each row in the host or storage table that you want grouped in an enclosure then click Alias -> Enclosure. This automatically sets the enclosure names of each selected row with the first token of the alias.
 
    
 
     
      [bookmark: pgfId-1280007]Mapping Multiple Fabrics
 
     [bookmark: pgfId-1289380]To log into[bookmark: marker-1280008] multiple fabrics, the same username and password must be used. The information for both fabrics is displayed, with no need to select a seed switch. To see details of a fabric, click the tab for that fabric at the bottom of the Fabric pane, or double-click the fabric’s cloud icon. To continuously manage a fabric using DCNM-SAN, follow the instructions in the “Managing a Cisco DCNM-SAN Server Fabric” section. 
 
    
 
     
      [bookmark: pgfId-1280014]Inventory Management
 
     [bookmark: pgfId-1289389]The Information pane in DCNM-SAN shows inventory[bookmark: marker-1280018], configuration, and status information for all switches, links, and hosts in the fabric. Inventory management includes vendor name and model, and software or firmware versions. Select a fabric or VSAN from the Logical Domains pane, and then select the Summary tab in the Information pane to get a count of the number of VSANS, switches, hosts, and storage elements in the fabric. See the “Cisco DCNM-SAN Client Quick Tour: Admin Perspective” section for more information on the DCNM-SANDCNM-SAN user interface. 
 
    
 
     
      [bookmark: pgfId-1280023]Using the Inventory Tab from DCNM-SAN Web Server
 
     [bookmark: pgfId-1289397]If you have configured DCNM-SAN Web Server, you can launch this application and access the Inventory tab to see a summary of the fabrics managed by the DCNM-SAN Server. The Inventory tab shows an inventory of the selected SAN, fabric, or switch. See Chapter 4, “Cisco DCNM Web Client” for more information on how to configure and use DCNM-SAN Web Server. 
 
    
 
     
      [bookmark: pgfId-1290250]DETAILED STEPS
 
     
 
     [bookmark: pgfId-1289405]Step 1 [bookmark: 16465][bookmark: 28619][bookmark: 48451][bookmark: 12684]Point your browser at the DCNM-SAN Web Server. 
 
     [bookmark: pgfId-1280039]Step 2 Click the Events tab and then the Details tab to view the system messages. The columns in the events table are sortable. In addition, you can use the Filter button to limit the scope of messages within the table.
 
     [bookmark: pgfId-1290589]
 
      
      
 
     
 
     
 
    
 
     
      [bookmark: pgfId-1280042][bookmark: 46162]Viewing Logs from Device Manager
 
     [bookmark: pgfId-1280043]You can view system messages from Device Manager if Device Manager is running from the same workstation as the DCNM-SAN Server. Choose[bookmark: marker-1280044] Logs > Events > current to view the system messages on Device Manager. The columns in the events table are sortable. In addition, you can use the Find button to locate text within the table.
 
     [bookmark: pgfId-1287160]You can view switch-resident logs even if you have not set up your local syslog server or your local PC is not in the switch's syslog server list. Due to memory constraints, these logs will wrap when they reach a certain size. The switch syslog has two logs: an NVRAM log that holds a limited number of critical and greater messages and a nonpersistent log that contains notice or greater severity messages. Hardware messages are part of these logs.
 
      
       
     
 
     
 
     [bookmark: pgfId-1287161]Note To view syslog local logs, you need to configure the IP address of the DCNM-SAN Server in the syslog host. 
 
      
      
 
     
 
     
 
    
 
   
 
    
   
 
  
 
  
  
   
   
    
     [bookmark: pgfId-1300502]Monitoring [bookmark: 38215]Performance 
      
      
 
     
 
 
    [bookmark: pgfId-1305640]This chapter describes how to configure Performance Monitoring tools for Cisco DCNM-SAN and Device Manager. These tools provide real-time statistics as well as historical performance monitoring.
 
    [bookmark: pgfId-1300504]This chapter contains the following sections:
 
     
     	 [bookmark: pgfId-1300508]Information About Performance Monitoring
 
     	 [bookmark: pgfId-1300512]Configuring Performance Manager
 
     	 [bookmark: pgfId-1306868]Configuring the Summary View in Device Manager
 
     	 [bookmark: pgfId-1306881]Configuring Per Port Monitoring using Device Manager
 
     	 [bookmark: pgfId-1306909]Displaying DCNM-SAN Real-Time ISL Statistics
 
     	 [bookmark: pgfId-1308160]Displaying Performance Manager Reports
 
     	 [bookmark: pgfId-1308164]Generating Performance Manager Reports
 
     	 [bookmark: pgfId-1308169]Exporting Data Collections
 
     	 [bookmark: pgfId-1304323]Analyzing SAN Health
 
    
 
   
 
    
     [bookmark: pgfId-1300513][bookmark: 98858]Information About Performance Monitoring
 
    [bookmark: pgfId-1300515]Device Manager provides an easy tool for monitoring[bookmark: marker-1300514] ports on the Cisco MDS 9000 Family switches. This tool gathers statistics at a configurable interval and displays the results in tables or charts. Real-time performance statistics are useful for dynamic troubleshooting and fault isolation within the fabric. Real-time statistics gather data on parts of the fabric in user-configurable intervals and display these results in DCNM-SAN and Device Manager. For a selected port, you can monitor any of a number of statistics including traffic in and out, errors, class 2 traffic, and FICON data.
 
     
      [bookmark: pgfId-1287560]Real-Time Performance Monitoring
 
     [bookmark: pgfId-1301394]Device Manager provides an easy tool for monitoring ports on the Cisco MDS 9000 Family switches. This tool gathers statistics at a configurable interval and displays the results in tables or charts. These statistics show the performance of the selected port in real-time and can be used for performance monitoring and troubleshooting. For a selected port, you can monitor any of a number of statistics including traffic in and out, errors, class 2 traffic, and FICON data. You can set the polling interval from ten seconds to one hour, and display the results based on a number of selectable options including absolute value, value per second, and minimum or maximum value per second. 
 
     [bookmark: pgfId-1287561]Device Manager checking for oversubscription on the host-optimized four-port groups on relevant modules. Right-click the port group on a module and choose Check Oversubscription from the pop-up menu.
 
     [bookmark: pgfId-1287562]Device manager provides two performance views: the Summary View tab and the configurable monitor option per port. 
 
    
 
     
      [bookmark: pgfId-1305780]Historical Performance Monitoring
 
     [bookmark: pgfId-1305782]Performance Manager gathers network device statistics historically[bookmark: marker-1305781] and provides this information using DCNM-SAN client and web browser. It presents recent statistics in detail and older statistics in summary. Performance Manager also integrates with external tools such as Cisco Traffic Analyzer. See the “Information About Performance Manager” section for an overview of Performance Manager.
 
    
 
   
 
    
     [bookmark: pgfId-1306203][bookmark: 88843]Configuring Performance Manager
 
    [bookmark: pgfId-1306722]This section includes the following topics:
 
     
     	 [bookmark: pgfId-1306740]Creating a Flow with Performance Manager
 
     	 [bookmark: pgfId-1306779]Creating a Collection with Performance Manager
 
     	 [bookmark: pgfId-1306783]Using Performance Thresholds
 
    
 
     
      [bookmark: pgfId-1306714][bookmark: 44572][bookmark: 29640]Creating a Flow with Performance Manager
 
     [bookmark: pgfId-1306205]With the Flow Configuration Wizard[bookmark: marker-1306204] you can create host-to-storage, storage-to-host, or bidirectional flows. Once defined, you can add these flows to a collection configuration file to monitor the traffic between a host/storage element pair. The flows created become part of the collection options in the Performance Manager Configuration Wizard. 
 
    
 
     
      [bookmark: pgfId-1306210][bookmark: 56913]Creating a Collection with Performance Manager
 
     [bookmark: pgfId-1306212]The Performance Manager Configuration Wizard steps you through the process of creating collections[bookmark: marker-1306211] using configuration files. Collections are defined for one or all VSANs in the fabric. Collections can include statistics from the SAN element types described in Table 14-1.
 
     [bookmark: pgfId-1306242]
 
      
       
        
        [bookmark: pgfId-1306219]Table 14-1 [bookmark: 89973]Performance Manager Collection Types
 
        
        
         
         	 
           
           [bookmark: pgfId-1306223]Collection Type 
          
  
         	 
           
           [bookmark: pgfId-1306225]Description 
          
  
        
 
         
         	[bookmark: pgfId-1306227]ISLs
  
         	[bookmark: pgfId-1306229]Collects link statistics for ISLs.
  
        
 
         
         	[bookmark: pgfId-1306231]Host
  
         	[bookmark: pgfId-1306233]Collects link statistics for SAN hosts.
  
        
 
         
         	[bookmark: pgfId-1306235]Storage
  
         	[bookmark: pgfId-1306237]Collects link statistics for a storage elements.
  
        
 
         
         	[bookmark: pgfId-1306239]Flows
  
         	[bookmark: pgfId-1306241]Collects flow statistics defined by the Flow Configuration Wizard.
  
        
 
        
      
 
     
 
    
 
     
      [bookmark: pgfId-1306243][bookmark: 37714]Using Performance Thresholds
 
     [bookmark: pgfId-1306244]The Performance Manager Configuration Wizard allows you to set up two thresholds that trigger events when the monitored traffic exceeds the percent utilization configured. These event triggers can be set as either Critical or Warning events that are reported on the DCNM-SAN web client Events browser page.
 
     [bookmark: pgfId-1306245]You must choose either absolute value thresholds or baseline thresholds that apply to all transmit or receive traffic defined in the collection. Click the Use absolute values radio button on the last screen of the Performance Manager Configuration Wizard to configure thresholds that apply directly to the statistics gathered. These statistics, as a percent of the total link capacity, are compared to the percent utilization configured for the threshold type. If the statistics exceed either configured threshold, an event is shown on the DCNM-SAN web client Events tab.
 
     [bookmark: pgfId-1306246]As an example, the collection has absolute value thresholds set for 60% utilization (for warning) and 80% utilization (for critical). If Performance Manager detects that the traffic on a 1-Gigabit link in its collection exceeds 600 Mbps, a warning event is triggered. If the traffic exceeds 800 Mbps, a critical event is triggered.
 
     [bookmark: pgfId-1306247]Baseline thresholds are defined for a configured time of day or week (1 day, 1 week, or 2 weeks). The baseline is created by calculating the average of the statistical results for the configured time each day, week, or every 2 weeks. Table 14-2 shows an example of the statistics used to create the baseline value for a collection defined at 4 pm on a Wednesday.
 
     [bookmark: pgfId-1306273]
 
      
       
        
        [bookmark: pgfId-1306254]Table 14-2 [bookmark: 84191]Baseline Time Periods for a Collection Started on Wednesday at 4pm
 
        
        
         
         	 
           
           [bookmark: pgfId-1306258]Baseline Time Window 
          
  
         	 
           
           [bookmark: pgfId-1306260]Statistics Used in Average Calculation 
          
  
        
 
         
         	[bookmark: pgfId-1306262]1 day
  
         	[bookmark: pgfId-1306264]Every prior day at 4 pm
  
        
 
         
         	[bookmark: pgfId-1306266]1 week
  
         	[bookmark: pgfId-1306268]Every prior Wednesday at 4 pm
  
        
 
         
         	[bookmark: pgfId-1306270]2 weeks
  
         	[bookmark: pgfId-1306272]Every other prior Wednesday at 4 pm
  
        
 
        
      
 
     
 
     [bookmark: pgfId-1306274]Baseline thresholds create a threshold that adapts to the typical traffic pattern for each link for the same time window each day, week, or every 2 weeks. Baseline thresholds are set as a percent of the average (110% to 500%), where 100% equals the calculated average. 
 
     [bookmark: pgfId-1306275]As an example, a collection is created at 4 pm on Wednesday, with baseline thresholds set for 1 week, at 150% of the average (warning) and 200% of the average (critical). Performance Manager recalculates the average for each link at 4 pm every Wednesday by taking the statistics gathered at that time each Wednesday since the collection started. Using this as the new average, Performance Manager compares each received traffic statistic against this value and sends a warning or critical event if the traffic on a link exceeds this average by 150% or 200% respectively.
 
     [bookmark: pgfId-1306279]Table 14-3 shows two examples of 1-Gigabit links with different averages in our example collection and at what traffic measurements the Warning and Critical events are sent.
 
     [bookmark: pgfId-1306306]
 
      
       
        
        [bookmark: pgfId-1306283]Table 14-3 [bookmark: 49294]Example of Events Generated for 1-Gigabit Links
 
        
        
         
         	 
           
           [bookmark: pgfId-1306289]Average 
          
  
         	 
           
           [bookmark: pgfId-1306291]Warning Event Sent at 150% 
          
  
         	 
           
           [bookmark: pgfId-1306293]Critical Event Sent at 200% 
          
  
        
 
         
         	[bookmark: pgfId-1306295]400 Mbps
  
         	[bookmark: pgfId-1306297]600 Mbps
  
         	[bookmark: pgfId-1306299]800 Mbps
  
        
 
         
         	[bookmark: pgfId-1306301]200 Mbps
  
         	[bookmark: pgfId-1306303]300 Mbps
  
         	[bookmark: pgfId-1306305]400 Mbps
  
        
 
        
      
 
     
 
     [bookmark: pgfId-1306307]Set these thresholds on the last screen of the Collections Configuration Wizard by checking the Send events if traffic exceeds threshold check box.
 
    
 
   
 
    
     [bookmark: pgfId-1300175][bookmark: 84499]Configuring the Summary View in Device Manager
 
     
      [bookmark: pgfId-1287565]DETAILED STEPS
 
     
 
     [bookmark: pgfId-1287566]Step 1 Click the Summary tab on the main display. 
 
     [bookmark: pgfId-1287567]You see all of the active ports on the switch, as well as the configuration options available from the Summary view shown in Figure 14-1.
 
     [bookmark: pgfId-1287572]Figure 14-1 [bookmark: 36324]Device Manager Summary Tab
 
     [bookmark: pgfId-1287576]
 
      
      [image: ] 
     
 
     [bookmark: pgfId-1287577]Step 2 Choose a value from the Poll Interval drop-down list.
 
     [bookmark: pgfId-1287578]Step 3 Decide how you want your data to be interpreted by looking at the Show Rx/Tx drop-down menu. The table updates each polling interval to show an overview of the receive and transmit data for each active port on the switch.
 
     [bookmark: pgfId-1287579]Step 4 Select a value from the Show Rx/Tx drop-down list. If you select Util%, you need to also select values from the two Show Rx/Tx > %Util/sec drop-down lists. The first value is the warning level and the second value is the critical threshold level for event reporting.
 
     [bookmark: pgfId-1287580]Note that you can also display percent utilization for a single port by selecting the port and clicking the Monitor Selected Interface Traffic Util % icon.
 
     [bookmark: pgfId-1287582]
 
      
      
 
     
 
     
 
    
 
   
 
    
     [bookmark: pgfId-1306655][bookmark: 78834]Configuring Per Port Monitoring using Device Manager
 
    [bookmark: pgfId-1287583]The configurable monitor per port option gives statistics for in and out traffic on that port, errors, class 2 traffic and other data that can be graphed over a period of time to give a real-time view into the performance of the port.
 
     
      [bookmark: pgfId-1306683]DETAILED STEPS
 
     
 
     [bookmark: pgfId-1287586]Step 1 Click the Device tab.
 
     [bookmark: pgfId-1287587]Step 2 Right-click the port you are interested in and choose Monitor from the drop-down menu. 
 
     [bookmark: pgfId-1287591]You see the port real-time monitor dialog box shown in Figure 14-2.
 
     [bookmark: pgfId-1316677]Figure 14-2 [bookmark: 97616]Device Manager Monitor Dialog Box
 
     [bookmark: pgfId-1316681]
 
      
      [image: ] 
     
 
     [bookmark: pgfId-1287598]Step 3 Select a value from the Interval drop-down list to determine how often data is updated in the table shown here.
 
     [bookmark: pgfId-1287599]Step 4 Click a statistical value in the table then click one of the graphing icons to display a running graph of that statistic over time. You see a graph window that contains options to change the graph type. 
 
      
       
     
 
     
 
     [bookmark: pgfId-1287600]Tip You can open multiple graphs for statistics on any of the active ports on the switch.
 
      
      
 
     
 
     
 
     [bookmark: pgfId-1287601]
 
      
      
 
     
 
     
 
    
 
   
 
    
     [bookmark: pgfId-1287604]Displaying [bookmark: 93888][bookmark: marker-1287603]DCNM-SAN Real-Time ISL Statistics
 
    [bookmark: pgfId-1287606]This section includes the following topics:
 
     
     	 [bookmark: pgfId-1306970]“Viewing Performance Statics Using DCNM-SAN” section
 
    
 
    [bookmark: pgfId-1306939]You can configure DCNM-SAN to gather [bookmark: marker-1287605]ISL statistics in real time. These ISL statistics include receive and transmit utilization, bytes per second, as well as errors and discards per ISL. 
 
     
      [bookmark: pgfId-1287607]DETAILED STEPS
 
     
 
     [bookmark: pgfId-1287608]Step 1 Choose Performance > ISLs in Real-Time. 
 
     [bookmark: pgfId-1287612]You see any ISL statistics in the Information pane as shown in Figure 14-3.
 
     [bookmark: pgfId-1287614]Figure 14-3 [bookmark: 79703]ISL Performance in Real Time
 
     [bookmark: pgfId-1287618]
 
      
      [image: ] 
     
 
     [bookmark: pgfId-1287619]Step 2 Select a value from the Poll Interval drop-down list.
 
     [bookmark: pgfId-1287620]Step 3 Select two values from the Bandwidth utilization thresholds drop-down lists, one value for the minor threshold and one value for the major threshold.
 
     [bookmark: pgfId-1287621]The table shown updates each polling interval to show the statistics for all configured ISLs in the fabric.
 
     [bookmark: pgfId-1287622]Step 4 Select a row in the table to highlight that ISL in blue in the Topology map.
 
     [bookmark: pgfId-1287623]
 
      
      
 
     
 
     
 
    
 
     
      [bookmark: pgfId-1299365][bookmark: 71105]Viewing Performance Statics Using DCNM-SAN
 
     [bookmark: pgfId-1299385]You can configure DCNM-SAN to gather historic and real time statistics of ISLs or End devices. These statistics include receive and transmit utilization, bytes per second, as well as errors and discards per ISL or end device. 
 
    
 
     
      [bookmark: pgfId-1299366]DETAILED STEPS
 
     
 
     [bookmark: pgfId-1299767]Step 1 Right-click the ISL or end device in the Fabric pane.
 
     [bookmark: pgfId-1299813]You see a context menu as shown in the Figure 14-4.
 
     [bookmark: pgfId-1299768]Step 2 Select Show Statics.
 
     [bookmark: pgfId-1316703]Figure 14-4 [bookmark: 16052]Show Statics Menu
 
     [bookmark: pgfId-1316707]
 
      
      [image: ] 
     
 
      
       
     
 
     
 
     [bookmark: pgfId-1307732]Note Show Statics menu will be enabled only if you add the fabric to the Performance Manager collection.
 
      
      
 
     
 
     
 
     [bookmark: pgfId-1307733]
 
      
      
 
     
 
     
 
    
 
   
 
    
     [bookmark: pgfId-1307736][bookmark: 18887]Displaying [bookmark: marker-1307735]Performance Manager Reports
 
    [bookmark: pgfId-1307763]This section includes the following topics:
 
     
     	 [bookmark: pgfId-1307771]“Displaying Performance Summary” section
 
     	 [bookmark: pgfId-1307836]“Displaying Performance Tables and Details Graphs” section
 
     	 [bookmark: pgfId-1307873]“Displaying Performance of Host-Optimized Port Groups” section
 
     	 [bookmark: pgfId-1307910]“Displaying Performance Manager Events” section
 
    
 
    [bookmark: pgfId-1300904]
 
    [bookmark: pgfId-1308004]You can view Performance Manager statistical data using preconfigured reports[bookmark: marker-1300903] that are built on demand and displayed in a web browser. These reports provide summary information as well as detailed statistics that can be viewed for daily, weekly, monthly, or yearly results.
 
     
      [bookmark: pgfId-1287721]DETAILED STEPS
 
     
 
     [bookmark: pgfId-1306448]Step 1 Choose Performance > Reports to access Performance Manager reports from DCNM-SAN. 
 
     [bookmark: pgfId-1306539]This opens a web browser window showing the default DCNM-SAN web client event summary report. 
 
     [bookmark: pgfId-1306540]Step 2 Click the Performance tab to view the Performance Manager reports. 
 
     [bookmark: pgfId-1306576]Performance Manager begins reporting data ten minutes after the collection is started.
 
     [bookmark: pgfId-1309317]
 
      
      
 
     
 
     
 
      
       
     
 
     
 
     [bookmark: pgfId-1309320]Note DCNM-SAN Web Server must be running for reports to work. 
 
      
      
 
     
 
     
 
    
 
     
      [bookmark: pgfId-1309324][bookmark: 26419]Displaying Performance [bookmark: marker-1309323]Summary
 
     [bookmark: pgfId-1287728]The Performance Summary page presents a dashboard display of the throughput and link utilization for hosts, ISLs, storage, and flows for the last 24-hour period. The summary provides a quick overview of the fabric’s bandwidth consumption and highlights any hotspots.
 
     [bookmark: pgfId-1287729]The report includes network throughput pie charts and link utilization pie charts. Use the navigation tree on the left to show summary reports for monitored fabrics or VSANs. The summary displays charts for all hosts, storage elements, ISLs, and flows. Each pie chart shows the percent of entities (links, hosts, storage, ISLs, or flows) that measure throughput or link utilization on each of six predefined ranges. Move the mouse over a pie chart section to see how many entities exhibit that range of statistics. Double-click any pie chart to bring up a table of statistics for those hosts, storage elements, ISLs, or flows.
 
    
 
     
      [bookmark: pgfId-1287731][bookmark: 36417]Displaying Performance [bookmark: marker-1287730]Tables and Details Graphs
 
     [bookmark: pgfId-1287732]Click Host, Storage, ISL, or Flow to view traffic over the past day for all hosts, storage, ISLs, or flows respectively. A table lists all of the selected entities, showing transmit and receive traffic and errors and discards, if appropriate. The table can be sorted by any column heading. The table can also be filtered by day, week, month, or year. Tables for each category of statistics display average and peak throughput values and provide hot-links to more detailed information.
 
     [bookmark: pgfId-1287733]Clicking a link in any of the tables opens a details page that shows graphs for traffic by day, week, month, and year. If flows exist for that port, you can see which storage ports sent data. The details page also displays graphs for errors and discards if they are part of the statistics gathered and are not zero.
 
     [bookmark: pgfId-1287734]If you double-click a graph on a Detail report, it will launch the Cisco Traffic Analyzer for Fibre Channel, if configured. The aliases associated with hosts, storage devices, and VSANs in the fabric are passed to the Cisco Traffic Analyzer to provide consistent, easy identification.
 
    
 
     
      [bookmark: pgfId-1287736][bookmark: 91476]Displaying [bookmark: marker-1287735]Performance of Host-Optimized Port Groups
 
     [bookmark: pgfId-1287737]You can monitor the performance of host-optimized port groups by selecting Performance > End Devices and selecting Port Groups from the Type drop-down list.
 
    
 
     
      [bookmark: pgfId-1287738][bookmark: 20204]Displaying Performance Manager Events
 
     [bookmark: pgfId-1287739]Performance Manager events are viewed through DCNM-SAN Web Server. To view problems and events[bookmark: marker-1287740] in DCNM-SAN Web Server, choose a fabric and then click the Events tab to see a summary or detailed report of the problems and events that have occurred in the selected fabric.
 
    
 
   
 
    
     [bookmark: pgfId-1308017][bookmark: 60756]Generating Performance Manager Reports
 
     
     	 [bookmark: pgfId-1308026]“Generating Top10 Reports in Performance Manager” section
 
     	 [bookmark: pgfId-1308080]“Generating Top10 Reports Using Scripts” section
 
    
 
     
      [bookmark: pgfId-1287741][bookmark: 58671]Generating Top10 Reports in Performance Manager
 
     [bookmark: pgfId-1300910]You can generate historical Top10 reports[bookmark: marker-1301282] that can be saved for later review. These reports list the entities from the data collection, with the most active entities appearing first. This is a static, one-time only report that generates averages and graphs of the data collection as a snapshot at the time the report is generated. These Top10 reports differ from the other monitoring tables and graphs in Performance Manager in that the other data is continuously monitored and is sortable on any table column. The Top10 reports are a snapshot view at the time the report was generated and are static. These are one-time reports that generate averages and graphs of the data collection as a snapshot at the time the report is generated. 
 
      
       
     
 
     
 
     [bookmark: pgfId-1287746]Tip Name the reports with a timestamp so that you can easily find the report for a given day or week.
 
      
      
 
     
 
     
 
     [bookmark: pgfId-1287747]These Top10 reports differ from the other monitoring tables and graphs in Performance Manager in that the other data is continuously monitored and is sortable on any table column. The Top10 reports are a snapshot view at the time the report was generated.
 
      
       
     
 
     
 
     [bookmark: pgfId-1287748]Note Top10 reports require analyzing the existing data over an extended period of time and can take hours or more to generate on large fabrics.
 
      
      
 
     
 
     
 
    
 
     
      [bookmark: pgfId-1287753][bookmark: 18599]Generating Top10 Reports Using Scripts
 
     [bookmark: pgfId-1287754]You can generate Top10 reports manually by issuing the following commands:
 
      
      	 [bookmark: pgfId-1287755]On UNIX, run the script:
 
     
 
      
      [bookmark: pgfId-1287756]“/<user_directory>/.cisco_mds9000/bin/pm.sh display pm/pm.xml <output_directory>” 
     
 
      
      [bookmark: pgfId-1287757] 
     
 
      
      	 [bookmark: pgfId-1287758]On Windows, run the script:
 
     
 
      
      [bookmark: pgfId-1287759]“c:\Program Files\Cisco Systems\MDS 9000\bin\pm.bat display pm\pm.xml <output_directory>” 
     
 
      
      [bookmark: pgfId-1287760] 
     
 
     [bookmark: pgfId-1287761]On UNIX, you can automate the generation of the Top10 reports on your DCNM-SANDCNM-SAN Server host by adding the following cron entry to generate the reports once an hour:
 
      
      [bookmark: pgfId-1287762]0 * * * * /<user_directory>/.cisco_mds9000/bin/pm.sh display pm/pm.xml <output_directory> 
     
 
      
      [bookmark: pgfId-1287763] 
     
 
     [bookmark: pgfId-1287764]If your crontab does not run automatically or Java complains about an exception similar to Example 14-1, you need to add “-Djava.awt.headless=true” to the JVMARGS command in /<user_directory>/.cisco_mds9000/bin/pm.sh.
 
     [bookmark: pgfId-1287769]Example 14-1 [bookmark: 29318]Example Java Exception
 
      
      [bookmark: pgfId-1307330]in thread “main” java.lang.InternalError Can't connect to X11 window server using '0.0' as the value of the DISPLAY variable. 
     
 
    
 
     
      [bookmark: pgfId-1307374][bookmark: 1801][bookmark: 1704]Configuring Performance Manager for Use with Cisco Traffic Analyzer
 
     [bookmark: pgfId-1287821]Performance Manager works in conjunction with the [bookmark: marker-1287820]Cisco Traffic Analyzer to allow you to monitor and manage the traffic on your fabric. Using Cisco Traffic Analyzer with Performance Manager requires the following components:
 
      
      	 [bookmark: pgfId-1287822]A configured Fibre Channel Switched Port Analyzer (SPAN) destination (SD) port to forward Fibre Channel traffic.
 
      	 [bookmark: pgfId-1287823]A Port Analyzer Adapter 2 (PAA-2) to convert the Fibre Channel traffic to Ethernet traffic.
 
      	 [bookmark: pgfId-1287824]Cisco Traffic Analyzer software to analyze the traffic from the PAA-2.
 
     
 
    
 
     
      [bookmark: pgfId-1287825]DETAILED STEPS
 
     
 
     [bookmark: pgfId-1287827]Step 1 [bookmark: 1715 ]Set up the Cisco Traffic Analyzer according to the instructions in the Cisco MDS 9000 Family Port Analyzer Adapter 2 Installation and Configuration Note.
 
     [bookmark: pgfId-1287829]Step 2 [bookmark: 1718 ]Get the following three items of information:
 
      
      	 [bookmark: pgfId-1287830]The IP address of the management workstation on which you are running Performance Manager and Cisco Traffic Analyzer.
 
      	 [bookmark: pgfId-1287831]The path to the directory where Cisco Traffic Analyzer is installed.
 
      	 [bookmark: pgfId-1287832]The port that is used by Cisco Traffic Analyzer (the default is 3000).
 
     
 
     [bookmark: pgfId-1287834]Step 3 [bookmark: 1727 ]Start the Cisco Traffic Analyzer.
 
     [bookmark: pgfId-1287835] a. Choose Performance > Traffic Analyzer > Open.
 
     [bookmark: pgfId-1287836] b. Enter the URL for the Cisco Traffic Analyzer, in the format:
 
      
      [bookmark: pgfId-1287837]http://<ip address>:<port number> 
     
 
      
      [bookmark: pgfId-1287838] 
     
 
     [bookmark: pgfId-1287840]ip address is the address of the management workstation on which you have installed the Cisco Traffic Analyzer
 
     [bookmark: pgfId-1287841]:port number is the port that is used by Cisco Traffic Analyzer (the default is :3000).
 
     [bookmark: pgfId-1287842] c. Click OK.
 
     [bookmark: pgfId-1287843] d. Choose Performance > Traffic Analyzer > Start.
 
     [bookmark: pgfId-1287844] e. Enter the location of the Cisco Traffic Analyzer, in the format:
 
      
      [bookmark: pgfId-1287845]D:\<directory>\ntop.bat 
     
 
      
      [bookmark: pgfId-1287846] 
     
 
     [bookmark: pgfId-1287848]D: is the drive letter for the disk drive where the Cisco Traffic Analyzer is installed.
 
     [bookmark: pgfId-1287849]directory is the directory containing the ntop.bat file.
 
     [bookmark: pgfId-1287850] f. Click OK.
 
     [bookmark: pgfId-1287852]Step 4 [bookmark: 1750 ]Create the flows you want Performance Manager to monitor, using the Flow Configuration Wizard. See the “Creating a Flow with Performance Manager” section
 
     [bookmark: pgfId-1287857]Step 5 [bookmark: 1752 ]Define the data collection you want Performance Manager to gather, using the Performance Manager Configuration Wizard. See the “Creating a Collection with Performance Manager” section.
 
     [bookmark: pgfId-1287861] a. Choose the VSAN you want to collect information for or choose All VSANs.
 
     [bookmark: pgfId-1287862] b. Check the types of items you want to collect information for (Hosts, ISLs, Storage Devices, and Flows).
 
     [bookmark: pgfId-1287863] c. Enter the URL for the Cisco Traffic Analyzer in the format:
 
      
      [bookmark: pgfId-1287864]http://<ip address>/<directory> 
     
 
      
      [bookmark: pgfId-1287865] 
     
 
     [bookmark: pgfId-1287866]where:
 
     [bookmark: pgfId-1287867]ip address is the address of the management workstation on which you have installed the Cisco Traffic Analyzer, and directory is the path to the directory where the Cisco Traffic Analyzer is installed.
 
     [bookmark: pgfId-1287868] d. Click Next.
 
     [bookmark: pgfId-1287869] e. Review the data collection on this and the next section to make sure this is the data you want to collect.
 
     [bookmark: pgfId-1287870] f. Click Finish to begin collecting data.
 
      
       
     
 
     
 
     [bookmark: pgfId-1287871]Note Data is not collected for JBOD or for virtual ports. If you change the data collection configuration parameters during a data collection, you must stop and restart the collection process for your changes to take effect.
 
      
      
 
     
 
     
 
     [bookmark: pgfId-1287873]Step 6 [bookmark: 1772 ]Choose Performance > Reports to generate a report. Performance Manager Web Server must be running. You see Web Services; click Custom then select a report template.
 
      
       
     
 
     
 
     [bookmark: pgfId-1287877]Note It takes at least five minutes to start collecting data for a report. Do not attempt to generate a report in Performance Manager during the first five minutes of collection.
 
      
      
 
     
 
     
 
     [bookmark: pgfId-1287879]Step 7 [bookmark: 1779 ]Click Cisco Traffic Analyzer at the top of the Host or Storage detail pages to view the Cisco Traffic Analyzer information, or choose Performance > Traffic Analyzer > Open. The Cisco Traffic Analyzer page will not open unless ntop has been started already.
 
      
       
     
 
     
 
     [bookmark: pgfId-1287880]Note For information on capturing a SPAN session and starting a Cisco Traffic Analyzer session to view it, refer to the Cisco MDS 9000 Family Port Analyzer Adapter 2 Installation and Configuration Note.
 
      
      
 
     
 
     
 
      
       
     
 
     
 
     [bookmark: pgfId-1287883]Note For information on viewing and interpreting your Performance Manager data, see the “Creating a Flow with Performance Manager” section.

For information on viewing and interpreting your Cisco Traffic Analyzer data, refer to the Cisco MDS 9000 Family Port Analyzer Adapter 2 Installation and Configuration Note.
 
      
      
 
     
 
     
 
     [bookmark: pgfId-1287885]
 
      
      
 
     
 
     
 
     [bookmark: pgfId-1307325]For performance drill-down, DCNM-SAN Server can launch the Cisco Traffic Analyzer in-context from the Performance Manager graphs. The aliases associated with hosts, storage devices, and VSANs are passed to the Cisco Traffic Analyzer to provide consistent, easy identification.
 
    
 
   
 
    
     [bookmark: pgfId-1308121][bookmark: 89189]Exporting Data Collections 
 
    [bookmark: pgfId-1308128]This section includes the following topics:
 
     
     	 [bookmark: pgfId-1308143]“Exporting Data Collections to XML Files” section
 
     	 [bookmark: pgfId-1308153]“Exporting Data Collections in Readable Format” section
 
    
 
     
      [bookmark: pgfId-1307534][bookmark: 1796]Exporting Data Collections to XML Files
 
     [bookmark: pgfId-1307536]The RRD files used by Performance Manager can be exported[bookmark: marker-1307535] to a freeware tool called rrdtool. The rrd files are located in pm/db on the DCNM-SAN Server. To export the collection to an XML file, enter the following command at the operating system command-line prompt:
 
      
      [bookmark: pgfId-1307537]/bin/pm.bat xport xxx yyy 
     
 
      
      [bookmark: pgfId-1307538] 
     
 
     [bookmark: pgfId-1307539]In this command, xxx is the RRD file and yyy is the XML file that is generated. This XML file is in a format that rrdtool is capable of reading with the command:
 
      
      [bookmark: pgfId-1307540]rrdtool restore filename.xml filename.rrd 
     
 
      
      [bookmark: pgfId-1307541] 
     
 
     [bookmark: pgfId-1307542]You can import an XML file with the command:
 
      
      [bookmark: pgfId-1307543]bin/pm.bat pm restore <xmlFile> <rrdFile> 
     
 
      
      [bookmark: pgfId-1307544] 
     
 
     [bookmark: pgfId-1307545]This reads the XML export format that rrdtool is capable of writing with the command:
 
      
      [bookmark: pgfId-1307546]rrdtool xport filename.xml filename.rrd. 
     
 
      
      [bookmark: pgfId-1307547] 
     
 
     [bookmark: pgfId-1307548]The pm xport and pm restore commands can be found on your DCNM-SAN Server at bin\PM.bat for Windows platforms or bin/PM.sh on UNIX platforms. For more information on the rrdtool, refer to the following website: http://www.rrdtool.org.
 
    
 
     
      [bookmark: pgfId-1307550][bookmark: 68411]Exporting Data Collections in Readable Format
 
     [bookmark: pgfId-1307551]You can export the RRD files used by Performance Manager to a freeware tool called rrdtool and export the collection to an XML file. Cisco MDS SAN-OS Release 2.1(1a) introduces the inability to export data collection[bookmark: marker-1307552]s in comma-separated format (CSV). This format can be imported to various tools, including Microsoft Excel. You can export these readable data collections either from the DCNM-SAN Web Services menus or in batch mode from the command line on Windows or UNIX. Using DCNM-SAN Web Services, you can export one file. Using batch mode, you can export all collections in the pm.xml file.
 
      
       
     
 
     
 
     [bookmark: pgfId-1307555]Note DCNM-SAN Web Server must be running for this to work. 
 
      
      
 
     
 
     
 
     [bookmark: pgfId-1308108]You can export data collections to Microsoft Excel using DCNM-SAN Web Server.
 
    
 
     
      [bookmark: pgfId-1312130]DETAILED STEPS
 
     
 
     [bookmark: pgfId-1307558]Step 1 Click the Performance tab on the main page. 
 
     [bookmark: pgfId-1307559]You see the overview table.
 
     [bookmark: pgfId-1307560]Step 2 Click the Flows sub-tab.
 
     [bookmark: pgfId-1307561]Step 3 Right-click the name of the entity you want to export and select Export to Microsoft Excel. 
 
     [bookmark: pgfId-1307562]You see the Excel chart for that entity in a pop-up window.
 
     [bookmark: pgfId-1307563]
 
      
      
 
     
 
     
 
     [bookmark: pgfId-1307564]You can export data collections using command-line batch mode.
 
    
 
     
      [bookmark: pgfId-1312157]DETAILED STEPS
 
     
 
     [bookmark: pgfId-1307565]Step 1 Go to the installation directory on your workstation and then go to the bin directory.
 
     [bookmark: pgfId-1307566]Step 2 On Windows, enter .\pm.bat export C:\Program Files\Cisco Systems\MDS 9000\pm\pm.xml <export directory>. This creates the csv file (export.csv) in the export directory on your workstation.
 
     [bookmark: pgfId-1307567]Step 3 On UNIX, enter ./pm.sh export /usr/local/cisco_mds9000/pm/pm.xml <export directory>. This creates the csv file (export.csv) in the export directory on your workstation.
 
     [bookmark: pgfId-1307568]
 
      
      
 
     
 
     
 
     [bookmark: pgfId-1307569]When you open this exported file in Microsoft Excel, the following information displays:
 
      
      	 [bookmark: pgfId-1307570]Title of the entity you exported and the address of the switch the information came from.
 
      	 [bookmark: pgfId-1307571]The maximum speed seen on the link to or from this entity.
 
      	 [bookmark: pgfId-1307572]The VSAN ID and maximum speed.
 
      	 [bookmark: pgfId-1307573]The timestamp, followed by the receive and transmit data rates in bytes per second.
 
     
 
    
 
   
 
    
     [bookmark: pgfId-1307327][bookmark: 15402]Analyzing SAN Health
 
    [bookmark: pgfId-1302212]The SAN Health Advisor tool is a utility that used to monitor the performance and collect the statistics. You can perform the following tasks with this tool:
 
     
     	 [bookmark: pgfId-1302213] Run Performance Monitor to collect I/O statistics
 
     	 [bookmark: pgfId-1302214] Collect fabric inventory (switches and other devices)
 
     	 [bookmark: pgfId-1302215] Create a graphical layout of fabric topology
 
     	 [bookmark: pgfId-1302216] Create reports of error conditions and statistical data
 
    
 
    [bookmark: pgfId-1302217]You can install this tool at any SAN environment to collect I/O statistics for the specified time (usually 24 hours), generate health reports and automatically send reports to the designated system administrator for review at regular intervals. 
 
    [bookmark: pgfId-1302218]When you start SAN Health Advisor tool, it runs in wizard mode, and prompts for inputs such as seed switch credentials, IP address of the server to which the data to be sent and all the necessary information for the software setup. As soon as the fabric is discovered, the tool starts capturing performance data, I/O statistics and error conditions. 
 
    [bookmark: pgfId-1304564]The reports generated from the collection is stored in the $INSTALLDIR/dcm/fm/reports directory. These reports are automatically sent to the designated SAN administrator for review. In a situation where the tool fails to collect the data, it generates a report with an error message or exception. After sending the reports the tool automatically uninstalls itself and terminates all the processes that it established on the host machine. 
 
    [bookmark: pgfId-1302219]The report that SAN Health Advisor tool generates will have the following details:
 
     
     	 [bookmark: pgfId-1302221] Events
 
     	 [bookmark: pgfId-1302222] System messages
 
     	 [bookmark: pgfId-1302223] Analysis of connectivity
 
     	 [bookmark: pgfId-1302224] Zone discrepancy
 
     	 [bookmark: pgfId-1302225] System configuration
 
     	 [bookmark: pgfId-1302226] Interface status
 
     	 [bookmark: pgfId-1302227] Domain information
 
     	 [bookmark: pgfId-1302228] Security settings
 
    
 
    [bookmark: pgfId-1302247]
 
     
      [bookmark: pgfId-1302248]Installing the SAN Health Advisor Tool
 
     [bookmark: pgfId-1302279]SAN Health Advisor tool can be installed and run on Windows, UNIX, and Solaris platforms. Install the package that contains the .jar file with JRE version 6.0. 
 
      
       
     
 
     
 
     [bookmark: pgfId-1302316]Note The SAN Health tool is not installed by default when you install DCNM-SAN software. 
 
      
      
 
     
 
     
 
    
 
     
      [bookmark: pgfId-1302315]DETAILED STEPS
 
     
 
     [bookmark: pgfId-1302350]Step 1 Double-click the San Health Advisor tool installer.
 
     [bookmark: pgfId-1302351]You see the San Health Advisor tool Installer window as shown in Figure 14-5.
 
     [bookmark: pgfId-1316724]Figure 14-5 [bookmark: 51934]SAN Health Advisor: Installer
 
      
      [image: ] 
     
 
     [bookmark: pgfId-1302367]Step 2 Select an installation folder on your workstation for SAN Health Advisor. 
 
     [bookmark: pgfId-1303343]On Windows, the default location is C:\Program Files\Cisco Systems\.
 
     [bookmark: pgfId-1302416]Step 3 Click Install to start the installation.
 
     [bookmark: pgfId-1302784]You see the installation progressing as shown in Figure 14-6.
 
     [bookmark: pgfId-1316741]Figure 14-6 [bookmark: 11173]SAN Health Advisor: Installation in Progress
 
      
      [image: ] 
     
 
     [bookmark: pgfId-1302423]You see the Fabric Options dialog box as shown in Figure 14-7
 
     [bookmark: pgfId-1316758]Figure 14-7 [bookmark: 15218]SAN Health Advisor: Fabric Options
 
      
      [image: ] 
     
 
     [bookmark: pgfId-1302929]Step 4 In the Seed Switch text box, enter the IP address of the seed switch.
 
     [bookmark: pgfId-1303403]Step 5 Enter the user name and password for the switch. 
 
     [bookmark: pgfId-1303410]Step 6 Select the authentication privacy option from the Auth-Privacy drop-down list box.
 
     [bookmark: pgfId-1302930]Step 7 Click the Performance Collection check box to enable the process to run for 24 hours.
 
     [bookmark: pgfId-1302931]Step 8 Click Collect to start gathering performance information.
 
     [bookmark: pgfId-1302361]You see the collecting dialog box as shown in Figure 14-8.
 
     [bookmark: pgfId-1316775]Figure 14-8 [bookmark: 81192]SAN Health Advisor: Collecting
 
      
      [image: ] 
     
 
     [bookmark: pgfId-1303456]If you want to stop gathering information in the middle of the process, click Cancel. You see the message indicating performance collection is complete as shown in Figure 14-9. 
 
     [bookmark: pgfId-1316792]Figure 14-9 [bookmark: 85051]SAN Health Advisor: Performance Collection Complete
 
      
      [image: ] 
     
 
     [bookmark: pgfId-1303683]Step 9 Click Uninstall to remove the SAN Health Advisor software.
 
     [bookmark: pgfId-1302295]
 
    
 
     
      [bookmark: pgfId-1336001]Monitoring the LAN Switch Performance Counters
 
     [bookmark: pgfId-1336040]DCNM allows you to monitor LAN switch performance counters. The following counters can be monitored:
 
      
      	 [bookmark: pgfId-1336053]Performance monitoring of interfaces (RX/TX traffic statistics, errors/discards, average/peak statistics etc.)
 
      	 [bookmark: pgfId-1336054]Monitor VPC member Rx/Tx counters
 
      	 [bookmark: pgfId-1336055]Monitor CPU/Memory statistics
 
      	 [bookmark: pgfId-1336056]Monitor switch traffic
 
      	 [bookmark: pgfId-1336057]Monitor Health Scores
 
      	 [bookmark: pgfId-1336058]Monitor Events
 
     
 
     [bookmark: pgfId-1302088]
 
    
 
   
 
  
 
  
  
   
   
    
     [bookmark: pgfId-241178]DCNM Vacuum and Autovacuum Postgres Databases 
      
      
 
     
 
 
    [bookmark: pgfId-241179]This chapter describes how to vacuum the postgres database in Microsoft Windows and Linux.
 
    [bookmark: pgfId-241285]This chapter includes the following sections:
 
     
     	 [bookmark: pgfId-181128]Background Information
 
     	 [bookmark: pgfId-243036]Vacuum DCNM's Postgresql Database in Windows
 
     	 [bookmark: pgfId-243046]Vacuum DCNM's Postgresql Database in Linux
 
    
 
   
 
    
     [bookmark: pgfId-164254][bookmark: 98296]Background Information
 
    [bookmark: pgfId-186328]It is absolutely critical to vacuum postgres databases in order for the databases to properly function. Through the life of the database, new entries are added and current entries are updated. By design, postgres does not immediately remove the iterations of a record as it gets updated. Therefore, postgres databases can contain a large number of stale, unused records. These old records should be removed at least every two weeks with the vacuum function in order to reduce disk usage and improve the speed of database queries. It is even more effective if you configure postgres to automatically vacuum the database without the need to stop the Data Center Network Manager (DCNM) services.
 
     
      
    
 
    
 
    [bookmark: pgfId-241935]Note $INSTALLDIR throughout this article refers to "C:\Program Files\Cisco Systems\" or "/usr/local/cisco/" based on the operating system, Microsoft Windows or Linux respectively. The install path could be changed from these defaults during installation.
 
     
     
 
    
 
    
 
   
 
    
     [bookmark: pgfId-241958][bookmark: 11509]Vacuum DCNM's Postgresql Database in Windows
 
    
 
    [bookmark: pgfId-241982]Step 1 Stop the DCNM services by clicking Stop DCNM Servers button, or enter the command as below:
 
    [bookmark: pgfId-242075]$INSTALLDIR/dcm/dcnm/bin/stopLANSANserver.bat
 
    [bookmark: pgfId-242129]Step 2 Obtain the database name, username, and password. Locate the postgresql.cfg.xml file on the DCNM server.
 
     
     	 [bookmark: pgfId-242121]In DCNM Version 6.2.x, enter:
 
    
 
    [bookmark: pgfId-242183]$INSTALLDIR/dcm/jboss-4.2.2.GA/server/dcnm/conf/database/postgresql.cfg.xml
 
     
     	 [bookmark: pgfId-242202]In DCNM Version 6.3.x, enter:
 
    
 
    [bookmark: pgfId-242195]$INSTALLDIR/dcm/Jboss-as-7.2.0.Final/standalone/conf/postgresql.cfg.xml
 
    [bookmark: pgfId-242236]Step 3 Open PgAdmin III.exe, which is a helpful GUI for the postgres database. Then, right-click the object in the list and connect to the database. Enter the password from Step 2 here.
 
    [bookmark: pgfId-242271]Step 4 Navigate through the drop-down menus to the dcmdb database.
 
    [bookmark: pgfId-242290]Step 5 Right-click dcmdb and select Maintenance. Select the Vacuum, Full, Analyze, and Verbose options in the Maintain Database dcmdb dialog box.
 
     
      
    
 
    
 
    [bookmark: pgfId-242306]Note The vacuum operation usually completes within an hour, but can take much longer for larger databases. Remember to restart the DCNM services.
 
     
     
 
    
 
    
 
    [bookmark: pgfId-243009]
 
     
     
 
    
 
    
 
   
 
    
     [bookmark: pgfId-242391][bookmark: 51146]Vacuum DCNM's Postgresql Database in Linux
 
    
 
    [bookmark: pgfId-242402]Step 1 Stop dcnm by using the appmgr stop dcnm command.
 
    [bookmark: pgfId-242471]Step 2 Open the psql prompt:
 
    [bookmark: pgfId-242454]./usr/local/cisco/dcm/db/bin/psql -U <dbUsername> dcmdb
 
    [bookmark: pgfId-242508]Step 3 Run the database vacuum and quit:
 
    [bookmark: pgfId-242510]dcmdb=> VACUUM FULL ANALYZE VERBOSE;
 
    [bookmark: pgfId-242514]Many pages of output pass on the screen. The vacuum is finished when you see a message similar to this one:
 
    [bookmark: pgfId-242516]Current limits are: 532000 page slots, 1000 relations, using 3182 kB.
 
    [bookmark: pgfId-242517]VACUUM
 
    [bookmark: pgfId-242518]dcmdb=>
 
    [bookmark: pgfId-242519]dcmdb=> \q
 
    [bookmark: pgfId-243223]The previous command exits the sql prompt.
 
    [bookmark: pgfId-243224]Step 4 Start DCNM services by using the appmgr start dcnm command.
 
    [bookmark: pgfId-243225]
 
     
     
 
    
 
    
 
   
 
    
   
 
  
 
  
  
   
   
    
     [bookmark: pgfId-1007671][bookmark: 95993]DCNM-SAN Event Management 
      
      
 
     
 
 
    [bookmark: pgfId-1018953]DCNM Event Management tool (EMAN) offers event management capability directly in Cisco MDS, Nexus 7000 and 5000 series switches to monitor events and take informational or corrective action as events occur, or when a threshold is reached. EMAN captures the state of the switches during critical situations helping to take immediate recovery actions and gather information to perform root-cause analysis. 
 
    [bookmark: pgfId-1018955]An event is generated when the object matches specified values or crosses specified thresholds. When it detects an event, EMAN will parse the event for the host name, severity and then determine the host-to-application dependency by comparing the event in the host table. EMAN monitors these events to detect the severity type such as warning, critical and emergency of the events. It will also list the impacted components such as a host, ISL or a storage port. Switch health and performance threshold are the two event types that the EMAN monitor.
 
    [bookmark: pgfId-1010285]This Appendix contains the following sections:
 
     
     	 [bookmark: pgfId-1010286]Benefits of the Event Management Tool
 
     	 [bookmark: pgfId-1010318]DCNM-SAN Event Management
 
     	 [bookmark: pgfId-1023735]DCNM-SAN Event Classification
 
    
 
   
 
    
     [bookmark: pgfId-1010288][bookmark: 50444]Benefits of the Event Management Tool
 
    [bookmark: pgfId-1019119]EMAN tracks resource utilization and resource depletion by monitoring events in 45000 ports and 240 switches. It also provides a mechanism to send notifications whenever the specified threshold values are exceeded by any of the components. This notification helps network administrators diagnose resource utilization issues and prioritize resources making it more scalable.
 
    [bookmark: pgfId-1019121]EMAN helps in addressing component issues real time by performing the following functions:
 
     
     	 [bookmark: pgfId-1019172]Monitoring resource usage.
 
     	 [bookmark: pgfId-1019124]Using resource threshold pre-sets.
 
     	 [bookmark: pgfId-1019125]Generating alerts when resource utilization reaches the specified level.
 
     	 [bookmark: pgfId-1019203]Provides dependency path mapping.
 
    
 
   
 
    
     [bookmark: pgfId-1019215][bookmark: 29941]DCNM-SAN Event Management 
 
    [bookmark: pgfId-1019239]This section describes how DCNM handles asynchronous transfer events from the managed switches and contains the following topics:
 
     
      [bookmark: pgfId-1019479][bookmark: 16366]Events
 
     [bookmark: pgfId-1019480]The following are the three primary methods by which DCNM detects events:
 
      
      	 [bookmark: pgfId-1019401]SNMP—The Simple Network Management Protocol v1 (SNMPv1) event detector allows an event to be generated when the object matches specified values or crosses specified thresholds. The Cisco MDS 9000 switch can contain up to 10 trap destinations. The unmanaged fabrics or switches are removed from the list of traps destinations.
 
      	 [bookmark: pgfId-1019278]Syslog—DCNM-SAN receives syslog messages and are logged in the events table in the database and archived on each switch. 
 
      	 [bookmark: pgfId-1019406]Fabric Model— DCNM-SAN can function even without receiving SNMP traps from the managed switches. DCNM-SAN polls for traps every 5 minutes and does a deeper discovery every 30 minutes by default. 
 
     
 
    
 
     
      [bookmark: pgfId-1019709]Purpose
 
     [bookmark: pgfId-1019710]Asynchronous event handling serves the following purposes:
 
      
      	 [bookmark: pgfId-1019711]Model Update—DCNM-SAN design the model of the physical and logical connectivity of each fabric. Asynchronous events enables real time synchronization with the fabric. In cases such as a linkdown, this model quickly updates the event without polling the fabric. However, for major changes such as an ISL link change, this model polls the fabric to synchronize.
 
      	 [bookmark: pgfId-1019520]Log—All the events are logged into a database. The number of events that can be logged is set to 10,000 by default. You can view this log in the Cisco DCNM-SAN Client and in Cisco DCNM Web Client. The Cisco DCNM Web Client stores all events in the database unless you do not apply any filteres. The Cisco DCNM-SAN Client log is restricted to the fabric(s) that are opened in the client’s interface. TheCisco DCNM-SAN Client automatically updates the table as new events appear. 
 
      	 [bookmark: pgfId-1019500]Map—The Cisco DCNM-SAN Client’s updates the map automatically when topology changes.
 
     
 
    
 
     
      [bookmark: pgfId-1019691]Forwarding
 
     [bookmark: pgfId-1019692]Events are forwarded in three ways:
 
      
      	 [bookmark: pgfId-1019726]Cisco Call Home—The Cisco MDS 9000 series switches generates an email at the event of a critical event such as a module down etc. You can customize this email to include additional information. You can use Cisco DCNM-SAN client to configure Cisco call home feature and it has no operational dependency on Cisco DCNM.
 
      	 [bookmark: pgfId-1019728]EMC Call Home—If you enable this feature, the Cisco DCNM server generates an EMC call home email at the event of a critical event such as a linkDown event etc. This email is created in XML format.
 
      	 [bookmark: pgfId-1019730]Event Forwarding—You can optionally choose to send an email or SNMP traps from Cisco DCNM for any or all events that are logged into the database.
 
     
 
    
 
   
 
    
     [bookmark: pgfId-1019853][bookmark: 36467]DCNM-SAN Event Classification
 
     
      [bookmark: pgfId-1019861]Port Events
 
     [bookmark: pgfId-1019866]Port events provides real-time information about the operational status of the host ports, storage ports, ISLs, NPV etc in your network. At the event of a fault, the Cisco DCNM EMAN generates an event or events that are rolled up into an alert. The port events are broadly classified into two as follows:
 
      
      	 [bookmark: pgfId-1019886]Service Impacting—Indicates the severity of the event that impacts the service. Examples are PMON, RMON and SFP events.
 
      	 [bookmark: pgfId-1019887]Outage—Indicates the severity of the event that impacts the functioning of the device. Exampls are link up/down and threshold events.
 
     
 
    
 
     
      [bookmark: pgfId-1019869]Event Log Format
 
     [bookmark: pgfId-1020000]Events log consists of parseable information that is available to higher level management applications in the following format:
 
      
      [bookmark: pgfId-1020025] <fabric>/<switch> <localTime> <severity> <type> <description> 
     
 
     [bookmark: pgfId-1020023]
 
      
      	 [bookmark: pgfId-1019873]Fabric/Switch—The name of the fabric or the switch.
 
      	 [bookmark: pgfId-1020113]LocalTime—The date and time of the event occurred. The time is in the following format: hh:mm:ss.ttt. The date is in the following format: MM/DD/YYYY.
 
      	 [bookmark: pgfId-1020114]Severity—Event severity level, combination of single events, or a range of event severity levels. The severity contains one of the following. 
 
     
 
     [bookmark: pgfId-1020115] – Emergencies
 
     [bookmark: pgfId-1020029] – Alert
 
     [bookmark: pgfId-1020030] – Critical 
 
     [bookmark: pgfId-1020108] – Error
 
     [bookmark: pgfId-1020031] – Warning
 
     [bookmark: pgfId-1020032] – Notice
 
     [bookmark: pgfId-1020033] – Informational
 
     [bookmark: pgfId-1020034] – Debugging
 
      
      	 [bookmark: pgfId-1019876]Type—Type of events.
 
     
 
     [bookmark: pgfId-1020088] – Fabric
 
     [bookmark: pgfId-1020089] – FICON
 
     [bookmark: pgfId-1020090] – IVR
 
     [bookmark: pgfId-1020091] – License
 
     [bookmark: pgfId-1020092] – Other
 
     [bookmark: pgfId-1020093] – Port Alarm
 
     [bookmark: pgfId-1020094] – Port Up and Port Down
 
     [bookmark: pgfId-1020096] – Security
 
     [bookmark: pgfId-1020097] – Switch Hardware
 
     [bookmark: pgfId-1020098] – Switch Manageability
 
     [bookmark: pgfId-1020099] – Threshold
 
     [bookmark: pgfId-1020100] – VSAN
 
     [bookmark: pgfId-1020101] – Zone
 
      
      	 [bookmark: pgfId-1019877]Description—Description of the event in the following format: 
 
     
 
      
      [bookmark: pgfId-1020140]<portType>: <name>, Port: <interface>, VSAN: <vsanId(s)>, <condition>
 
     
 
     [bookmark: pgfId-1020227]
 
    
 
     
      [bookmark: pgfId-1020228]Event Types
 
    
 
     
      [bookmark: pgfId-1020233]IVR
 
     [bookmark: pgfId-1020242]Table B-1 IVR Events 
 
      
       
        
         
         	 
           
           [bookmark: pgfId-1020276]Event Name 
          
  
         	 
           
           [bookmark: pgfId-1020278]Description 
          
  
        
 
         
         	[bookmark: pgfId-1020346]civrDomainConflictNotify
  
         	[bookmark: pgfId-1020282]
  
        
 
         
         	[bookmark: pgfId-1020348]civrZoneActivationDoneNotify
  
         	[bookmark: pgfId-1020286]
  
        
 
         
         	[bookmark: pgfId-1020350]civrZoneCompactNotify
  
         	[bookmark: pgfId-1020290]
  
        
 
         
         	[bookmark: pgfId-1020352]civrZoneDeactivationDoneNotify
  
         	[bookmark: pgfId-1020294]
  
        
 
         
         	[bookmark: pgfId-1020354]civrDomainConflictNotify
  
         	[bookmark: pgfId-1020298]
  
        
 
         
         	[bookmark: pgfId-1020356]civrAfidConfigNotify
  
         	[bookmark: pgfId-1020302]
  
        
 
        
      
 
     
 
    
 
     
      [bookmark: pgfId-1020441]
 
    
 
     
      [bookmark: pgfId-1020442]License
 
     [bookmark: pgfId-1020481]Table B-2 Licence Events
 
      
       
        
         
         	 
           
           [bookmark: pgfId-1020454]Event Name 
          
  
         	 
           
           [bookmark: pgfId-1020456]Description 
          
  
        
 
         
         	[bookmark: pgfId-1020544]clmLicenseExpiryNotify
  
         	[bookmark: pgfId-1020460]
  
        
 
         
         	[bookmark: pgfId-1020546]clmLicenseExpiryWarningNotify
  
         	[bookmark: pgfId-1020464]
  
        
 
         
         	[bookmark: pgfId-1020548]clmLicenseFileMissingNotify
  
         	[bookmark: pgfId-1020468]
  
        
 
         
         	[bookmark: pgfId-1020550]clmNoLicenseForFeatureNotify
  
         	[bookmark: pgfId-1020472]
  
        
 
        
      
 
     
 
    
 
     
      [bookmark: pgfId-1020374]Port Alarm
 
     [bookmark: pgfId-1020574]Any RMON event that relates to an interface object.
 
     [bookmark: pgfId-1020590]Table B-3 Port Alarm Event
 
      
       
        
         
         	 
           
           [bookmark: pgfId-1020594]Event Name 
          
  
         	 
           
           [bookmark: pgfId-1020596]Description 
          
  
        
 
         
         	[bookmark: pgfId-1020598]cIfXcvrMonStatusChangeNotif
  
         	[bookmark: pgfId-1020600]
  
        
 
        
      
 
     
 
     [bookmark: pgfId-1020576]
 
    
 
     
      [bookmark: pgfId-1020577]Port Up and Port Down
 
     [bookmark: pgfId-1020578]Model-generated events relating to Host, Storage, ISL, NP_Links
 
     [bookmark: pgfId-1024111]Table B-4 IVR Events 
 
      
       
        
         
         	 
           
           [bookmark: pgfId-1024084]Event Name 
          
  
         	 
           
           [bookmark: pgfId-1024086]Description 
          
  
        
 
         
         	[bookmark: pgfId-1024203]linkup
  
         	[bookmark: pgfId-1024090]
  
        
 
         
         	[bookmark: pgfId-1024205]linkDown
  
         	[bookmark: pgfId-1024094]
  
        
 
         
         	[bookmark: pgfId-1024207]cieLinkUp
  
         	[bookmark: pgfId-1024098]
  
        
 
         
         	[bookmark: pgfId-1024209]cieLinkDown
  
         	[bookmark: pgfId-1024102]
  
        
 
         
         	[bookmark: pgfId-1024211]connUnitPortStatusChange
  
         	[bookmark: pgfId-1024125]
  
        
 
         
         	[bookmark: pgfId-1024213]fcNameServerEntryAdd
  
         	[bookmark: pgfId-1024129]
  
        
 
         
         	[bookmark: pgfId-1024215]fcNameServerEntryDelete
  
         	[bookmark: pgfId-1024133]
  
        
 
         
         	[bookmark: pgfId-1024217]fcTrunkIfDownNotify
  
         	[bookmark: pgfId-1024137]
  
        
 
         
         	[bookmark: pgfId-1024219]fcTrunkIfUpNotify
  
         	[bookmark: pgfId-1024106]
  
        
 
         
         	[bookmark: pgfId-1024221]cieDelayedLinkUpDownNotif
  
         	[bookmark: pgfId-1024110]
  
        
 
        
      
 
     
 
      
       
     
 
     
 
     [bookmark: pgfId-1020583]Note Port Moved events will not be logged.
 
      
      
 
     
 
     
 
    
 
     
      [bookmark: pgfId-1020377]Security
 
     [bookmark: pgfId-1020749]Table B-5 Security Event Types
 
      
       
        
         
         	 
           
           [bookmark: pgfId-1020914]Event Name 
          
  
         	 
           
           [bookmark: pgfId-1020916]Description 
          
  
        
 
         
         	[bookmark: pgfId-1021028]casServerStateChange
  
         	[bookmark: pgfId-1020920]
  
        
 
         
         	[bookmark: pgfId-1021030]cfcspAuthFailTrap
  
         	[bookmark: pgfId-1020924]
  
        
 
         
         	[bookmark: pgfId-1021032]ciscoPsmFabricBindDenyNotifyNew
  
         	[bookmark: pgfId-1020928]
  
        
 
         
         	[bookmark: pgfId-1021034]ciscoEnhIpsecFlowBadSa
  
         	[bookmark: pgfId-1020932]
  
        
 
         
         	[bookmark: pgfId-1021036]ciscoEnhIpsecFlowSetupFail
  
         	[bookmark: pgfId-1020936]
  
        
 
         
         	[bookmark: pgfId-1021038]ciscoEnhIpsecFlowSysFailure
  
         	[bookmark: pgfId-1020940]
  
        
 
         
         	[bookmark: pgfId-1021040]ciscoEnhIpsecFlowTunnelStart
  
         	[bookmark: pgfId-1020944]
  
        
 
         
         	[bookmark: pgfId-1021042]ciscoEnhIpsecFlowTunnelStop
  
         	[bookmark: pgfId-1020948]
  
        
 
         
         	[bookmark: pgfId-1021044]ciscoIPsecProvCryptomapAdded
  
         	[bookmark: pgfId-1020952]
  
        
 
         
         	[bookmark: pgfId-1021046]ciscoIPsecProvCryptomapAttached
  
         	[bookmark: pgfId-1020956]
  
        
 
         
         	[bookmark: pgfId-1021048]ciscoIPsecProvCryptomapDeleted
  
         	[bookmark: pgfId-1020960]
  
        
 
         
         	[bookmark: pgfId-1021050]ciscoIPsecProvCryptomapDetached
  
         	[bookmark: pgfId-1020984]
  
        
 
         
         	[bookmark: pgfId-1021052]ciscoIkeConfigOperStateChanged
  
         	[bookmark: pgfId-1020988]
  
        
 
         
         	[bookmark: pgfId-1021054]ciscoIkeConfigPolicyAdded
  
         	[bookmark: pgfId-1020992]
  
        
 
         
         	[bookmark: pgfId-1021056]ciscoIkeConfigPolicyDeleted
  
         	[bookmark: pgfId-1020996]
  
        
 
         
         	[bookmark: pgfId-1021058]ciscoIkeConfigPskAdded
  
         	[bookmark: pgfId-1021000]
  
        
 
         
         	[bookmark: pgfId-1021060]ciscoIkeConfigPskDeleted
  
         	[bookmark: pgfId-1021004]
  
        
 
         
         	[bookmark: pgfId-1021062]ciscoIkeFlowInNewGrpRejected
  
         	[bookmark: pgfId-1021008]
  
        
 
         
         	[bookmark: pgfId-1021064]ciscoIkeFlowOutNewGrpRejected
  
         	[bookmark: pgfId-1021012]
  
        
 
         
         	[bookmark: pgfId-1021066]ciscoIpsSgCertCrlFailure
  
         	[bookmark: pgfId-1021016]
  
        
 
         
         	[bookmark: pgfId-1021068]ciscoIpsSgSysFailure
  
         	[bookmark: pgfId-1021020]
  
        
 
         
         	[bookmark: pgfId-1021070]ciscoIpsSgTunnelStart
  
         	[bookmark: pgfId-1020964]
  
        
 
         
         	[bookmark: pgfId-1021072]ciscoIpsSgTunnelStop
  
         	[bookmark: pgfId-1020968]
  
        
 
        
      
 
     
 
     [bookmark: pgfId-1020706]
 
    
 
     
      [bookmark: pgfId-1021079]Switch Hardware 
 
     [bookmark: pgfId-1021177]Table B-6 Switch Hardware Events
 
      
       
        
         
         	 
           
           [bookmark: pgfId-1021082]Event Name 
          
  
         	 
           
           [bookmark: pgfId-1021084]Description 
          
  
        
 
         
         	[bookmark: pgfId-1021294]cefcFRUInserted
  
         	[bookmark: pgfId-1021088]
  
        
 
         
         	[bookmark: pgfId-1021296]cefcFRURemoved
  
         	[bookmark: pgfId-1021092]
  
        
 
         
         	[bookmark: pgfId-1021298]cefcPowerStatusChange
  
         	[bookmark: pgfId-1021096]
  
        
 
         
         	[bookmark: pgfId-1021300]cefcPowerSupplyOutputChange
  
         	[bookmark: pgfId-1021100]
  
        
 
         
         	[bookmark: pgfId-1021302]cefcFanTrapStatusChange
  
         	[bookmark: pgfId-1021104]
  
        
 
         
         	[bookmark: pgfId-1021304]cefcUnrecognizedFRU
  
         	[bookmark: pgfId-1021108]
  
        
 
         
         	[bookmark: pgfId-1021306]cefcFRUInserted
  
         	[bookmark: pgfId-1021112]
  
        
 
         
         	[bookmark: pgfId-1021308]cefcFRURemoved
  
         	[bookmark: pgfId-1021116]
  
        
 
         
         	[bookmark: pgfId-1021310]cefcUnrecognizedFRU
  
         	[bookmark: pgfId-1021120]
  
        
 
         
         	[bookmark: pgfId-1021312]entPhysicalVendorType
  
         	[bookmark: pgfId-1021124]
  
        
 
         
         	[bookmark: pgfId-1021314]entPhysicalName
  
         	[bookmark: pgfId-1021128]
  
        
 
         
         	[bookmark: pgfId-1021316]entPhysicalModelName
  
         	[bookmark: pgfId-1021132]
  
        
 
         
         	[bookmark: pgfId-1021318]cefcPhysicalStatus
  
         	[bookmark: pgfId-1021136]
  
        
 
         
         	[bookmark: pgfId-1021320]cefcPowerStatusChange
  
         	[bookmark: pgfId-1021140]
  
        
 
         
         	[bookmark: pgfId-1021322] cefcFRUPowerOperStatus
  
         	[bookmark: pgfId-1021144]
  
        
 
         
         	[bookmark: pgfId-1021324]cefcFRUPowerAdminStatus
  
         	[bookmark: pgfId-1021148]
  
        
 
         
         	[bookmark: pgfId-1021326]cefcFanTrapStatusChange
  
         	[bookmark: pgfId-1021152]
  
        
 
        
      
 
     
 
    
 
     
      [bookmark: pgfId-1021328]Switch Managability
 
     [bookmark: pgfId-1021402]Table B-7 Switch Event Types
 
      
       
        
         
         	 
           
           [bookmark: pgfId-1021331]Event Name 
          
  
         	 
           
           [bookmark: pgfId-1021333]Description 
          
  
        
 
         
         	[bookmark: pgfId-1021495]Switch Discovered
  
         	[bookmark: pgfId-1021337]
  
        
 
         
         	[bookmark: pgfId-1021497]Switch Rebooted
  
         	[bookmark: pgfId-1021341]
  
        
 
         
         	[bookmark: pgfId-1021499]Switch Unreachable
  
         	[bookmark: pgfId-1021345]
  
        
 
         
         	[bookmark: pgfId-1021501]Switch Manageable
  
         	[bookmark: pgfId-1021349]
  
        
 
         
         	[bookmark: pgfId-1021503]Switch Unmanageable
  
         	[bookmark: pgfId-1021353]
  
        
 
         
         	[bookmark: pgfId-1021505]Switch IP Changed
  
         	[bookmark: pgfId-1021357]
  
        
 
         
         	[bookmark: pgfId-1021507]warmStart
  
         	[bookmark: pgfId-1021361]
  
        
 
         
         	[bookmark: pgfId-1021509]coldStart
  
         	[bookmark: pgfId-1021365]
  
        
 
         
         	[bookmark: pgfId-1021511]ciscoRFProgressionNotif
  
         	[bookmark: pgfId-1021369]
  
        
 
         
         	[bookmark: pgfId-1021513]ciscoRFSwactNotif
  
         	[bookmark: pgfId-1021373]
  
        
 
        
      
 
     
 
    
 
     
      [bookmark: pgfId-1021466]Threshold
 
     [bookmark: pgfId-1021586]Table B-8 Threshold Events
 
      
       
        
         
         	 
           
           [bookmark: pgfId-1021543]Event Name 
          
  
         	 
           
           [bookmark: pgfId-1021545]Description 
          
  
        
 
         
         	[bookmark: pgfId-1024352]cHcRisingAlarm
  
         	[bookmark: pgfId-1021549]
  
        
 
         
         	[bookmark: pgfId-1024354]cHcFallingAlarm
  
         	[bookmark: pgfId-1024275]
  
        
 
         
         	[bookmark: pgfId-1024356]hcRisingAlarm
  
         	[bookmark: pgfId-1024279]
  
        
 
         
         	[bookmark: pgfId-1024358]hcFallingAlarm
  
         	[bookmark: pgfId-1024283]
  
        
 
         
         	[bookmark: pgfId-1024360]risingAlarm
  
         	[bookmark: pgfId-1024287]
  
        
 
         
         	[bookmark: pgfId-1024362]FallingAlarm
  
         	[bookmark: pgfId-1024291]
  
        
 
        
      
 
     
 
    
 
     
      [bookmark: pgfId-1020381]VSAN
 
     [bookmark: pgfId-1021778]Table B-9 VSAN Events
 
      
       
        
         
         	 
           
           [bookmark: pgfId-1021767]Event Name 
          
  
         	 
           
           [bookmark: pgfId-1021769]Description 
          
  
        
 
         
         	[bookmark: pgfId-1021771]vsanPortMembershipChange
  
         	[bookmark: pgfId-1021773]
  
        
 
         
         	[bookmark: pgfId-1021775]vsanStatusChange
  
         	[bookmark: pgfId-1021777]
  
        
 
        
      
 
     
 
    
 
     
      [bookmark: pgfId-1021779]Zone
 
     [bookmark: pgfId-1021825]Table B-10 Zone Events
 
      
       
        
         
         	 
           
           [bookmark: pgfId-1021782]Event Name 
          
  
         	 
           
           [bookmark: pgfId-1021784]Description 
          
  
        
 
         
         	[bookmark: pgfId-1021862]zoneActivateNotify
  
         	[bookmark: pgfId-1021788]
  
        
 
         
         	[bookmark: pgfId-1021864]zoneCompactNotify
  
         	[bookmark: pgfId-1021792]
  
        
 
         
         	[bookmark: pgfId-1021866]zoneDefZoneBehaviourChngNotify
  
         	[bookmark: pgfId-1021796]
  
        
 
         
         	[bookmark: pgfId-1021868]zoneMergeFailureNotify
  
         	[bookmark: pgfId-1021800]
  
        
 
         
         	[bookmark: pgfId-1021870]zoneMergeSuccessNotify
  
         	[bookmark: pgfId-1021804]
  
        
 
         
         	[bookmark: pgfId-1021872]zoneServiceReqRejNotify
  
         	[bookmark: pgfId-1021808]
  
        
 
         
         	[bookmark: pgfId-1021874]zoneUnsuppMemInIntOpModeNotify
  
         	[bookmark: pgfId-1021812]
  
        
 
        
      
 
     
 
    
 
     
      [bookmark: pgfId-1020387]Others
 
     [bookmark: pgfId-1021943]This table contains all other trap types such as ISCSI, VRRP, Cisco callhome, flex attach, FDMI, FICON, CFS, PMON config, SVC, SCSI, SNE, Core, Domain Manager, FCNS, FCOT, and UCS.
 
     [bookmark: pgfId-1021944]
 
     [bookmark: pgfId-1021916]Table B-11 Other Events
 
      
       
        
         
         	 
           
           [bookmark: pgfId-1021885]Event Name 
          
  
         	 
           
           [bookmark: pgfId-1021887]Description 
          
  
        
 
         
         	[bookmark: pgfId-1023163]cIsnsClientInitalRegistration
  
         	[bookmark: pgfId-1022214]
  
        
 
         
         	[bookmark: pgfId-1023165]cIsnsClientLostConnection
  
         	[bookmark: pgfId-1022218]
  
        
 
         
         	[bookmark: pgfId-1023167]cIsnsClientNoServerDiscovered
  
         	[bookmark: pgfId-1022222]
  
        
 
         
         	[bookmark: pgfId-1023169]cIsnsClientStart
  
         	[bookmark: pgfId-1022226]
  
        
 
         
         	[bookmark: pgfId-1023171]cIsnsServerShutdown
  
         	[bookmark: pgfId-1022230]
  
        
 
         
         	[bookmark: pgfId-1023173]cIsnsServerStart
  
         	[bookmark: pgfId-1022234]
  
        
 
         
         	[bookmark: pgfId-1023175]cVrrpNotificationNewMaster
  
         	[bookmark: pgfId-1022238]
  
        
 
         
         	[bookmark: pgfId-1023177]cVrrpNotificationProtoError
  
         	[bookmark: pgfId-1022242]
  
        
 
         
         	[bookmark: pgfId-1023179]casServerStateChange
  
         	[bookmark: pgfId-1022246]
  
        
 
         
         	[bookmark: pgfId-1023181]ccCopyCompletion
  
         	[bookmark: pgfId-1022250]
  
        
 
         
         	[bookmark: pgfId-1023183]ccmAlertGroupTypeAddedNotif
  
         	[bookmark: pgfId-1022254]
  
        
 
         
         	[bookmark: pgfId-1023185]ccmAlertGroupTypeDeletedNotif
  
         	[bookmark: pgfId-1022258]
  
        
 
         
         	[bookmark: pgfId-1023187]ccmCLIRunningConfigChanged
  
         	[bookmark: pgfId-1022262]
  
        
 
         
         	[bookmark: pgfId-1023189]ccmCTIDRolledOver
  
         	[bookmark: pgfId-1022266]
  
        
 
         
         	[bookmark: pgfId-1023191]ccmEventNotif
  
         	[bookmark: pgfId-1022270]
  
        
 
         
         	[bookmark: pgfId-1023193]ccmSmtpMsgSendFailNotif
  
         	[bookmark: pgfId-1022274]
  
        
 
         
         	[bookmark: pgfId-1023195]ccmSmtpServerFailNotif
  
         	[bookmark: pgfId-1022278]
  
        
 
         
         	[bookmark: pgfId-1023197]cfaIfVirtualWwnChangeNotify
  
         	[bookmark: pgfId-1022282]
  
        
 
         
         	[bookmark: pgfId-1023199]cfaVirtualWwnMapChangeNotify
  
         	[bookmark: pgfId-1022286]
  
        
 
         
         	[bookmark: pgfId-1023201]cfdmiRejectRegNotify
  
         	[bookmark: pgfId-1022290]
  
        
 
         
         	[bookmark: pgfId-1023203]cficonPortInfoChange
  
         	[bookmark: pgfId-1022294]
  
        
 
         
         	[bookmark: pgfId-1023205]ciscoCFSDiscoveryCompleteNotif
  
         	[bookmark: pgfId-1022298]
  
        
 
         
         	[bookmark: pgfId-1023207]ciscoCFSFeatureActionNotif
  
         	[bookmark: pgfId-1022302]
  
        
 
         
         	[bookmark: pgfId-1023209]ciscoCFSMergeFailNotif
  
         	[bookmark: pgfId-1022306]
  
        
 
         
         	[bookmark: pgfId-1023211]ciscoCFSStatPeerStatusChngNotif
  
         	[bookmark: pgfId-1022310]
  
        
 
         
         	[bookmark: pgfId-1023213]ciscoConfigManEvent
  
         	[bookmark: pgfId-1022314]
  
        
 
         
         	[bookmark: pgfId-1023215]ciscoEnhIpsecFlowBadSa
  
         	[bookmark: pgfId-1022318]
  
        
 
         
         	[bookmark: pgfId-1023217]ciscoEnhIpsecFlowSetupFail
  
         	[bookmark: pgfId-1022322]
  
        
 
         
         	[bookmark: pgfId-1023219]ciscoEnhIpsecFlowSysFailure
  
         	[bookmark: pgfId-1022326]
  
        
 
         
         	[bookmark: pgfId-1023221]ciscoEnhIpsecFlowTunnelStart
  
         	[bookmark: pgfId-1022330]
  
        
 
         
         	[bookmark: pgfId-1023223]ciscoEnhIpsecFlowTunnelStop
  
         	[bookmark: pgfId-1022334]
  
        
 
         
         	[bookmark: pgfId-1023225]ciscoExtScsiLunDiscDoneNotify
  
         	[bookmark: pgfId-1022338]
  
        
 
         
         	[bookmark: pgfId-1023227]ciscoFCCCongestionRateLimitEnd
  
         	[bookmark: pgfId-1022342]
  
        
 
         
         	[bookmark: pgfId-1023229]ciscoFCCCongestionRateLimitStart
  
         	[bookmark: pgfId-1022346]
  
        
 
         
         	[bookmark: pgfId-1023231]ciscoFCCCongestionStateChange
  
         	[bookmark: pgfId-1022350]
  
        
 
         
         	[bookmark: pgfId-1023233]ciscoFeatOpStatusChange
  
         	[bookmark: pgfId-1022354]
  
        
 
         
         	[bookmark: pgfId-1023235]ciscoFeatureOpStatusChange
  
         	[bookmark: pgfId-1022358]
  
        
 
         
         	[bookmark: pgfId-1023237]ciscoFeatureSetOpStatusChange
  
         	[bookmark: pgfId-1022362]
  
        
 
         
         	[bookmark: pgfId-1023239]ciscoFlashCopyCompletionTrap
  
         	[bookmark: pgfId-1022366]
  
        
 
         
         	[bookmark: pgfId-1023241]ciscoFlashDeviceChangeTrap
  
         	[bookmark: pgfId-1022370]
  
        
 
         
         	[bookmark: pgfId-1023243]ciscoFlashDeviceInsertedNotif
  
         	[bookmark: pgfId-1022374]
  
        
 
         
         	[bookmark: pgfId-1023245]ciscoFlashDeviceInsertedNotifRev1
  
         	[bookmark: pgfId-1022378]
  
        
 
         
         	[bookmark: pgfId-1023247]ciscoFlashDeviceRemovedNotif
  
         	[bookmark: pgfId-1022382]
  
        
 
         
         	[bookmark: pgfId-1023249]ciscoFlashDeviceRemovedNotifRev1
  
         	[bookmark: pgfId-1022386]
  
        
 
         
         	[bookmark: pgfId-1023251]ciscoFlashMiscOpCompletionTrap
  
         	[bookmark: pgfId-1022390]
  
        
 
         
         	[bookmark: pgfId-1023253]ciscoFlashPartitioningCompletionTrap
  
         	[bookmark: pgfId-1022394]
  
        
 
         
         	[bookmark: pgfId-1023255]ciscoIPsecProvCryptomapAdded
  
         	[bookmark: pgfId-1022398]
  
        
 
         
         	[bookmark: pgfId-1023257]ciscoIPsecProvCryptomapAttached
  
         	[bookmark: pgfId-1022402]
  
        
 
         
         	[bookmark: pgfId-1023259]ciscoIPsecProvCryptomapDeleted
  
         	[bookmark: pgfId-1022406]
  
        
 
         
         	[bookmark: pgfId-1023261]ciscoIPsecProvCryptomapDetached
  
         	[bookmark: pgfId-1022410]
  
        
 
         
         	[bookmark: pgfId-1023263]ciscoIkeConfigOperStateChanged
  
         	[bookmark: pgfId-1022414]
  
        
 
         
         	[bookmark: pgfId-1023265]ciscoIkeConfigPolicyAdded
  
         	[bookmark: pgfId-1022418]
  
        
 
         
         	[bookmark: pgfId-1023267]ciscoIkeConfigPolicyDeleted
  
         	[bookmark: pgfId-1022422]
  
        
 
         
         	[bookmark: pgfId-1023269]ciscoIkeConfigPskAdded
  
         	[bookmark: pgfId-1022426]
  
        
 
         
         	[bookmark: pgfId-1023271]ciscoIkeConfigPskDeleted
  
         	[bookmark: pgfId-1022430]
  
        
 
         
         	[bookmark: pgfId-1023273]ciscoIkeFlowInNewGrpRejected
  
         	[bookmark: pgfId-1022434]
  
        
 
         
         	[bookmark: pgfId-1023275]ciscoIkeFlowOutNewGrpRejected
  
         	[bookmark: pgfId-1022438]
  
        
 
         
         	[bookmark: pgfId-1023277]ciscoIpsSgCertCrlFailure
  
         	[bookmark: pgfId-1022442]
  
        
 
         
         	[bookmark: pgfId-1023279]ciscoIpsSgSysFailure
  
         	[bookmark: pgfId-1022446]
  
        
 
         
         	[bookmark: pgfId-1023281]ciscoIpsSgTunnelStart
  
         	[bookmark: pgfId-1022450]
  
        
 
         
         	[bookmark: pgfId-1023283]ciscoIpsSgTunnelStop
  
         	[bookmark: pgfId-1022454]
  
        
 
         
         	[bookmark: pgfId-1023285]ciscoPmonPolicyChangeNotify
  
         	[bookmark: pgfId-1022458]
  
        
 
         
         	[bookmark: pgfId-1023287]ciscoPrefPathHWFailureNotify
  
         	[bookmark: pgfId-1022462]
  
        
 
         
         	[bookmark: pgfId-1023289]ciscoPsmFabricBindDenyNotify
  
         	[bookmark: pgfId-1022466]
  
        
 
         
         	[bookmark: pgfId-1023291]ciscoPsmFabricBindDenyNotifyNew
  
         	[bookmark: pgfId-1022470]
  
        
 
         
         	[bookmark: pgfId-1023293]ciscoPsmPortBindEPortDenyNotify
  
         	[bookmark: pgfId-1022474]
  
        
 
         
         	[bookmark: pgfId-1023295]ciscoPsmPortBindFPortDenyNotify
  
         	[bookmark: pgfId-1022478]
  
        
 
         
         	[bookmark: pgfId-1023297]ciscoSanBaseSvcClusterNewMaster
  
         	[bookmark: pgfId-1022482]
  
        
 
         
         	[bookmark: pgfId-1023299]ciscoSanBaseSvcInterfaceCreate
  
         	[bookmark: pgfId-1022486]
  
        
 
         
         	[bookmark: pgfId-1023301]ciscoSanBaseSvcInterfaceDelete
  
         	[bookmark: pgfId-1022490]
  
        
 
         
         	[bookmark: pgfId-1023303]ciscoScsiFlowStatsNotify
  
         	[bookmark: pgfId-1022494]
  
        
 
         
         	[bookmark: pgfId-1023305]ciscoScsiFlowVerifyNotify
  
         	[bookmark: pgfId-1022498]
  
        
 
         
         	[bookmark: pgfId-1023307]ciscoScsiFlowWrAccNotify
  
         	[bookmark: pgfId-1022502]
  
        
 
         
         	[bookmark: pgfId-1023309]ciscoSmeClusterNewMaster
  
         	[bookmark: pgfId-1022506]
  
        
 
         
         	[bookmark: pgfId-1023311]ciscoSmeInterfaceCreate
  
         	[bookmark: pgfId-1022510]
  
        
 
         
         	[bookmark: pgfId-1023313]ciscoSmeInterfaceDelete
  
         	[bookmark: pgfId-1022514]
  
        
 
         
         	[bookmark: pgfId-1023315]ciscoSystemClockChanged
  
         	[bookmark: pgfId-1022518]
  
        
 
         
         	[bookmark: pgfId-1023317]ciscoVshaStateChngNotify
  
         	[bookmark: pgfId-1022522]
  
        
 
         
         	[bookmark: pgfId-1023319]ciuUpgradeJobStatusNotify
  
         	[bookmark: pgfId-1022526]
  
        
 
         
         	[bookmark: pgfId-1023321]ciuUpgradeOpCompletionNotify
  
         	[bookmark: pgfId-1022530]
  
        
 
         
         	[bookmark: pgfId-1023323]cseFailSwCoreNotify
  
         	[bookmark: pgfId-1022534]
  
        
 
         
         	[bookmark: pgfId-1023325]cseFailSwCoreNotifyExtended
  
         	[bookmark: pgfId-1022538]
  
        
 
         
         	[bookmark: pgfId-1023327]cseHaRestartNotify
  
         	[bookmark: pgfId-1022542]
  
        
 
         
         	[bookmark: pgfId-1023329]cseShutDownNotify
  
         	[bookmark: pgfId-1022546]
  
        
 
         
         	[bookmark: pgfId-1023331]csiErrorTrap
  
         	[bookmark: pgfId-1022550]
  
        
 
         
         	[bookmark: pgfId-1023333]csiInformationTrap
  
         	[bookmark: pgfId-1022554]
  
        
 
         
         	[bookmark: pgfId-1023335]csiWarningTrap
  
         	[bookmark: pgfId-1022558]
  
        
 
         
         	[bookmark: pgfId-1023337]dmDomainIdNotAssignedNotify
  
         	[bookmark: pgfId-1022562]
  
        
 
         
         	[bookmark: pgfId-1023339]dmFabricChangeNotify
  
         	[bookmark: pgfId-1022566]
  
        
 
         
         	[bookmark: pgfId-1023341]dmNewPrincipalSwitchNotify
  
         	[bookmark: pgfId-1022570]
  
        
 
         
         	[bookmark: pgfId-1023343]fcNameServerDatabaseFull
  
         	[bookmark: pgfId-1022574]
  
        
 
         
         	[bookmark: pgfId-1023345]fcNameServerRejectRegNotify
  
         	[bookmark: pgfId-1022578]
  
        
 
         
         	[bookmark: pgfId-1023347]fcPingCompletionNotify
  
         	[bookmark: pgfId-1022582]
  
        
 
         
         	[bookmark: pgfId-1023349]fcTraceRouteCompletionNotify
  
         	[bookmark: pgfId-1022586]
  
        
 
         
         	[bookmark: pgfId-1023351]fcotInserted
  
         	[bookmark: pgfId-1022590]
  
        
 
         
         	[bookmark: pgfId-1023353]fcotRemoved
  
         	[bookmark: pgfId-1022594]
  
        
 
         
         	[bookmark: pgfId-1023355]fcsDiscoveryCompleteNotify
  
         	[bookmark: pgfId-1022598]
  
        
 
         
         	[bookmark: pgfId-1023357]fcsMgmtAddrChangeNotify
  
         	[bookmark: pgfId-1022602]
  
        
 
         
         	[bookmark: pgfId-1023359]fcsReqRejNotify
  
         	[bookmark: pgfId-1022606]
  
        
 
         
         	[bookmark: pgfId-1023361]fspfNbrStateChangeNotify
  
         	[bookmark: pgfId-1022610]
  
        
 
         
         	[bookmark: pgfId-1023363]ptopoConfigChange
  
         	[bookmark: pgfId-1022614]
  
        
 
         
         	[bookmark: pgfId-1023365]qlSB2PortLinkDown
  
         	[bookmark: pgfId-1022618]
  
        
 
         
         	[bookmark: pgfId-1023367]qlSB2PortLinkUp
  
         	[bookmark: pgfId-1022622]
  
        
 
         
         	[bookmark: pgfId-1023369]rscnElsRejectReqNotify
  
         	[bookmark: pgfId-1022626]
  
        
 
         
         	[bookmark: pgfId-1023371]rscnElsRxRejectReqNotify
  
         	[bookmark: pgfId-1022630]
  
        
 
         
         	[bookmark: pgfId-1023373]rscnIlsRejectReqNotify
  
         	[bookmark: pgfId-1022634]
  
        
 
         
         	[bookmark: pgfId-1023375]rscnIlsRxRejectReqNotify
  
         	[bookmark: pgfId-1022638]
  
        
 
         
         	[bookmark: pgfId-1023377]virtualNwIfCreateEntryNotify
  
         	[bookmark: pgfId-1022642]
  
        
 
         
         	[bookmark: pgfId-1023379]virtualNwIfDeleteEntryNotify
  
         	[bookmark: pgfId-1022646]
  
        
 
         
         	[bookmark: pgfId-1023381]vlanTrunkPortDynamicStatusChange
  
         	[bookmark: pgfId-1022650]
  
        
 
         
         	[bookmark: pgfId-1023383]vrrpTrapAuthFailure
  
         	[bookmark: pgfId-1022654]
  
        
 
         
         	[bookmark: pgfId-1023385]vrrpTrapNewMaster
  
         	[bookmark: pgfId-1022658]
  
        
 
         
         	[bookmark: pgfId-1023387]vtpConfigDigestError
  
         	[bookmark: pgfId-1022662]
  
        
 
         
         	[bookmark: pgfId-1023389]vtpConfigRevNumberError
  
         	[bookmark: pgfId-1022666]
  
        
 
         
         	[bookmark: pgfId-1023391]vtpLocalModeChanged
  
         	[bookmark: pgfId-1022670]
  
        
 
         
         	[bookmark: pgfId-1023393]vtpMtuTooBig
  
         	[bookmark: pgfId-1022674]
  
        
 
         
         	[bookmark: pgfId-1023395]vtpPruningStateOperChange
  
         	[bookmark: pgfId-1022678]
  
        
 
         
         	[bookmark: pgfId-1023397]vtpServerDisabled
  
         	[bookmark: pgfId-1022682]
  
        
 
         
         	[bookmark: pgfId-1023399]vtpVersionInUseChanged
  
         	[bookmark: pgfId-1022686]
  
        
 
         
         	[bookmark: pgfId-1023401]vtpVersionOneDeviceDetected
  
         	[bookmark: pgfId-1022690]
  
        
 
         
         	[bookmark: pgfId-1023403]vtpVlanCreated
  
         	[bookmark: pgfId-1022694]
  
        
 
         
         	[bookmark: pgfId-1023405]vtpVlanDeleted
  
         	[bookmark: pgfId-1022698]
  
        
 
         
         	[bookmark: pgfId-1023407]vtpVlanRingNumberConflict
  
         	[bookmark: pgfId-1022702]
  
        
 
         
         	[bookmark: pgfId-1023409]wwnmType1WwnAvailableNotify
  
         	[bookmark: pgfId-1022706]
  
        
 
         
         	[bookmark: pgfId-1023411]wwnmType1WwnShortageNotify
  
         	[bookmark: pgfId-1022710]
  
        
 
         
         	[bookmark: pgfId-1023413]wwnmTypeOtherWwnAvailableNotify
  
         	[bookmark: pgfId-1022714]
  
        
 
         
         	[bookmark: pgfId-1023415]wwnmTypeOtherWwnShortageNotify
  
         	[bookmark: pgfId-1022718]
  
        
 
        
      
 
     
 
     [bookmark: pgfId-1021880]
 
     [bookmark: pgfId-1021881]
 
     [bookmark: pgfId-1008042]
 
    
 
   
 
  
 
  
  
   
   
    
     [bookmark: pgfId-1033820][bookmark: 95993]Vcenter Plugin 
      
      
 
     
 
 
    [bookmark: pgfId-1018955]VMware Vcenter plugin allows you to monitor the Cisco Unified Computing System™ (Cisco UCS), Cisco Nexus, and Cisco MDS 9000 Family platforms through Cisco DCNM.
 
    [bookmark: pgfId-1025814]The Cisco DCNM plug-in for VMware Vcenter adds a multihop view and monitoring of Ethernet and Fibre Channel Cisco Nexus and Cisco MDS 9000 Family topologies. The increased visibility into virtualized infrastructure helps network administrators locate performance anomalies that may cause service degradation. It also aids to eliminate virtual computing and networking as a root cause of the problem.
 
    [bookmark: pgfId-1010285]This Appendix contains the following sections:
 
     
     	 [bookmark: pgfId-1010286]Associating Vcenter with the Datasource
 
     	 [bookmark: pgfId-1010318]Registering Vcenter plugin
 
     	 [bookmark: pgfId-1023735]Triggering the plugin
 
     	 [bookmark: pgfId-1027368]Removing the plugin
 
    
 
   
 
    
     [bookmark: pgfId-1010288][bookmark: 50444]Associating Vcenter with the Datasource
 
    [bookmark: pgfId-1019119]To associate the Vcenter with the datasource, Cisco DCNM must discover the LAN and SAN devices.
 
    [bookmark: pgfId-1026068]Navigate to Inventory > Discovery > LAN Switches or Inventory > Discovery > SAN Switches to check if the LAN or SAN devices are discovered on the Cisco DCNM Web Client. In the Inventory->Discovery->Virtual Machine Manager block, click + to add the Vcenter to the datasource.
 
   
 
    
     [bookmark: pgfId-1026442][bookmark: 76915]Registering Vcenter plugin
 
    [bookmark: pgfId-1026487]To register the Vcenter plugin, run the RegisterPlugin script. Enter the Vcenter IP address, Vcenter username, Vcenter password, and complete URL of the DCNM server. The plugin configuration file is stored in the DCNM server.
 
     
     [bookmark: pgfId-1026488]Example:  
    
 
     
     [bookmark: pgfId-1026778]RegisterPlugin.bat -add 172.22.29.87 admin nbv123 https://dcnm-san-001:443 
    
 
   
 
    
     [bookmark: pgfId-1026807][bookmark: 59932]Triggering the plugin
 
    [bookmark: pgfId-1026850]When user clicks on the menu, it will show the login page first, and then will launch an internal browser which will show the host dashboard.
 
   
 
    
     [bookmark: pgfId-1019215][bookmark: 29941]Removing the plugin
 
    [bookmark: pgfId-1019239]To remove the Vcenter plugin, run the RegisterPlugin script. Enter the Vcenter IP address, Vcenter username, Vcenter password, and complete URL of the DCNM server. The plugin configuration file is located in the DCNM server.
 
   
 
  
 
  
  
   
   
    
     [bookmark: pgfId-1006077][bookmark: 94595]Interface Non-operational Reason Codes 
      
      
 
     
 
 
     
      
       
       [bookmark: pgfId-1041193]Table D-1 [bookmark: 87507]Reason Codes for Nonoperational States 
 
       
       
        
        	 
          
          [bookmark: pgfId-1041199]Reason Code 
         
  
        	 
          
          [bookmark: pgfId-1041201]Description 
         
  
        	 
          
          [bookmark: pgfId-1041203]Applicable Modes 
         
  
       
 
        
        	[bookmark: pgfId-1041206][bookmark: marker-1041205]Link failure or not connected
  
        	[bookmark: pgfId-1041208]Physical layer link is not operational.
  
        	 [bookmark: pgfId-1041210]All
  
       
 
        
        	[bookmark: pgfId-1041213][bookmark: marker-1041212]SFP not present
  
        	[bookmark: pgfId-1041215]The small form-factor pluggable (SFP) hardware is not plugged in.
  
       
 
        
        	[bookmark: pgfId-1041219]Initializing
  
        	[bookmark: pgfId-1041221]The physical layer link is operational and the protocol initialization is in progress.
  
       
 
        
        	[bookmark: pgfId-1041226]Reconfigure fabric in progress
  
        	[bookmark: pgfId-1041228]The fabric is currently being reconfigured.
  
       
 
        
        	[bookmark: pgfId-1041233][bookmark: marker-1041232]Offline
  
        	[bookmark: pgfId-1041235]Cisco MDS SAN-OS waits for the specified R_A_TOV time before retrying initialization.
  
       
 
        
        	[bookmark: pgfId-1041241]Inactive
  
        	[bookmark: pgfId-1041244]The interface VSAN is deleted or is in a suspended state.
 [bookmark: pgfId-1041245]To make the interface operational, assign that port to a configured and active VSAN.
  
       
 
        
        	[bookmark: pgfId-1041249]Hardware failure
  
        	[bookmark: pgfId-1041251]A hardware failure is detected.
  
       
 
        
        	[bookmark: pgfId-1041256]Error disabled
  
        	[bookmark: pgfId-1041258]Error conditions require administrative attention. Interfaces may be error-disabled for various reasons. For example:
 
          
          	 [bookmark: pgfId-1041259]Configuration failure.
 
          	 [bookmark: pgfId-1041262]Incompatible [bookmark: marker-1041260]buffer-to-buffer [bookmark: marker-1041261]credit configuration.
 
         
 [bookmark: pgfId-1041263]To make the interface operational, you must first fix the error conditions causing this state; and next, administratively shut down or enable the interface.
  
       
 
        
        	[bookmark: pgfId-1041270]Isolation due to [bookmark: marker-1041268]ELP[bookmark: marker-1041269] failure
  
        	[bookmark: pgfId-1041272]Port negotiation failed.
  
        	 [bookmark: pgfId-1041274]Only E ports and TE ports 
  
       
 
        
        	[bookmark: pgfId-1041277]Isolation due to [bookmark: marker-1041276]ESC failure
  
        	[bookmark: pgfId-1041279]Port negotiation failed.
  
       
 
        
        	[bookmark: pgfId-1041284]Isolation due to [bookmark: marker-1041283]domain overlap
  
        	[bookmark: pgfId-1041286]The Fibre Channel domains (fcdomain) overlap.
  
       
 
        
        	[bookmark: pgfId-1041291]Isolation due to [bookmark: marker-1041290]domain ID assignment failure
  
        	[bookmark: pgfId-1041293]The assigned domain ID is not valid.
  
       
 
        
        	[bookmark: pgfId-1041298]Isolation due to other side [bookmark: marker-1041297]E port isolated
  
        	[bookmark: pgfId-1041300]The E port at the other end of the link is isolated.
  
       
 
        
        	[bookmark: pgfId-1041304]Isolation due to invalid fabric reconfiguration
  
        	[bookmark: pgfId-1041306]The port is isolated due to fabric reconfiguration.
  
       
 
        
        	[bookmark: pgfId-1041311]Isolation due to domain manager disabled
  
        	[bookmark: pgfId-1041313]The fcdomain feature is disabled.
  
       
 
        
        	[bookmark: pgfId-1041318]Isolation due to [bookmark: zones]zone merge failure
  
        	[bookmark: pgfId-1041320]The zone merge operation failed.
  
       
 
        
        	[bookmark: pgfId-1041325]Isolation due to [bookmark: marker-1041324]VSAN mismatch
  
        	[bookmark: pgfId-1041327]The VSANs at both ends of an ISL are different.
  
       
 
        
        	[bookmark: pgfId-1041332]Nonparticipating
  
        	[bookmark: pgfId-1041335][bookmark: marker-1041334]FL ports cannot participate in loop operations. It may happen if more than one FL port exists in the same loop, in which case all but one FL port in that loop automatically enters nonparticipating mode. 
  
        	[bookmark: pgfId-1041337]Only FL ports and TL ports
  
       
 
        
        	[bookmark: pgfId-1041340][bookmark: marker-1041339]PortChannel administratively down
  
        	[bookmark: pgfId-1041342]The interfaces belonging to the PortChannel are down.
  
        	 [bookmark: pgfId-1041344]Only PortChannel interfaces
  
       
 
        
        	[bookmark: pgfId-1041346]Suspended due to[bookmark: marker-1044533] incompatible speed
  
        	[bookmark: pgfId-1041348]The interfaces belonging to the PortChannel have incompatible speeds.
  
       
 
        
        	[bookmark: pgfId-1041352]Suspended due to[bookmark: marker-1044534] incompatible mode
  
        	[bookmark: pgfId-1041354]The interfaces belonging to the PortChannel have incompatible modes.
  
       
 
        
        	[bookmark: pgfId-1041358]Suspended due to [bookmark: marker-1044535]incompatible remote switch [bookmark: marker-1041359]WWN
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